Install and License your Genero Products
# Contents

## Install and License your Genero Products........................................................................ 6
- The what, where, and when of installation...................................................................... 7
- Software package names................................................................................................. 7
- Installation conventions.................................................................................................. 8
- Product version life cycle............................................................................................... 9
- Installation troubleshooting tips.................................................................................... 10

## Install Genero Business Development Language......................................................... 11
- System requirements...................................................................................................... 11
- Install Genero BDL procedures...................................................................................... 12
- Genero Business Development Language packages...................................................... 12
- Pre-install tasks............................................................................................................. 13
- Install Genero BDL on UNIX® platforms......................................................................... 13
- Install Genero BDL on Windows® platforms................................................................... 14
- Install Genero BDL on macOS®..................................................................................... 15
- Post-install tasks........................................................................................................... 16

## Install Genero Desktop Client..................................................................................... 16
- System requirements...................................................................................................... 17
- Genero compatibility..................................................................................................... 17
- GDC 3.10 and Genero compatibility............................................................................... 17
- GDC 3.00 and Genero compatibility............................................................................... 17
- GDC 2.50 and Genero compatibility............................................................................... 17
- Install GDC on UNIX® platforms.................................................................................. 18
- Install GDC on Windows®............................................................................................ 18
- Install GDC on Windows® platforms using the MSI installer........................................... 19
- Install GDC on macOS®............................................................................................... 20
- Install GDC on X11 systems.......................................................................................... 21
- Microsoft® Windows® Security Blocking...................................................................... 21

## Install Genero Application Server............................................................................... 21
- System requirements...................................................................................................... 22
- Genero compatibility for the GAS................................................................................... 23
- GAS 3.10 and Genero compatibility............................................................................... 23
- Install Genero Application Server on UNIX® platforms.................................................. 23
- Install on Microsoft® Windows® platforms................................................................... 24
- Install and uninstall in silent mode on Microsoft® Windows® platforms......................... 25
- Install GAS on macOS®............................................................................................... 27

## Install Genero Studio.................................................................................................. 27
- System requirements...................................................................................................... 28
- Install Genero Studio on Windows®............................................................................... 29
- Install Genero Studio on Windows® in silent mode......................................................... 30
- Install Genero Studio on UNIX® platforms..................................................................... 33
- Install Genero Studio on UNIX® platforms in silent mode............................................. 33
Install Genero Studio Server Suite ................................................................. 36
  Genero Studio Server Suite system requirements ....................................... 36
  Install Genero Studio Server Suite on Windows® ........................................... 37
  Install Genero Studio Server Suite on UNIX® platforms ............................... 38
  Install Genero Studio Server Suite on macOS™ ............................................. 39

Install the Genero Mobile for Android front-end application ....................... 40

Install the Genero Mobile for iOS front-end application ................................ 40

Install Genero Report Engine ........................................................................... 41
  System requirements ....................................................................................... 41
  Install Genero Report Engine on UNIX® platforms ........................................ 42
  Install Genero Report Engine on Windows® .................................................. 42
  Install GRE on Windows® platforms using the MSI installer .......................... 42
  Install GRE on macOS™ .............................................................................. 43

Install Genero Report Designer ....................................................................... 44
  System requirements ....................................................................................... 45
  Install Genero Report Designer on Linux® .................................................... 45
  Install Genero Report Designer on Windows® ................................................ 45

Install Genero Browser Client ......................................................................... 46
  Genero Browser Client system requirements ................................................ 46

Install Four Js License Manager ....................................................................... 46
  System requirements ....................................................................................... 47
  Upgrade the FLM without re-applying licenses ............................................. 47
  Patching a license controller ......................................................................... 48
  Identify DVM version ...................................................................................... 48
  Installation ...................................................................................................... 49
  Four Js License Manager packages .............................................................. 49
  Launching the installation ............................................................................ 49

License Genero Business Development Language .......................................... 52
  Steps to BDL license installation ................................................................... 52
  Install BDL license with user interface (internet) .......................................... 53
  Install BDL license with user interface (no internet) ...................................... 55
  Install BDL license from the command line (via internet) ............................ 57
  Install BDL license from the command line (no internet) ............................. 58
  Manage Genero BDL local license ............................................................... 59
  License Controller (fglWrt) ......................................................................... 60
Displaying environment and statistics.................................................................61
GDC/GDCAX/GJC...............................................................................................63
Genero Browser Client (GBC).............................................................................64
Get license information.......................................................................................64
Uninstall license.................................................................................................67
The FGLDIR/lock directory................................................................................69
License an upgraded installation........................................................................69
Managing the active users...................................................................................70
Register license on Four Js website.....................................................................72
Troubleshooting license registration.................................................................74
Get maintenance key from Four Js website.......................................................75
Steps to finalize temporary BDL license..............................................................75
  Finalize BDL license with user interface (via internet).....................................76
  Finalize BDL license with user interface (no internet)......................................77
  Finalize BDL license from the command line (via internet).............................79
  Finalize BDL license from the command line (no internet)..............................79
Steps to apply maintenance or subscription key (BDL)........................................80
  Install or update the maintenance key (BDL) with UI (via internet)...............80
  Install or update the maintenance key (BDL) with UI (no internet)...............82
  Install or update the maintenance key (BDL) with fglwrt (via internet).........83
  Install or update the maintenance key (BDL) with fglwrt (no internet).........83
License using Four Js License Manager..............................................................83
License Genero Report Engine (GRE)................................................................83
Steps to GRE license installation........................................................................84
  Install Genero Report Engine license with GUI (internet)..............................84
  Install GRE license with GUI (no internet)......................................................85
  Install GRE license from the command line...................................................86
  Install GRE license from the command line...................................................87
Manage Genero Report Engine local license......................................................88
  License Controller (greWrt) options...............................................................88
  Get license information..................................................................................89
  Uninstall license.............................................................................................92
  License an upgraded installation.....................................................................93
Register license on Four Js website.....................................................................93
Get maintenance key from Four Js website.......................................................95
Steps to finalize temporary GRE license............................................................96
  Finalize Genero Report Engine license with GUI (via internet).....................97
  Finalize Genero Report Engine license with GUI (no internet)......................98
  Finalize Genero Report Engine license from the command line (via internet) 99
  Finalize Genero Report Engine license from the command line (no internet) 100
Steps to apply maintenance or subscription key (GRE).......................................100
  Install or update the maintenance key (GRW) with GUI (via internet)..........101
  Install or update the maintenance key (GRW) with GUI (no internet)..........102
  Install or update the maintenance key (GRE) with greWrt (via internet).......103
  Install or update the maintenance key (GRE) with greWrt (no internet).......103
License Genero Report Engine using the Four Js License Manager....................103
License Genero Mobile.......................................................................................103
  Find your mobile app p-code size..................................................................104
License using license manager..........................................................................106
  License Manager configuration......................................................................106
<table>
<thead>
<tr>
<th>Contents</th>
<th>v</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring the License Manager</td>
<td>106</td>
</tr>
<tr>
<td>Configuring the license controller</td>
<td>107</td>
</tr>
<tr>
<td>Steps to licensing with FLM</td>
<td>108</td>
</tr>
<tr>
<td>Install license with Four Js License Manager (via internet)</td>
<td>109</td>
</tr>
<tr>
<td>Install license with Four Js License Manager (without internet)</td>
<td>110</td>
</tr>
<tr>
<td>Manage licenses with FLM (flmprg)</td>
<td>111</td>
</tr>
<tr>
<td>FLM (flmprg) options</td>
<td>111</td>
</tr>
<tr>
<td>Remove a license (Four Js License Manager)</td>
<td>113</td>
</tr>
<tr>
<td>Display license information and statistics</td>
<td>113</td>
</tr>
<tr>
<td>Manage the active user list (flmprg)</td>
<td>116</td>
</tr>
<tr>
<td>Restricting access to a Four Js License Manager</td>
<td>117</td>
</tr>
<tr>
<td>Reload the configuration file (Windows only)</td>
<td>118</td>
</tr>
<tr>
<td>Steps to finalize temporary license with FLM</td>
<td>118</td>
</tr>
<tr>
<td>Install license with FLM (via internet)</td>
<td>118</td>
</tr>
<tr>
<td>Finalize license with FLM (via internet)</td>
<td>119</td>
</tr>
<tr>
<td>Steps to apply maintenance (FLM)</td>
<td>120</td>
</tr>
<tr>
<td>Install the maintenance key with Four Js License Manager (via internet)</td>
<td>120</td>
</tr>
<tr>
<td>Install the maintenance key with Four Js License Manager (without internet)</td>
<td>121</td>
</tr>
</tbody>
</table>

**License sharing with docker** | 121 |
| Install FGLGWS on host | 122 |
| Build operating system image | 122 |
| Build docker image with FGLGWS package | 123 |
| Run docker container | 125 |
| Assign host license to docker container | 125 |
| Release docker container license | 126 |

**Troubleshoot license issues** | 127 |

**License logs** | 127 |

**Upgrading** | 128 |
| New Features of Genero License | 128 |
| Licensing 3.10 new features | 129 |
| Licensing 3.00 new features | 130 |
| Upgrade Guides for Licensing | 130 |
| Upgrade the FLM without re-applying licenses | 130 |

**Copyrights and Trademarks** | 131 |

**Index** | 132 |
Install and License your Genero Products

The installation instructions for all of the packages provided by the Genero Enterprise suite.

This manual provides installation instructions for the products that comprise the Genero Enterprise suite:

- Genero BDL with Web Services (BDL)
- Genero Application Server (GAS)
- Genero Studio (GST)
- Genero Suite Server (Genero Studio Server plus all components)
- Genero Desktop Client (GDC)
- Genero Mobile for Android™ (GMA)
- Genero Mobile for iOS (GMI)
- Genero Ghost Client (GGC)
- Genero Report Engine (GRE)

This manual covers the installation and licensing of the product. Configuration of a product is covered in product-specific administrator and user manuals.

Genero Installation Basics

Regardless of the product, there are basics that are true across the Genero packages:

- The what, where, and when of installation on page 7
- Software package names on page 7
- Installation conventions on page 8
- Product version life cycle on page 9
- Installation troubleshooting tips on page 10

Product-specific Installation Guides

Click on a link to access a product-specific installation guide:

- Install Genero Business Development Language on page 11
- Install Genero Desktop Client on page 16
- Install Genero Application Server on page 21
- Install Genero Studio on page 27
- Install Genero Report Engine on page 41
- Install Genero Report Designer on page 44
- Install Four Js License Manager on page 46

Licensing your products

Click on a link to learn more about licensing your Genero installation:

- License Genero Business Development Language on page 52
- License Genero Report Engine (GRE) on page 83
- License using license manager on page 106

Note: For a general overview and introduction to licensing Genero products, see Genero Licensing manual.
The what, where, and when of installation

This topic covers what you should install (bundled software or individual packages) and where you should install it (server or workstation) based on what you want to do (development or production).

Software Bundle versus Individual Package

Genero software is provided as both software bundles and, for some products, as individual packages.

Individual packages include:
- Genero BDL with Web Services (BDL)
- Genero Desktop Client (GDC)
- Genero Application Server (GAS)
- Genero Report Engine (GRE)
- Genero Report Designer (GRD)

When you install individual packages, each package creates its own installation directory.

Software bundles include:
- Genero Studio (Studio + GRE + BDL + GAS + GDC)
- Genero Suite Server (Studio Server + GRE + BDL + GAS)

When you install a bundle, the installation puts all of the Genero products in a single install directory, with child directories for each product included in the package (fgl, gas, gdc, gre and gst). You can opt during the installation to include or exclude any of the individual components when installing a bundle.

Installation for Development

For development, you can install the Genero Suite Client/Server software bundle on your local machine. This provides all the software you need, pre-configured to work together. You do not need a Web server for your development environment; you can use the standalone Genero Application Server to test your Web applications and Web services.

Installation for Production

For a production environment, you must use a Web server with the Genero Application Server. It is recommended that the Genero Business Development Language, Genero Application Server and your Web server sit on the same server host. The database can be on a separate machine, and the end-user client software will sit on the client machine (or be delivered to a browser that sits on the client machine). For more information, refer to the various User Guides to see different architecture scenarios.

Related concepts

Product version life cycle on page 9
A strategy for installing and using different versions of Genero software is described.

Software package names

Genero software packages use a standard nomenclature.

All Four Js software packages follow a specific naming convention:

\texttt{fjs-product-version-build-osident.extension}

where:
- \textit{product} is the product identifier.
- \textit{version} is the software release number.
• *build* is the build number.
• *osident* is the operating system identifier.
• *extension* is the file extension:
  • *run* on UNIX™ platforms
  • *exe* on Windows® platforms
  • *dmg* or *run* on macOS® platforms.

**Examples**

- fjs-fglgws-3.10.00-build2239_gws126106-a640610.run
- fjs-fglgws-3.10.00-build2239_gws126106-w64v100.exe
- fjs-gdc-3.10.03-build4949-1641x25.run

**Installation conventions**

Genero software installations use standard conventions, for example, for environment and directory structure.

All Four Js software installations follow conventions which are common between products.

**Installation environment**

Typically environment variables, which define the installation directory of Genero products, follow this recognizable format:

*product identifying code DIR*

Where, for example:

- *FGLDIR* is the variable that sets the Genero Business Development Language (BDL) installation directory.
- *GDCDIR* sets the Genero Desktop Client (GDC) installation directory.
- *FGLASDIR* sets the Genero Application Server (GAS) installation directory.
- *GSTDIR* sets the Genero Studio (GST) product installation directory.
- *GREDIR* sets the Genero Report Engine (GRE) installation directory.
- *GRDDIR* sets the Genero Report Designer (GRD) installation directory.
- *FLMDIR* sets the Four Js License Manager (FLM) installation directory.

**Scripts to set environment**

Scripts that ensure that PATH, installation directory and other dependent environment variables are set correctly, are run in the installation directory at installation time. The name of the associated script files (*sh* for Linux® or *bat* for Windows®) follow this recognizable format:

*env product identifying code*

Where, for example:

- *envcomp* is the script that sets the Genero Business Development Language installation environment.
- *envas* sets the Genero Application Server installation environment.
- *envgst* sets the Genero Studio product installation environment.
- *envgre* sets the Genero Report Engine installation environment.
- *envflm* sets the Four Js License Manager installation environment.

**Note:** As the Genero Studio installation also installs the Genero Business Development Language, the Genero Application Server, the Genero Report Engine, and the Genero Desktop Client, the environment is set for all at installation time by the wrapper script *envgenero.*
Installation directory structure

There is a standard directory structure used across the Four Js product installation. Where, for example, some directories are product specific, these are standard directories:

- **bin** contains the product executables.
- **lib** contains library extension files.
- **release** contains the copyright details.
- **license** contains end user and third-party license information.

Version and help

Command line program tools, such as compilation *fglcomp*, runtime system tool (*fglrnTheSpace*), and other tools, for example, *fglgar*, *gasadmin*, etc., follow a standard use of options to provide version information and help with the tool. See Table 1: Version and help options on page 9.

Table 1: Version and help options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-V or --version</td>
<td>Display version information for the tool.</td>
</tr>
<tr>
<td>-h or --help</td>
<td>Display options for the tool. Short help.</td>
</tr>
</tbody>
</table>

Product version life cycle

A strategy for installing and using different versions of Genero software is described.

To maintain more than one Genero product version, you install the version you are planning to install as described in the installation section, with the following additional considerations.

When prompted for the destination directory during installation, ensure that a distinct directory is used for each installed Genero version. For example:

- Enter the name of a separate directory in which to install each version. Give the directory a name including exact product version (for example, *fglgws-3.10.00*) to ensure the directory specified is not the same as that used for any other installed version.

  **Tip:** It is recommended to store all versions beneath an application root directory (for example, */opt/fourjs/fgl*).

- To switch between versions, use either generic symbolic links or set environment variables. Examples of both methods are given.

Example 1: generic symbolic links

You have two symbolic links, one for the product version installation directory, and one perhaps for your application directory where your application files (.*, .42r, .42m, .4st, etc.) are stored. These symbolic links remain the same regardless of the version in use. For example:

- You create a symbolic link at */opt/fourjs/fgl* pointing to the current installed version at */opt/fourjs/fgl.3.10.08*
- You create a symbolic link at */opt/myapp* pointing to your current application directory at */opt/myapp.1.23.4*, where 1.23.4 is the application version number.

At upgrade time, you change the symbolic links, to point to the latest installed version and your latest application version directory.

- */opt/fourjs/fgl* now points to */opt/fourjs/fgl.3.10.09*
- */opt/myapp* now points to */opt/myapp.1.24.1*
**Example 2: environment variables**

This method uses the same principle as the symbolic link example. You have two environment variables, one for the product installation directory, and one for your current application directory. These remain the same regardless of the version in use. For example:

- You set the environment variable FGLDIR to `/opt/fourjs/fgl.3.10.08`
- You set MYAPP to `/opt/myapp.1.23.4`

At upgrade time, you change the values of the environment variables, to point to the latest installed version and your latest application version directory.

- FGLDIR now has the value `/opt/fourjs/fgl.3.10.09`
- MYAPP now has the value `/opt/myapp.1.24.1`

**Switching between product versions**

To switch between versions, it is simply a case of changing the symbolic links or environment variables (whichever method you use). The advantage is that you can run two versions in parallel beforehand to test, or you can run a previous version after an upgrade to compare changes. This allows you to revert back quickly if something goes wrong.

**Installation troubleshooting tips**

If you have an issue during installation, generating a log of the installation can provide valuable information for support.

How you log an installation of a Genero package depends on your operating system.

**Table 2: Logging your installation**

<table>
<thead>
<tr>
<th>Operating System</th>
<th>How to log the installation</th>
</tr>
</thead>
</table>
| **Windows**®     | 1. Extract the `msi` file from the software package executable (exe):  
|                  | `fjs-package-name.exe /x`  
|                  | 2. From the command line execute:  
|                  | `msiexec /i fjs-package-name.msi /log mylogfile.log`  
|                  | **Important:** On Windows®, you must run the command as administrator. It is not enough to simply have administrator permissions. |
| **UNIX™**        | From the command line:  
|                  | 1. `export FGLINSTALLDEBUG=1`  
|                  | 2. `./fjs-package-name 2>&1 | tee fjs.log` |
| **Mac®**         | See [Debug the Genero Studio Install on macOS (GUI installer)](page) on page 34. |
Install Genero Business Development Language

These topics relate to the installation of Genero Business Development Language.

- Genero BDL software requirements on page 11
- Install Genero BDL procedures on page 12

Note: See the Genero Business Development Language User Guide for additional installation and configuration information.

Genero BDL software requirements

Before installing, ensure that your system meets the minimum system requirements and additional software.

Operating systems

The Genero Business Development Language is supported on a variety of operating systems. You must install the software package corresponding to the operating system that you use.

For a detailed list of supported operating systems, refer to the Supported platforms and databases document (available on the Products download page of the Four Js Web site) or contact your support center. This document also informs you which operating systems will no longer be supported as of the next release.

Disk space

As the amount of disk space required may vary slightly, depending on the operating system, and the released version, you will need to estimate disk space. The disk space needed for installation may be calculated by multiplying the size of the download file by 5. Once the product is installed, the required disk space is approximately the size of the download file multiplied by 2.

Database client software

To connect to a database server, the database client software must be installed on the system where you run the Genero BDL programs.

The Genero runtime system uses database drivers to connect to database servers, as a database client program. Database vendor-specific client software needs to be installed on the system where you run the Genero programs.

Genero database drivers are shipped as shared libraries and require a database vendor client software shared library such as Informix® Client SDK (with ESQL/C), Oracle® Client (with OCI), Microsoft® SQL Server ODBC. The database driver to be selected must correspond to the database client type and version.

For a detailed list of supported databases, database driver names, and operating systems on which those database drivers are supported, refer to the Supported platforms and databases document (available on the Products download page of the Four Js web site) or contact your support center. This matrix also informs you which database drivers will no longer be supported as of the next release.

C compiler for C Extensions

Applications using C extensions need a C compiler and linker to build the C extension library that will be loaded by the runtime system.

On UNIX® platforms, you need a cc compiler on the system where you create the C extension libraries. Note that some UNIX® systems do not have a C compiler installed by default.
On Windows® platforms, it is mandatory to install Microsoft® Visual C++ version corresponding to the installed Genero BDL package. The OS identifier of the Genero BDL package file name identifies the Visual C++ version to be used.

**Java**

In order to use the Java Interface in your application programs, you need the Java software installed and properly configured.

- Install a Java Development Kit on development sites (if you need to compile your own Java classes)
- Install a Java Runtime Environment on production sites (on the server where your programs are running)

**Note:** Over time, the Java platform has used different versioning systems, to distinguish a “Java developer version”, from a “Java product version”. For example, the Java developer version (JDK) 1.8 corresponds to the Java product version 8. With recent versions like Java 10, a unique version numbering convention is used.

The Java classes defined by Genero (com.fourjs.fgl.lang.*) are compiled with `javac -source 1.6 -target 1.6` options. Therefore, the minimum theoretical version is Java SE 6. However, depending on the platform, the minimum required Java version may be greater than version 6.

**Note:** As a general rule, always install the current long-term-support (LTS) Java version available on your platform, with JNI support. For example, Java SE 8 (released in March 2014) and Java SE 11 (released in September 2018) are LTS versions.

For a detailed list of supported JVMs, refer to the *Supported platforms and databases* document (available on the Products download page of the Four Js Web site) or contact your support center.

The version of the installed Java software can be shown with the command:

```
java --version
```

In order to execute Java byte code, the Genero runtime system uses the JNI interface. The JVM is loaded as a shared library and its binary format must match the binary format of the Genero runtime system. For example, a 64-bit Genero package requires a 64-bit JVM.

When implementing Java classes for Genero Mobile for Android™ (GMA), check the JDK version required by the Android™ SDK. For more information, see the Android™ Studio web site.

### Install Genero BDL procedures

Please review the installation procedures before installing the product.

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

- *Genero Business Development Language packages* on page 12
- *Pre-install tasks* on page 13
- *Install Genero BDL on UNIX platforms* on page 13
- *Install Genero BDL on Windows platforms* on page 14
- *Post-install tasks* on page 16

### Genero Business Development Language packages

The Genero Business Development Language software is a self-extractable installation program.

Genero BDL package files follow a specific naming convention:

```
fjs-product-version-build-osident.extension
```

where:

- *product* is the product identifier
• *version* is the release number of the software
• *build* is the build information
• *osident* is the operating system identifier
• *extension* is **run** on UNIX™ platforms, **exe** on Windows® platforms, and **dmg** or **run** on macOS™ platforms.

**Examples**

```
fjs-fglgws-3.10.00-build2239_gws126106-a640610.run
fjs-fglgws-3.10.00-build2239_gws126106-w64v100.exe
```

**Pre-install tasks**

Before launching the installation program, make sure:

1. You have a license number and a license key for Genero BDL development or runtime. See **License Genero Business Development Language** on page 52 for more details.
2. You have a valid maintenance contract (for BDL versions 2.20 or higher) and maintenance key. See **License Genero Business Development Language** on page 52 for more details.
3. You are using a **supported operating system**.
4. You are connected to the system as a user with sufficient privileges to install the software in the target directory.
5. Your configuration matches all hardware requirements and software requirements.

In addition there are some environment and database considerations that you may need to take care of before installation. Make sure:

**Important:** Before starting the installation program, make sure that the database client environment variables are set.

1. You have set the environment variables for the database client software (for example, **INFORMIXDIR**).
2. You have access to all needed DLLs (PATH) or shared libraries (**LD_LIBRARY_PATH**, **LD_LIBRARY_PATH_64**, **SHLIB_PATH**, **LIBPATH** or **DYLD_LIBRARY_PATH**).
3. You can use the **C compiler**, if you need to create **C Extensions**.
4. You can use the **JDK**, if you need to use the **Java Interface**.

**Install Genero BDL on UNIX™ platforms**

Follow these steps to install Genero Business Development Language (BDL) on UNIX™ platforms.

On UNIX™ platforms, Genero BDL is provided as an auto-extractable shell script. Distribution files and installation program are provided in the same file.

The installation program has options. Display the installation program options using the help (−h) option, for example:

```
./fjs-fglgws-3.10.02-build2281_gws128706-164p125.run −h
```

1. To perform the installation, run the auto-extractable shell script without any option.
   
   For example: `./fjs-fglgws-3.10.02-build2281_gws128706-164p125.run`
   
   The installation program determines the operating system and checks that all the system requirements are met before starting to copy the product files to your disk.

2. Follow the instructions of the installation program.
   
   Answer the questions, including the request for license key and number (See **License Genero Business Development Language** on page 52).

**Related concepts**

**Product version life cycle** on page 9

A strategy for installing and using different versions of Genero software is described.

**Post-install tasks** on page 16
Tasks to complete after the installation of Genero BDL.

Installation troubleshooting tips on page 10
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

Install Genero BDL on Windows® platforms
Install Genero BDL on Windows® platforms.

1. Execute the installation package to start the Setup Wizard.
   
   \texttt{fjs-product-version-build-osident.exe}
   
   Example:
   
   \texttt{fjs-fglgws-3.10.00-build2239_gws126106-w64v100.exe}

2. Follow the instructions of the installation program.
   
   Answer the questions, including the request for license key and number (See License Genero Business Development Language on page 52).

Related concepts
Install BDL on Windows platforms using the MSI installer on page 14
Install Genero BDL on Windows® platforms using the MSI installer.

Post-install tasks on page 16
Tasks to complete after the installation of Genero BDL.

Product version life cycle on page 9
A strategy for installing and using different versions of Genero software is described.

Installation troubleshooting tips on page 10
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

Install BDL on Windows® platforms using the MSI installer
Install Genero BDL on Windows® platforms using the MSI installer.

On Microsoft® Windows®, the Genero BDL package is provided with a standard MSI Windows® setup program. Distribution files and installation program are provided in the same file.

Installing and uninstalling in silent mode on Windows®

The \texttt{.exe} file is a boot-strapper including the \texttt{.msi} file. You may want to extract the \texttt{.msi} file by running the \texttt{.exe} with the /\texttt{x} option, in order to run the \texttt{.msi} installation in silent mode, for example:

\texttt{fjs-fglgws-3.10.02-build2281_gws128706-w32v100.exe /x}

To install or uninstall Genero BDL in silent mode, you can use the \texttt{msiexec} command line utility. The \texttt{msiexec} utility provides the means to install, modify, and perform operations on Windows® Installer from the command line.

Table 3: msiexec install and uninstall options on page 14 shows the most common options for \texttt{msiexec} relating to installation and un-installation.

Table 3: msiexec install and uninstall options

<table>
<thead>
<tr>
<th>msiexec option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/qn</td>
<td>Quiet mode with no UI.</td>
</tr>
<tr>
<td>/i package-name.msi</td>
<td>Install the specified msi package.</td>
</tr>
<tr>
<td>/x package-name.msi</td>
<td>Uninstall the specified msi package.</td>
</tr>
</tbody>
</table>
### msiexec option

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/log logfile</td>
</tr>
</tbody>
</table>

Enter `msiexec` from the DOS command prompt to view the complete list of available options.

You can pass arguments to the `msiexec` installer on the command line.

**Table 4: Arguments for the msiexec installer**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRODUCTDIR=fgldir-path</td>
<td>The path where BDL will be installed. It is an alias of FGLDIR variable.</td>
</tr>
<tr>
<td>FGLDIR=fgldir_path</td>
<td>The path where BDL will be installed. It is an alias of the PRODUCTDIR variable.</td>
</tr>
<tr>
<td>STARTMENUFOLDER=startmenu-folder</td>
<td>Customize the location for the shortcuts in the startmenu. For example, &quot;fjs\fgl&quot;.</td>
</tr>
<tr>
<td>FORCEREMOVEPRODUCTDIR=YES</td>
<td>On uninstall, remove the PRODUCTDIR location, even if it is not empty. YES = Force removal of PRODUCTDIR. Other = Keep files in PRODUCTDIR. Default value: &quot;&quot; (empty string)</td>
</tr>
</tbody>
</table>

**Note:** Quotes are only required around the argument value when a space character is in the value string. Call your support center for more details if this silent installation is required.

### Install Genero BDL on macOS™

**Before you begin**

Review the Genero BDL software requirements on page 11.

You need a macOS™ and an user account which has administrator access level.

Download the installation package for the macOS™.

If you plan to license Genero BDL during the installation process, ensure you have the license number, license key, and maintenance number available.

**About this task**

Follow these instructions to install the Genero BDL on macOS.

1. Determine the directory where you will install the product.
   
   The wizard will eventually suggest `/opt/fourjs/fgl`. If you plan to use this default, ensure you have write permission to this directory.

2. Log in as a user with permission to write to the directory in which you plan to install this product.

3. Copy the self-extractable file into a temporary directory.

4. From a command prompt, run the self-extractable shell script with the -i option:

   ```
   sh fjs-fgl-3.xx.xx-buildxxxxxx-m64x1011.run -i
   ```

   **Note:** The "x" entries in the file name example above must use the actual numbers of the downloaded file!

5. Follow the instructions displayed.

   **Tip:** After you have read the licensing agreement, press "q" to return to the instructions and prompts.
At some point in the instructions, you will be asked whether you wish to provide the licensing details for the Genero Business Development Language. If you skip this step during the installation, you can always go back later to provide the licensing details.

When asked about providing the licensing details for the Genero Report Engine, you can choose to not license the GRE. A GRE license is not necessary if you have a Genero BDL license with maintenance support.

What to do next

When installation is complete, see the *Genero Business Development Language User Guide* for configuration information and instructions.

Related concepts

Installation troubleshooting tips on page 10

If you have an issue during installation, generating a log of the installation can provide valuable information for support.

Post-install tasks

Tasks to complete after the installation of Genero BDL.

After installing the product, it is recommended that you first read the license terms provided in the FGLDIR/license directory.

Release information files are provided in FGLDIR/release directory: The readme.txt file may contain important last-minute information that may not be found in the documentation.

A list of corrected defects can be accessed at the issue tracker page of the Four Js website at the following URL: http://www.4js.com/support/issue/FGL

It is recommended that you read the details of the new features as well as upgrade notes provided in the Upgrading section of *Genero Business Development Language User Guide*.

Depending on the database server you want to connect to, you will need to set up the correct database driver in FGLPROFILE. The default database driver is selected at installation time. For more details about database driver configuration, see Connections in the *Genero Business Development Language User Guide*

Tip: If you have configurations from a previous installation version, for example in your fglprofile, avoid copying these files in to your new installation. The preferred practice is to use the default from the new install package so that you benefit from any new or changed syntax it may contain and then reapply your custom changes.

For additional post installation and configuration information see the Installation topics in the *Genero Business Development Language User Guide*.

Related concepts

Product version life cycle on page 9

A strategy for installing and using different versions of Genero software is described.

Install Genero Desktop Client

These topics relate to the installation of the Genero Desktop Client.

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

**Note:** See the *Genero Desktop Client User Guide* for additional installation and configuration information.

- **GDC system requirements** on page 17
- **Genero compatibility** on page 17
- **Install GDC on Windows** on page 18
• Install GDC on Windows platforms using the MSI installer on page 19
• Install GDC on macOS on page 20
• Install GDC on X11 systems on page 21

GDC system requirements
Before installing the Genero Desktop Client package, ensure that your system meets the minimum system requirements.

Operating systems
The Genero Desktop Client is supported on a variety of operating systems.
For a detailed list of supported operating systems, refer to the Supported platforms and databases document (available on the Products download page of the Four Js Web site) or contact your support center. This document also informs you which operating systems will no longer be supported as of the next release.

Disk space
As the amount of disk space required may vary slightly, depending on the operating system, and the released version, you will need to estimate disk space. The disk space needed for installation may be calculated by multiplying the size of the download file by 5. Once the product is installed, the required disk space is approximately the size of the download file multiplied by 2.

Genero compatibility
Determine the compatibility of different versions of the Genero product family and the Genero Desktop Client.

GDC 3.10 and Genero compatibility
Ensure your Genero installation is valid for GDC 3.10.
GDC 3.10 is compatible with Genero runtime system (DVM) 3.00 or 3.10 in direct mode.
GDC 3.10 is compatible with a 3.10 server-side configuration (DVM 3.10 + GAS 3.10) or a 3.00 server-side configuration (DVM 3.00 + GAS 3.00) in UA mode.
GDC 3.10 is not compatible with Genero runtime system 2.5x or earlier.

GDC 3.00 and Genero compatibility
Ensure your Genero installation is valid for GDC 3.00.
GDC 3.00 is compatible with Genero runtime system (DVM) 3.00.
When using an HTTP connection through the GAS:
• GDC 3.00 should use uaproxy (ua) and requires a Genero runtime system (DVM) 3.00.
GDC 3.00 is not compatible with Genero runtime system 2.5x or earlier.

GDC 2.50 and Genero compatibility
Ensure your Genero installation is valid for GDC 2.50.
Genero Desktop Client 2.5x will work only with Genero Runtime Systems 2.5x plus 2.4x, 2.3x, 2.2x and 2.1x for backward compatibility. It is not supported with Genero Runtime Systems 2.0x and 1.3x.
When using an HTTP connection through the GAS:
• GDC 2.50 should use gdcproxy (wa) and requires a Genero runtime system (DVM) 2.50.
For those who connect through HTTP, Genero Desktop Client and Genero Application Server need to be on the same level; for instance, both would need to be 2.5x. Genero Desktop Client 2.5x is **NOT** backward compatible with versions 1.3x, 2.0x, 2.1x, 2.2x, 2.3x and 2.4x of the Genero Application Server, mainly for stability reasons due to the HTTP stack review.

If you have any doubts regarding compatibility between versions, contact your support center.

---

**Install GDC on UNIX™ platforms**

Follow these steps to install GDC on UNIX™ platforms.

On UNIX™ platforms, GDC is provided as an auto-extractable shell script. Distribution files and installation program are provided in the same file.

The installation program has options. Display the installation program options using the help (\-h) option, for example:

```
./fjs-gdc-3.10.11-build158046-164x1212.run -h
```

1. To perform the installation, run the auto-extractable shell script without any option.
   
   For example:
   
   ```
   ./fjs-gdc-3.10.11-build158046-164x1212.run
   ```

   The installation program determines the operating system and checks that all the system requirements are met before starting to copy the product files to your disk.

2. Follow the instructions of the installation program.

**Related concepts**

- **Product version life cycle** on page 9
  A strategy for installing and using different versions of Genero software is described.

- **Post-install tasks** on page 16
  Tasks to complete after the installation of Genero BDL.

- **Installation troubleshooting tips** on page 10
  If you have an issue during installation, generating a log of the installation can provide valuable information for support.

---

**Install GDC on Windows®**

Procedure to install GDC on Windows® using the exe file.

1. Close all running applications.

2. Execute the installation program.

   On Windows® Vista, Windows® 7, Windows® 8, and Windows® 10, administrator privileges are needed to perform the installation. UAC will pop up, you will need to validate it to install GDC.

3. Press 'Next' to start the installation.

4. If you accept the agreement, check 'I accept the terms in the License Agreement' and click 'Next' to continue.

5. Select the folder in which you want to install GDC.

6. Determine whether to grant read/write/modify permissions on the installation directory to the Users group.

   The option must be selected to allow the GDC auto-updater to work silently. However, granting these permissions may be considered as unsecure. Consult with your Genero application administrator.

7. Select the StartMenu folder in which GDC shortcuts will be set.

8. Determine whether to associate .gdc files with the GDC.

   GDC shortcuts can be stored as a .gdc file. By associating this extension with this GDC, you can start GDC by double-clicking a .gdc file in Explorer. You can enable or disable the file associations.
GDC is now ready to be installed.

9. Click **Install** to begin the installation.
   All files are copied.

10. Click **Finish** to close the installation wizard.
    The GDC is installed. You can now run the GDC.

**Related concepts**

Installation troubleshooting tips on page 10
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

**Install GDC on Windows® platforms using the MSI installer**

Install Genero Desktop Client on Windows® platforms using the MSI installer.

**MSI installer**

The GDC installer uses MSI technology. To be compliant with Microsoft® User Access Control (UAC) requirements, the msi file is embedded inside an exe file. You can extract the msi file from the exe file using the /x option:

```
c:\fjs-gdc-version-build-osident.exe /x
```

Example:

```
c:\fjs-gdc-3.10.03-build4949-w32v100.exe /x
```

This creates a msi file with the same name.

**Install and uninstall in silent mode**

To install and uninstall GDC in silent mode, you can use the msiexec command line utility. The msiexec utility provides the means to install, modify, and perform operations on Windows® Installer from the command line.

The following options for msiexec are the most common options regarding installation and uninstallation. Enter msiexec from the command prompt to view the complete list of available options.

```
msiexec /qn - Quiet mode with no UI
/i fjs-gdc-version-build-osident.msi - Install the specified msi package
/x fjs-gdc-version-build-osident.msi - Uninstall the specified msi package
/log logfile - Log to the specified log file
/l*vx logfile - Provide verbose (detailed) logs in the specified log file
```

**Arguments**

You can pass arguments to the msiexec installer on the command line.

**Table 5: Arguments for the msiexec installer**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRODUCTDIR=your_gdcdir_path</td>
<td>The path where GDC will be installed. It is an alias of GDCDIR variable.</td>
</tr>
<tr>
<td>GDCDIR=your_gdcdir_path</td>
<td>The path where GDC will be installed. It is an alias of the PRODUCTDIR variable.</td>
</tr>
<tr>
<td>STARTMENUFOLDER=your_startmenufolder_path</td>
<td>Customize the location for the shortcuts in the startmenu. For example, &quot;fjs\gdc&quot;.</td>
</tr>
<tr>
<td>Argument</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>ADDLOCAL=[ALL,GDC,GDCFILEASSOCGDC]</td>
<td>Set the features to install.</td>
</tr>
<tr>
<td>• ALL (default): Install GDC (mandatory) and .gdc file association</td>
<td></td>
</tr>
<tr>
<td>• GDC: Install GDC only</td>
<td></td>
</tr>
<tr>
<td>• GDC, GDCFILEASSOCGDC: Same as ALL</td>
<td></td>
</tr>
<tr>
<td>FORCEREMOVEPRODUCTDIR=YES</td>
<td>On uninstall, remove the PRODUCTDIR location, even if it is not empty. Default value: &quot;&quot; (empty string)</td>
</tr>
<tr>
<td>• YES = Force removal of PRODUCTDIR</td>
<td></td>
</tr>
<tr>
<td>• Any other entry = Keep files in PRODUCTDIR</td>
<td></td>
</tr>
<tr>
<td>FORCEWRITEPERM=YES</td>
<td>Specify whether to grant read, write, and modify permissions on the installation directory to the Users group. These permissions are needed to allow the GDC auto-updater to work silently. However, granting these permissions may be considered as unsecure. Consult with your Genero application administrator.</td>
</tr>
<tr>
<td>• YES sets the permissions.</td>
<td></td>
</tr>
<tr>
<td>• Any other value but YES will be understood as NO, and the permissions will not be set.</td>
<td></td>
</tr>
</tbody>
</table>

Note: Quotes are only required around the argument value when a space character is in the value string.

Related concepts
Installation troubleshooting tips on page 10
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

Product version life cycle on page 9
A strategy for installing and using different versions of Genero software is described.

Install GDC on macOS™

Procedure for installing GDC on macOS™.

Before you begin
Review the GDC system requirements on page 17.
You need a macOS™ and an user account which has administrator access level.
You need the GDC .dmg package. For example: fjs-gdc-3.xx.xx-buildxxxxxx-m64xxxxx.dmg, where the "x" are placeholders for version and build numbers.

About this task
Follow these instructions to install the Genero Desktop Client.

1. Close all applications.
2. Double-click on the drive image file (dmg).
   The image file is mounted by macOS™.
3. Double-click on the package file (mpkg).
   The installation wizard displays.
4. Follow the installation instructions presented by the wizard.

What to do next
When installation is complete, see the *Genero Desktop Client User Guide* for configuration information and instructions.

**Related concepts**

*Installation troubleshooting tips* on page 10
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

---

**Install GDC on X11 systems**

Procedure to install GDC on X11 systems

By default, the script un-compresses data into DBTEMP. Please make sure you have the correct permissions for this directory. If you do not have the necessary permissions, either unset DBTEMP (/tmp will be used), or use the `-w <tempdir>` option to specify an alternate temporary directory.

1. Close all applications.
2. Execute the installation shell. At the command line, enter the name of the package to install.
   
   `./fjs-gdc-version-build-osident.run`

   Example:
   
   `./fjs-gdc-3.10.03-build4949-l64lx25.run`

3. Follow the directions that appear.

**Related concepts**

*Installation troubleshooting tips* on page 10
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

---

**Microsoft® Windows® Security Blocking**

The Windows® firewall, enabled by default, detects and blocks the Genero Studio Server and the Genero Desktop Client.

From the network point of view, Genero Studio Server and the Genero Desktop Client (used by Genero Studio to display forms) are both considered servers. When you start Genero Desktop Client, or attempt to connect to Genero Studio Server, the firewall detects this and blocks the programs.

A dialog allows you to unblock the program. Follow the instructions provided by the dialog.

If you select **Keep Blocking** or **Ask Me Later**, the firewall continues to block the program(s).

If **Keep Blocking** has been pressed by mistake, you can change this parameter in the Windows® Firewall settings. Ensure you add Genero Studio, Genero Studio Server and Genero Desktop Client to the list of exceptions or allowed apps, and make sure that their listings have a check mark.

---

**Install Genero Application Server**

These topics relate to the installation of the Genero Application Server.

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

Before starting the installation, verify your system meets the system requirements.
The software is provided as an auto-extractible installation program (i.e. product files and installation program are provided in the same file). The name of the package includes the operating system type and version. You must install the Genero Application Server software package corresponding to the operating system that you use.

For the detailed list of supported operating systems, refer to the System Support matrix (available on the Four Js web site documentation or download area) or contact your support center.

The Genero Application Server and the Genero BDL runtime should be installed on the same machine.

**Note:** See the *Genero Application Server User Guide* for additional installation and configuration information.

- Genero compatibility for the GAS on page 23
- Install Genero Application Server on UNIX platforms on page 23
- Install on Microsoft Windows platforms on page 24
- Install and uninstall in silent mode on Microsoft Windows platforms on page 25

### GAS system requirements

Failure to meet system requirements can result in unexpected behavior.

**Important:** For the most current information, refer to the *Supported platforms and databases* document (available on the Products download page of the Four Js Web site) or contact your support center. This document also informs you which operating systems will no longer be supported as of the next release.

#### Operating systems

Linux®, IBM®, AIX®, HP-UX®, Sun® Solaris and Microsoft® Windows®.

For a detailed list of supported operating systems, refer to the *Supported platforms and databases* document (available on the Products download page of the Four Js Web site) or contact your support center. This document also informs you which operating systems will no longer be supported as of the next release.

#### Disk space

As the amount of disk space required may vary slightly, depending on the operating system, and the released version, you will need to estimate disk space. The disk space needed for installation may be calculated by multiplying the size of the download file by 5. Once the product is installed, the required disk space is approximately the size of the download file multiplied by 2.

#### Web Servers

Web server support depends on the platform hosting the Genero Application Server.

On Windows® platforms, typically Internet Information Services is used. For more information on prerequisites and configuration see *ISAPI installation* in the *Genero Application Server User Guide*.

On Linux®/UNIX™ platforms, we recommend Apache httpd, lighttpd and nginx. However, any Web server that is compatible with fastcgi can be used. For more information, refer to http://httpd.apache.org. To install and configure the required components, see *FastCGI* in the *Genero Application Server User Guide*.

#### User Agents

While these user agents can be used by the GAS, they are not provided as part of the GAS installation.

**Genero Desktop Client (GDC)**

The Genero Desktop Client allows you to run the application through the GAS, yet deliver the application locally using the GDC. For more information about the GDC, refer to the *Genero Desktop Client User Guide*.

**Genero Browser Client (GBC)**

The GBC allows you to deliver Genero applications in a Web browser on the client machine. It is a JavaScript
client that works with Node technology. The Genero Browser Client is provided as part of the FGLGWS installation. For more information see the Genero Browser Client User Guide.

For the latest list of the browsers supported by the Genero Browser Client, refer to the Supported platforms and databases document (available on the Products download page of the Four Js Web site) or contact your support center.

**Genero Web Services (GWS)**

Genero Web Services client allows you to implement Web services. Web services are a standard way of communicating between applications over the internet or an intranet. A Web service can be a server that exposes services or a client that consumes a service.

**Any Web Service Client**

The Genero Application Server is able to serve Web Service or RESTful clients written in languages other than Genero.

**Databases**

Any database accessible from the DVM or from the ODI is supported.

---

**Genero compatibility for the GAS**

Determine the compatibility of different versions of the Genero product family and the Genero Application Server.

**GAS 3.10 and Genero compatibility**

Ensure your Genero installation is valid for Genero Application Server (GAS) 3.10.

The GAS and DVM should be in sync. Therefore, GAS 3.10 should use the Genero runtime system (DVM) 3.10.

In addition, the following Genero clients are compatible:

- GDC HTTP 3.10
- GBC 1.00
- GMA 1.30
- GMI 1.30

**Important:** Genero Web Client for JavaScript (GWC-JS) applies to the Web client 3.xx and lower. Starting with 3.10, GWC-JS was renamed as the Genero Browser Client (GBC).

---

**Install Genero Application Server on UNIX™ platforms**

Follow these steps to install the Genero Application Server on UNIX™ platforms.

The installation program provides options that allow you to specify configuration options from the command line. You can display the installation program options using the -h option:

```
./fjs-gas-version-build-osident.run -h
```

Example:

```
$ ./fjs-gas-3.10.04-build129065-164x125.run -h
```

The installation program identifies the operating system and checks that all the system requirements are met before starting to copy the product files to disk.
1. To perform the installation, run the auto-extractable shell script:

   ./fjs-gas-version-build-osident.run

   Example:

   $ ./fjs-gas-3.10.04-build129065-164x125.run

2. Once the files are copied to disk, follow the instructions displayed.

   **Note:** You can install the package as root using the -r or --root option.

**What to do next:**

When you have completed the installation of the GAS, see *FastCGI installation* in the *Genero Application Server User Guide* for details on the Web Server configuration. Afterwards, validate your installation as described in *GAS Configuration Check* in the *Genero Application Server User Guide*.

**Tip:** If you have configurations from a previous installation version, for example in your as.xcf file, avoid copying these files into your new installation. The preferred practice is to use the default from the new install package so that you benefit from any new or changed syntax it may contain and then reapply your custom changes.

**Related concepts**

- Installation troubleshooting tips on page 10

If you have an issue during installation, generating a log of the installation can provide valuable information for support.

---

**Install on Microsoft® Windows® platforms**

Install the Genero Application Server on Microsoft® Windows® platforms.

On Microsoft® Windows®, the GAS is provided as a standard Windows® setup program.

If you plan on installing the ISAPI connector for the integration of the GAS within IIS, you must install IIS first, prior to running the setup program. On IIS 7.x, ensure also that the **IIS Management Scripts and Tools** component under Management Tools (or Web Management Tools) is installed.

The installation program and the distribution files are provided in the same file:

   fjs-gas-version-build-osident.exe

To install execute the setup program:

   Example:

   fjs-gas-3.10.04-build129065-w32v100.exe

A wizard guides you through the installation process.

**What to do next:**

**Tip:** If you have configurations from a previous installation version, for example in your as.xcf file, avoid copying this in to your new installation. The preferred practice is to use the default configuration file from the new install package so that you benefit from any new or changed syntax it may contain and then reapply your custom changes.

When the installation completes, follow the instructions to install and configure the ISAPI dispatcher in the *Genero Application Server User Guide*.

**Related concepts**

- Install and uninstall in silent mode on Microsoft Windows platforms on page 25
- Install or uninstall the Genero Application Server in silent mode on Microsoft® Windows® platforms.
- Installation troubleshooting tips on page 10
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

**Install and uninstall in silent mode on Microsoft® Windows® platforms**

Install or uninstall the Genero Application Server in silent mode on Microsoft® Windows® platforms.

To install or uninstall the GAS in silent mode, you can use the `msiexec` command line utility. The `msiexec` utility provides the means to install, modify, and perform operations on Windows® Installer from the command line.

The `msiexec` utility expects a `.msi` file, which is embedded into the setup program. To extract it, execute the following command:

```
msiexec /x fjs-gas-version-build-osident.exe
```

Example:

```
fjs-gas-3.10.05-build129065-v32v100.exe /x
```

A `.msi` file will be created in the same directory and with the same name as the `.exe` file.

**Options**

The following options for `msiexec` are the most common relating to an install and uninstall. Enter `msiexec` from the command prompt to view the complete list of available options.

```shell
msiexec /qn - Quiet mode with no UI
/i fjs-gas-version-build-osident.msi - Install the specified msi package
/x fjs-gas-version-build-osident.msi - Uninstall the specified msi package
/log logfile - Log to the specified log file
```

**Arguments**

You can pass arguments to the `msiexec` installer on the command line.

**Table 6: Arguments for the misexec installer**

<table>
<thead>
<tr>
<th>Argument</th>
<th>IIS version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRODUCTDIR=your_fglasdir_path</td>
<td>All</td>
<td>Path where GAS will be installed. It is an alias of GASDIR.</td>
</tr>
<tr>
<td>GASDIR=your_fglasdir_path</td>
<td>All</td>
<td>Path where GAS will be installed. It is an alias of PRODUCTDIR.</td>
</tr>
<tr>
<td>FGLDIR=your_fgladir_path</td>
<td>All</td>
<td>Path where Genero BDL is installed. Used only when SETFGLDIR=1.</td>
</tr>
<tr>
<td>SETFGLDIR=1</td>
<td>All</td>
<td>Enable the FGLDIR variable. Default value is 0 (zero).</td>
</tr>
<tr>
<td>GREDIR=your_gredir_path</td>
<td>All</td>
<td>Path where GRE is installed. Used only when SETGREDIR=1.</td>
</tr>
<tr>
<td>SETGREDIR=1</td>
<td>All</td>
<td>Enable the GREDIR variable. Default value is 0 (zero).</td>
</tr>
<tr>
<td>ADDLOCAL=GAS</td>
<td>All</td>
<td>Install the GAS without ISAPI. Set the parameter to ALL to install the GAS with the ISAPI extension.</td>
</tr>
</tbody>
</table>
### Argument Description

<table>
<thead>
<tr>
<th>Argument</th>
<th>IIS version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISAPIDIR=your_isapi_path</td>
<td>All</td>
<td>Path where the ISAPI extension will be installed. If not specified, the default path is <code>&lt;PRODUCTDIR&gt;\isapi</code>.</td>
</tr>
<tr>
<td>STARTMENUFOLDER=your_startmenufolderPath</td>
<td>All</td>
<td>Customize the location for the shortcuts in the startmenu. For example: &quot;fjs\gas&quot;</td>
</tr>
<tr>
<td>WEBSITE=your_webSite</td>
<td>IIS 6, IIS7</td>
<td>Default value: &quot;Default Web Site&quot;</td>
</tr>
<tr>
<td>WEBAPPNAME=your_webAppName</td>
<td>All</td>
<td>Default value: &quot;gas&quot;</td>
</tr>
<tr>
<td>WEBAPPPoolNAME=your_webAppPoolName</td>
<td>IIS 6, IIS7</td>
<td>Default value: &quot;GASAppPool&quot;</td>
</tr>
<tr>
<td>APPPOOLUSERDOMAIN=your_AppPoolUserDomain</td>
<td>IIS 6, IIS7</td>
<td>Default value: &quot;&quot;</td>
</tr>
<tr>
<td>APPPOOLUSER=your_AppPoolUser</td>
<td>IIS 6, IIS7</td>
<td>Default value: &quot;NetworkService&quot;</td>
</tr>
<tr>
<td>FORCEREMOVEDPRODUCTDIR=YES</td>
<td>All</td>
<td>On uninstall, remove the PRODUCTDIR location even if it is not empty. Default value: &quot;&quot;</td>
</tr>
</tbody>
</table>

**Note:** Quotes are only required around the argument value when a space character is in the value string.

#### Silent install examples

**On IIS5:**

```
msiexec /qn /i fjs-gas-2.50.04-build129065-v32v100.msi /log gas2.20.log
PRODUCTDIR=c:\tmp\gas2 ADDLOCAL=ALL ISAPIDIR=c:\tmp\gas2\isapi WEBAPPNAME=gas-msi
```

**On IIS 6:**

```
msiexec /qn /i fjs-gas-2.50.04-build129065-v32v100.msi /log gas2.20.log
PRODUCTDIR=c:\tmp\gas2 ADDLOCAL=ALL ISAPIDIR=c:\tmp\gas2\isapi WEBAPPNAME=gas-msi
APPPOOLUSERDOMAIN=your_domain APPPOOLUSER=your_user WEBAPPPoolNAME=gas-pool-msi
```

**Silent uninstall example**

```
msiexec /qn /x fjs-gas-2.50.04-build129065-v32v100.msi /log as2_50_04.log
```

**Related concepts**

Installation troubleshooting tips on page 10
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

### Install GAS on macOS™

#### Before you begin

Review the GAS system requirements on page 22.

You need a macOS™ and an user account which has administrator access level.

Download the installation package for the macOS™.

You should have completed the installations for Genero BDL (mandatory) and Genero Report Engine (if necessary) before you start this task.

- The installation of Genero BDL is mandatory.
- The installation of Genero Report Engine is only necessary if you plan to use the Genero Report Writer through applications running on the GAS.

You will be asked to provide the directory paths for both BDL and GRE.

#### About this task

Follow these instructions to install the Genero Application Server on macOS.

1. Determine the directory where you will install the product.
   
   The wizard will eventually suggest /opt/fourjs/gas. If you plan to use this default, ensure you have write permission to this directory.

2. Log in as a user with permission to write to the directory in which you plan to install this product.

3. Copy the self-extractable file into a temporary directory.

4. From a command prompt, run the self-extractable shell script with the -i option:

   ```
   sh fjs-gas-3.xx.xx-buildxxxxxxxx-m64x1011.run -i
   ```

   **Note:** The "x" entries in the file name example above must use the actual numbers of the downloaded file!

5. Follow the instructions displayed.

   **Tip:** After you have read the licensing agreement, press "q" to return to the instructions and prompts.

#### What to do next

When installation is complete, see the Genero Application Server User Guide for configuration information and instructions.

#### Related concepts

- Installation troubleshooting tips on page 10

If you have an issue during installation, generating a log of the installation can provide valuable information for support.

### Install Genero Studio

These topics relate to the installation of the Genero Studio.

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

The Genero Studio software package includes Genero Studio, Genero Business Development Language, Genero Application Server, Genero Desktop Client, Genero Web Client, Genero Web Services, Genero Mobile and Genero
Report Writer. During the installation process, you can select which components to include or exclude. By default, the wizard installs all components.

Genero Studio can be used as a standalone application, or in a client/server mode. The packages for Windows® and GNU/Linux® install client and server programs.

Use a standalone scheme when you want to use local Genero and Genero Desktop Client installations and compile files locally.

If the Genero installation and your project files are on another machine, install Genero Studio on this machine and run the server program only. You will have to declare the Genero Studio Server in your local Genero Studio (client) configuration in order to use it.

**Note:** See the *Genero Studio User Guide* for additional installation and configuration information.

**Note:** See the *Genero Business Development Language User Guide* for details on configuring Genero Mobile for Android™ and iOS. Those configuration topics contain additional system requirements for each mobile platform.

If you do not have a valid maintenance key for Genero, you must **License Genero Report Engine (GRE)** on page 83.

- Genero Studio or Genero Suite Server?
- GST system requirements on page 28
- Install Genero Studio on Windows on page 29
- Install Genero Studio on UNIX platforms on page 33
- Install Genero Studio on macOS (GUI installer) on page 34
- Install Genero Studio on macOS (command line) on page 35

---

**GST system requirements**

Before installing Genero Studio, ensure that your system meets the minimum system requirements.

**Display**

Minimum video resolution is XGA (1024x768).

**Genero compatibility**

Genero Studio is compliant with Genero 1.3x and above.

**Operating systems**

Genero Studio is supported on a variety of operating systems.

For a detailed list of supported operating systems, refer to the *Supported platforms and databases* document (available on the Products download page of the *Four Js Web site*) or contact your support center. This document also informs you which operating systems will no longer be supported as of the next release.

**Disk space**

As the amount of disk space required may vary slightly, depending on the operating system, and the released version, you will need to estimate disk space. The disk space needed for installation may be calculated by multiplying the size of the download file by 5. Once the product is installed, the required disk space is approximately the size of the download file multiplied by 2.

**Java**

Genero Studio requires Java JRE for Java extensions in Genero BDL, Genero Report Engine (GRE), and Java JDK for Genero Mobile for Android™ (GMA).
The version of Java that is supported can vary based on the product or component. To ensure you are viewing the latest information about Java version support for a specific product or component, refer to the Supported platforms and databases document (available on the Products download page of the Four Js Web site) or contact your support center.

**Genero Mobile**

Requirements for Android™ emulator hardware acceleration:

- The Android™ emulator requires a processor with virtualization technology and a dedicated driver. Most recent Intel® processors support virtualization (VT-x, EM64T). See Speeding Up the Android® Emulator on Intel Architecture.

**Genero Components**

The Genero Studio installation can install the Genero Business Development Language (BDL), the Genero Application Server (GAS), the Genero Report Engine (GRE), the Genero Desktop Client (GDC), the Genero Mobile for Android™ (GMA), Genero Mobile for iOS (GMI) (when installing on macOS™), and the Genero Ghost Client (GGC). While you can select which components to include during the installation, ensure you meet the individual system requirements for the components you include:

- Genero BDL system requirements
- GDC system requirements
- GAS system requirements on page 22
- GRE system requirements
- GRD system requirements on page 45

**Install Genero Studio on Windows®**

Procedure to install Genero Studio on Windows®.

If you plan to install the Genero Application Server (GAS), you have a choice to make. For the development cycle, the stand-alone GAS provides a direct http connection to access applications without using a Web server. If you want to use a local Microsoft® Internet Information Services (IIS) as your Web server, you must install the ISAPI extension. You make this choice during the installation.

1. Execute the package name to start the Setup Wizard.
   
   fjs-gst-version-build-osident.exe

   Example:
   
   fjs-gst-3.10.03-build127192-w32v100.exe

2. When the Welcome page displays, click Next.

3. End-User License Agreement - read and accept the license agreement and click Next.

4. Third-Party License Agreement - read and accept the terms of the license agreement and click Next.

5. Setup Type - select your machine type and components.

   Workstation or Server - Full installs the entire product suite. Click Next.

6. Product Features - select all the features you want to install and click Next.

   By default, all components are selected for installation. The list box for each feature or component allows you to specify whether:

   - Feature/component will be Installed on the local hard drive
   - Entire feature will be installed on the local hard drive
   - Entire feature will be unavailable

   If you have chosen to install the ISAPI extension for the Genero Application Server, some additional pages will display later in the process related to the ISAPI extension.
7. **Destination Folder** - specify the destination folder for your Genero installation (or use the default) and click Next.

8. **Start Menu Folder** - choose the folder and click Next.

   The following pages are for the ISAPI installation only. See the *ISAPI Installation* page in the *Genero Application Server User Guide* for additional information.

   a) **ISAPI - Web Site**: Choose the web site where you want to add your applications.

   b) **ISAPI - Web Application Name**: Assign a name that will be included as the path to the GAS in the URL for your applications. Click Next.

   c) **ISAPI - Web Application Path**: Enter the physical path of your applications. Within this directory the isapidispatch.ini file will be created.

   d) **ISAPI - Application Pool name**: Give the name for your Application Pool that will run the worker process. This name must not already exist within your IIS installation.

   The general installation pages continue.

9. **Licensing** - Choose the method of licensing and indicate which products you are licensing.

10. **Java™ Virtual Machine** - Choose an installed JVM version displayed in the list, or click Install JVM to do a silent install of the specified version. Click Next.

11. **Ready to install** - click Install to begin the installation.

12. **Enter License Information** - If you choose to license Studio at this point, provide the license number, the license key, and the maintenance key (if available). Click Install. As an alternative, you can check the box to use the Four Js Activation Server.

13. Click Quit to leave the License Information dialog.

14. Click Finish.

   The installation completes and the install wizard closes.

When installation is complete, see the *Configuring Genero Studio* page in the *Genero Studio User Guide*.

**Related concepts**

*Installation troubleshooting tips* on page 10

If you have an issue during installation, generating a log of the installation can provide valuable information for support.

**Install Genero Studio on Windows® in silent mode**

Use the `msiexec` command line utility to install or uninstall Genero Studio in silent mode on Microsoft® Windows® platforms.

The `msiexec` utility provides the means to install, modify, and perform operations on Windows® Installer from the command line.

The `msiexec` utility expects a `.msi` file, which is embedded into the setup program. To extract it, execute the following command:

```
    fjs-gst-version-build-osident.exe /x
```

Example:

```
    fjs-gst-3.10.04-build123456-w64v120.exe /x
```

A `.msi` file will be created in the same directory and with the same name as the `.exe` file.

**Options**

The following options for `msiexec` are the most common relating to an install and uninstall. Enter `msiexec` from the command prompt to view the complete list of available options.

```
    msiexec /qn - Quiet mode with no UI
    /i fjs-gst-version-build-osident.msi - Install the specified .msi package
```
/x fjs-gst-version-build-osident.msi - Uninstall the specified msi package
/log logfile - Log to the specified log file

**Arguments**

You can pass arguments to the msiexec installer on the command line.

**Table 7: Arguments for the msiexec installer**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRODUCTDIR=your_fglasdir_path</td>
<td>Path where GST will be installed. It is an alias of GSTDIR.</td>
</tr>
<tr>
<td>GENEROSTUDIODIR=your_fglasdir_path</td>
<td>Path where GST will be installed. It is an alias of GSTDIR.</td>
</tr>
<tr>
<td>STARTMENUFOLDER=your_startmenufolder_path</td>
<td>Customize the location for the shortcuts in the startmenu. For example: &quot;fjs\gst&quot;</td>
</tr>
<tr>
<td>Argument</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ADDLOCAL=option</td>
<td>Use option to set the features to install.</td>
</tr>
</tbody>
</table>

Table 8: Option values for ADDLOCAL

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL</td>
<td>Install Genero Studio (GSTIDE), all Genero Studio file associations (GSTFILEASSOC), Genero Studio to the context menu (GSTIDECONTEXTMENU), Genero Desktop Client and its file associations (GDC + GDCFILEASSOCGDC), Genero Business Development Language (FGL), Genero Report Engine (GRE), and the Genero Application Server (GAS)</td>
</tr>
<tr>
<td>GSTIDE</td>
<td>Install Genero Studio (mandatory).</td>
</tr>
<tr>
<td>GSTFILEASSOC</td>
<td>Install all Genero Studio file associations.</td>
</tr>
<tr>
<td>GSTFILEASSOCSOURCEFILES</td>
<td>Install all Genero Studio source file associations.</td>
</tr>
<tr>
<td>GSTFILEASSOCBINARYFILES</td>
<td>Install all Genero Studio binary file associations.</td>
</tr>
<tr>
<td>GSTFILEASSOCWEBXMLFILES</td>
<td>Install all Genero Studio WebXML file associations.</td>
</tr>
<tr>
<td>GSTIDECONTEXTMENU</td>
<td>Install Genero Studio to the context menu.</td>
</tr>
<tr>
<td>GDC</td>
<td>Install the Genero Desktop Client (GDC).</td>
</tr>
<tr>
<td>GDCFILEASSOCGDC</td>
<td>Install the GDC file associations.</td>
</tr>
<tr>
<td>FGL</td>
<td>Install the Genero Business Development Language (BDL).</td>
</tr>
<tr>
<td>GRE</td>
<td>Install the Genero Report Engine (GRE).</td>
</tr>
<tr>
<td>GAS</td>
<td>Install the Genero Application Server (GAS).</td>
</tr>
</tbody>
</table>

Default value: GSTIDE, GSTFILEASSOCSOURCEFILES, GSTFILEASSOCBINARYFILES, GSTIDECONTEXTMENU, GDC, GDCFILEASSOCGDC, FGL, GRE, GAS.
Install Genero Studio on UNIX™ platforms

Follow these steps to install Genero Studio on Gnu/Linux® and UNIX™.

1. Type the following command to start the installation:

   ```bash
   $ sh fjs-gst-version-build-osident.run
   
   Example:
   $ sh fjs-gst-3.10.05-build156401-164x124.run
   ```

2. Follow the instructions provided on the screen.

When installation is complete, see the Configuring Genero Studio page in the Genero Studio User Guide.

Related concepts

Installation troubleshooting tips on page 10

If you have an issue during installation, generating a log of the installation can provide valuable information for support.

Install Genero Studio on UNIX™ platforms in silent mode

Follow these steps to install Genero Studio on Gnu/Linux® and UNIX™ in silent mode.

Before you begin: Be sure that your PATH environment variable contains the full path to the java binary that you want to use with Genero Studio tools.

Type the following command to start the installation:

```bash
./fjs-gst-version-build-osident.run -a -q --no-desktop -t $PWD/fjs-gst-version
```

Example:

```bash
./fjs-gst-3.10.05-build156401-164x1212.run -a -q --no-desktop -t $PWD/fjs-gst-3.10.05
```
Install Genero Studio on macOS™ (GUI installer)

Procedure to install Genero Studio on macOS™.

Before you begin

Review the GST system requirements on page 28.

You need a macOS™ and an user account which has administrator access level.

You need the GST .dmg package. For example: fjs-gst-3.xx.xx-buildxxxxxx-m64xxxx.dmg, where the "x" are placeholders for version and build numbers.

About this task

Follow these instructions to install Genero Studio.

1. Double-click on the dmg package in the finder.
   The dmg mounts. You have a new icon on your desktop with the same name as the package (fjs-gst-3.10.00-buildxxxxxx-m64x106, for example).

2. Double click on the new icon.
   It will display a new window containing fjs-gst-3.10.00-buildxxxxxx-m64x106.pkg.

3. Double click on the fjs-gst-3.10.00-buildxxxxxx-m64x106.pkg to launch the installation process.
   The GUI installer can be installed GST in /Applications or $HOME/Applications. You can have several GST installed in the same time.

4. Follow the installation instructions presented by the wizard.

What to do next

When installation is complete, see the Genero Studio User Guide for configuration information and instructions.

Debug the Genero Studio Install on macOS™ (GUI installer)

Procedure to debug the install Genero Studio on macOS™.

Follow these steps to debug a failed installation in GUI mode:

1. When the installation process begins, you will have a "Window" menu. Go to the Window menu and choose the Installer Log item.
   It launches a window where the installation logs are displayed.

2. To the left of the new window, you can choose Show all logs from a combobox.

3. When the installation process ends (with or without error), you can use the save button to create a file containing all log messages.
Install Genero Studio on macOS™ (command line)

Procedure to install Genero Studio on macOS™.

Before you begin

Review the GST system requirements on page 28.

You need a macOS™ and an user account which has administrator access level.

You need the GST .dmg package. For example: fjs-gst-3.xx.xx-buildxxxxxxx-m64xxxx.dmg, where the "x" are placeholders for version and build numbers.

1. Open a terminal.
2. Mount the dmg file using the hdiutil tool:
   
   hdiutil mount fjs-gst-2.50.00-buildxxxxx-m64x105.dmg

3. Launch the install process:
   
   sudo installer -pkg /Volumes/fjs-gst-2.50.00-buildxxxxx-m64x106/fjs-gst-2.50.00-buildxxxxx-m64x106.pkg/ -target "/Volumes/Macintosh HD"

4. Change the owner of $HOME/.Fourjs:
   
   sudo chown -R [My Account]:staff $HOME/.Fourjs

5. Umount the dmg:
   
   hdiutil unmount /Volumes/fjs-gst-2.50.00-buildxxxxx-m64x106

When installation is complete, see the Genero Studio User Guide for configuration information and instructions.

Debug the Genero Studio Install on macOS™ (command line)

Procedure to debug the install Genero Studio on macOS™.

To debug a failed installation, use the following command line:

   sudo installer -pkg /Volumes/fjs-gst-2.50.00-buildxxxxx-m64x106/fjs-gst-2.50.00-buildxxxxx-m64x106.pkg/ -target "/Volumes/Macintosh HD" -dumplog -verbose 2>&1 | tee fjs-gst-2.50.00-buildxxxxx-m64x106.log

Microsoft® Windows® Security Blocking

The Windows® firewall, enabled by default, detects and blocks the Genero Studio Server and the Genero Desktop Client.

From the network point of view, Genero Studio Server and the Genero Desktop Client (used by Genero Studio to display forms) are both considered servers. When you start Genero Desktop Client, or attempt to connect to Genero Studio Server, the firewall detects this and blocks the programs.

A dialog allows you to unblock the program. Follow the instructions provided by the dialog.

If you select Keep Blocking or Ask Me Later, the firewall continues to block the program(s).

If Keep Blocking has been pressed by mistake, you can change this parameter in the Windows® Firewall settings. Ensure you add Genero Studio, Genero Studio Server and Genero Desktop Client to the list of exceptions or allowed apps, and make sure that their listings have a check mark.
Install Genero Studio Server Suite

These topics relate to the installation of the Genero Studio Server Suite

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

The Genero Suite Server package is intended for production or for remote development (where you are developing on a server machine and the IDE is not available for the platform).

It only includes the server components.

The Genero Studio Server Suite software package includes Genero Studio Server, Genero Business Development Language, Genero Application Server, and Genero Report Engine. During the installation process, you can select which components to include or exclude. By default, the wizard installs all components.

It does not include the Genero Desktop Client (GDC). If you download this package, you must also download the GDC separately to handle any client needs.

**Note:** See the *Genero Studio User Guide* for additional installation and configuration information.

If you do not have a valid maintenance key for Genero, you must License Genero Report Engine (GRE) on page 83.

### Genero Studio Server Suite system requirements

Before installing the Genero Studio Server Suite, ensure that your system meets the minimum system requirements.

**Genero compatibility**

Genero Studio is compliant with Genero 1.3x and above.

**Operating systems**

Genero Studio is supported on a variety of operating systems.

For a detailed list of supported operating systems, refer to the *Supported platforms and databases* document (available on the Products download page of the Four Js Web site) or contact your support center. This document also informs you which operating systems will no longer be supported as of the next release.

**Disk space**

As the amount of disk space required may vary slightly, depending on the operating system, and the released version, you will need to estimate disk space. The disk space needed for installation may be calculated by multiplying the size of the download file by 5. Once the product is installed, the required disk space is approximately the size of the download file multiplied by 2.

**Java**

Genero Studio requires Java JRE for Java extensions in Genero BDL and Genero Report Engine (GRE).

The version of Java that is supported can vary based on the product or component. To ensure you are viewing the latest information about Java version support for a specific product or component, refer to the *Supported platforms and databases* document (available on the Products download page of the Four Js Web site) or contact your support center.
**Genero Components**

The Genero Studio Server Suite installation can install the Genero Business Development Language (BDL), the Genero Application Server (GAS), and the the Genero Report Engine (GRE). While you can select which components to include during the installation, ensure you meet the individual system requirements for the components you include:

- Genero BDL system requirements
- GAS system requirements on page 22
- GRE system requirements

**Install Genero Studio Server Suite on Windows®**

Procedure to install Genero Studio Server Suite on Windows®.

**Before you begin**

Review the GST system requirements on page 28.

You must have Java installed. You will be asked to provide the Java directory as part of the installation.

If you plan to license Genero BDL during the installation process, ensure you have the license number, license key, and maintenance number available.

You will also be asked to identify a default database driver. Be prepared to provide an answer to that question.

If you plan to install the Genero Application Server (GAS), you have a choice to make. For the development cycle, the stand-alone GAS provides a direct http connection to access applications without using a Web server. If you want to use a local Microsoft® Internet Information Services (IIS) as your Web server, you must install the ISAPI extension. You make this choice during the installation.

1. Execute the package name to start the Setup Wizard.
   
   \[ fjs-gst-version-build-osident.exe \]
   
   Example:
   
   \[ fjs-gst-3.10.03-build127192-w32v100.exe \]

2. When the Welcome page displays, click Next.

3. End-User License Agreement - read and accept the license agreement and click Next.

4. Third-Party License Agreement - read and accept the terms of the license agreement and click Next.

5. Product Features - select which components to install and click Next.
   
   By default, all components are selected for installation. The list box for each feature or component allows you to specify whether:
   
   - Feature/component will be Installed on the local hard drive
   - Entire feature will be installed on the local hard drive
   - Entire feature will be unavailable
   
   If you have chosen to install the ISAPI extension for the Genero Application Server, some additional pages will display later in the process related to the ISAPI extension.

6. Destination Folder - specify the destination folder for your Genero installation (or use the default) and click Next.

7. Start Menu Folder - choose the folder and click Next.
   
   The following pages are for the ISAPI installation only. See the ISAPI Installation page in the Genero Application Server User Guide for additional information.
   
   a) ISAPI - Web Site: Choose the web site where you want to add your applications.
   
   b) ISAPI - Web Application Name: Assign a name that will be included as the path to the GAS in the URL for your applications. Click Next.
c) **ISAPI - Web Application Path**: Enter the physical path of your applications. Within this directory the isapidispatch.ini file will be created.

d) **ISAPI - Application Pool name**: Give the name for your Application Pool that will run the worker process. This name must not already exist within your IIS installation.

The general installation pages continue.

8. **Licensing** - Choose the method of licensing and indicate which products you are licensing.

9. **Java™ Virtual Machine** - Choose an installed JVM version displayed in the list, or click **Install JVM** to do a silent install of the specified version. Click **Next**.

10. **Ready to install** - click Install to begin the installation.

11. **Enter License Information** - If you choose to license Studio at this point, provide the license number, the license key, and the maintenance key (if available). Click **Install**. As an alternative, you can check the box to use the Four Js Activation Server.

12. Click **Quit** to leave the License Information dialog.

13. Click **Finish**.

The installation completes and the install wizard closes.

**What to do next**

When installation is complete, see the *Genero Application Server User Guide* for configuration information and instructions.

**Related concepts**

- [Installation troubleshooting tips](#) on page 10

If you have an issue during installation, generating a log of the installation can provide valuable information for support.

---

### Install Genero Studio Server Suite on UNIX™ platforms

Follow these steps to install Genero Studio Server Suite on Gnu/Linux® and UNIX™.

**Before you begin**

Review the *GST system requirements* on page 28.

You must have Java installed. You will be asked to provide the Java directory as part of the installation.

If you plan to license Genero BDL during the installation process, ensure you have the license number, license key, and maintenance number available.

You will also be asked to identify a default database driver. Be prepared to provide an answer to that question.

1. Type the following command to start the installation:
   
   $ sh fjs-gstsrv-version-build-osident.run

   Example:
   
   $ sh fjs-gstsrv-3.10.05-build156401-164x124.run

2. Follow the instructions provided on the screen.

**What to do next**

When installation is complete, see the *Genero Application Server User Guide* for configuration information and instructions.

**Related concepts**

- [Installation troubleshooting tips](#) on page 10
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

**Install Genero Studio Server on macOS™**

**Before you begin**

Review the **GST system requirements** on page 28.

You need a macOS™ and an user account which has administrator access level.

Download the installation package for the macOS™.

You must have Java installed. You will be asked to provide the Java directory as part of the installation.

If you plan to license Genero BDL during the installation process, ensure you have the license number, license key, and maintenance number available.

You will also be asked to identify a default database driver. Be prepared to provide an answer to that question.

**About this task**

This installation package can install Genero Studio Server, Genero BDL, Genero Report Engine, and the Genero Application Server. You can follow the wizard suggestions and install all four at this time, or you can select and pick which components to install.

Follow these instructions to install the Genero Studio Server on macOS.

1. Determine the directory where you will install the product.
   - The wizard will eventually suggest /opt/fourjs/gstsrv. If you plan to use this default, ensure you have write permission to this directory.
2. Log in as a user with permission to write to the directory in which you plan to install this product.
3. Copy the self-extractable file into a temporary directory.
4. From a command prompt, run the self-extractable shell script with the -i option:
   ```bash
   sh fjs-gstsrv-3.xx.xx-buildxxxxxx-m64x1011.run -i
   ```
   **Note:** The "x" entries in the file name example above must use the actual numbers of the downloaded file!
5. Follow the instructions displayed.

   **Tip:** After you have read the licensing agreement, press "q" to return to the instructions and prompts.

   At some point in the instructions, if you elected to install Genero BDL, you will be asked whether you wish to provide the licensing details for the Genero Business Development Language. If you skip this step during the installation, you can always go back later to provide the licensing details.

   If asked about providing the licensing details for the Genero Report Engine, you can choose to not license the GRE. A GRE license is not necessary if you have a Genero BDL license with maintenance support.

**What to do next**

When installation is complete, see the **Genero Application Server User Guide** for configuration information and instructions.

**Related concepts**

- **Installation troubleshooting tips** on page 10
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

Install the Genero Mobile for Android front-end application

Install Genero Mobile for Android™ (GMA) with Genero Studio, or download the package and install from the command line.

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

Using Genero Studio

Genero Studio comes with everything you need to install the GMA front-end application onto your device. Follow the procedures in the Configure Genero Mobile for Android section of the Genero Studio User Guide for installation and configuration information.

From the command line

To install from the command line, you must:

• Install Genero Business Development Language
• Download the Genero Mobile for Android™ (GMA) package from the Four Js product download page (visit http://www.4js.com/download/products). This package contains the gmabuildtool tool and the APK ready to install.

Follow the instructions provided in Genero mobile development client for Android in the Genero Business Development Language User Guide for installation and configuration information.

Install the Genero Mobile for iOS front-end application

Install Genero Mobile for iOS with Genero Studio, download and install from the App Store, or download the package and install from the command line.

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

Using Genero Studio

Genero Studio comes with everything you need to install the GMI front-end application onto your device. Follow the procedures in the Configure Genero Mobile for iOS section of the Genero Studio User Guide for installation and configuration information.

From the App Store

The Genero Mobile app is available from the App Store.

1. Go to the App Store.
2. Search for "Genero Development Client".
3. Select and install the "Genero Development Client".

Refer to the Genero mobile development client for iOS from the Genero Business Development Language User Guide for additional configuration and usage information.
**Install Genero Report Engine**

These topics relate to the installation of the Genero Report Engine.

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

If you do not have a valid maintenance key for Genero, you must License Genero Report Engine (GRE) on page 83.

- GRE system requirements on page 41
- Install Genero Report Engine on UNIX platforms on page 42
- Install Genero Report Engine on Windows on page 42
- Install GRE on Windows platforms using the MSI installer on page 42

**GRE system requirements**

Before installing the Genero Report Engine, ensure that your system meets the minimum system requirements.

**Operating systems**

The Genero Report Engine (GRE) is supported on a variety of operating systems.

For a detailed list of supported operating systems, refer to the Supported platforms and databases document (available on the Products download page of the Four Js Web site) or contact your support center. This document also informs you which operating systems will no longer be supported as of the next release.

**Disk space**

As the amount of disk space required may vary slightly, depending on the operating system, and the released version, you will need to estimate disk space. The disk space needed for installation may be calculated by multiplying the size of the download file by 5. Once the product is installed, the required disk space is approximately the size of the download file multiplied by 2.

**Java**

Genero Report Engine (GRE) requires a Java Runtime Environment (JRE).

The version of Java that is supported can vary based on the product or component. To ensure you are viewing the latest information about Java version support for a specific product or component, refer to the Supported platforms and databases document (available on the Products download page of the Four Js Web site) or contact your support center.

**Genero Report Viewer for HTML5**

For a detailed list of supported browsers, refer to the Supported platforms and databases document (available on the Products download page of the Four Js Web site) or contact your support center.
Install Genero Report Engine on UNIX™ platforms

Follow these steps to install Genero Report Engine on Gnu/Linux® and UNIX™.

1. Type the following command to start the installation:
   
   \$ sh fjs-gre-version-build-osident.run

   Example:
   
   \$ sh fjs-gre-3.10.05-build127148-164x124.run

2. Follow the instructions provided on the screen.

   When installation is complete, see Report Writer in the Genero Studio User Guide for configuration information and instructions.

Related concepts

Installation troubleshooting tips on page 10

If you have an issue during installation, generating a log of the installation can provide valuable information for support.

Install Genero Report Engine on Windows®

Follow these steps to install the Genero Report Engine on Windows®.

1. Execute the installation package to start the Setup Wizard.

   fjs-gre-version-build-osident.exe

   Example:
   
   fjs-gre-3.10.03-build127148-w32v100.exe

2. Follow the instructions provided online.

   The installation completes and the install wizard closes.

   When installation is complete, see Report Writer in the Genero Studio User Guide for configuration information and instructions.

Related concepts

Installation troubleshooting tips on page 10

If you have an issue during installation, generating a log of the installation can provide valuable information for support.

Install GRE on Windows® platforms using the MSI installer

Install Genero Report Engine on Windows® platforms using the MSI installer.

MSI installer

The GRE installer uses MSI technology. To be compliant with Microsoft® User Access Control (UAC) requirements, the msi file is embedded inside an exe file. You can extract the msi file from the exe file using the /x option:

\c:\fjs-gre-version-build-osident.exe /x

Example:

c:\fjs-gre-3.10.05-build156498-w64v140.exe /x

This creates a msi file with the same name.
Install and uninstall in silent mode

To install and uninstall GRE in silent mode, you can use the msiexec command line utility. The msiexec utility provides the means to install, modify, and perform operations on Windows® Installer from the command line.

Before you install the GRE, you must install the Java Runtime Engine (JRE).

The following options for msiexec are the most common options regarding installation and uninstallation. Enter msiexec from the command prompt to view the complete list of available options.

msiexec /qn - Quiet mode with no UI
/i fjs-gre-version-build-osident.msi - Install the specified msi package
/x fjs-gre-version-build-osident.msi - Uninstall the specified msi package
/log logfile - Log to the specified log file
/l*vx logfile - Provide verbose (detailed) logs in the specified log file

Arguments

You can pass arguments to the msiexec installer on the command line.

Table 9: Arguments for the msiexec installer

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRODUCTDIR=your_gredir_path</td>
<td>The path where GRE will be installed. It is an alias of GDCDIR variable.</td>
</tr>
<tr>
<td>GREDIR=your_gredir_path</td>
<td>The path where GRE will be installed. It is an alias of the PRODUCTDIR variable.</td>
</tr>
<tr>
<td>STARTMENUFOLDER=your_startmenufolder_path</td>
<td>Customize the location for the shortcuts in the startmenu. For example, &quot;fjs\gre&quot;.</td>
</tr>
<tr>
<td>ADDLOCAL=[ALL</td>
<td>GRE</td>
</tr>
<tr>
<td>• ALL (default): Install GRE (mandatory) and .gre file association</td>
<td></td>
</tr>
<tr>
<td>• GRE: Install GRE only</td>
<td></td>
</tr>
<tr>
<td>• GRE, GDCFILEASSOCGDC: Same as ALL</td>
<td></td>
</tr>
<tr>
<td>FORCEREMOVEPRODUCTDIR=YES</td>
<td>On uninstall, remove the PRODUCTDIR location, even if it is not empty. Default value: &quot;&quot; (empty string)</td>
</tr>
<tr>
<td>• YES = Force removal of PRODUCTDIR</td>
<td></td>
</tr>
<tr>
<td>• Any other entry = Keep files in PRODUCTDIR</td>
<td></td>
</tr>
</tbody>
</table>

Note: Quotes are only required around the argument value when a space character is in the value string.

Example

The following commands install the JRE and the GRE silently:

msiexec /qn /i fjs-gst-3.10.05-build156498-alpha-w64v140.msi /l*vx gre.log
GREDIR=D:\gre3.10 STARTMENUFOLDER="Four Js Genero Report Engine 3.10.05 (64 bits)"

Install GRE on macOS™

Before you begin
Review the GRE system requirements on page 41.
You need a macOS™ and an user account which has administrator access level.
Download the installation package for the macOS™.
You must have Java installed. You will be asked to provide the Java directory as part of the installation.
If you plan to license the GRE during the installation process, ensure you have the license number, license key, and maintenance number available.

About this task

Follow these instructions to install the Genero Report Engine on macOS.

1. Determine the directory where you will install the product.
   The wizard will eventually suggest /opt/fourjs/gre. If you plan to use this default, ensure you have write permission to this directory.
2. Log in as a user with permission to write to the directory in which you plan to install this product.
3. Copy the self-extractable file into a temporary directory.
4. From a command prompt, run the self-extractable shell script with the -i option:
   
   ```sh
   sh fjs-gre-3.xx.xx-buildxxxxxx-m64x1011.run -i
   ```
   
   **Note:** The “x” entries in the file name example above must use the actual numbers of the downloaded file!
5. Follow the instructions displayed.
   **Tip:** After you have read the licensing agreement, press "q" to return to the instructions and prompts.
   At some point in the instructions, you will be asked whether you wish to provide the licensing details for the Genero Report Engine. If you skip this step during the installation, you can always go back later to provide the licensing details.

What to do next

When installation is complete, see the Genero Studio User Guide for configuration information and instructions.

Related concepts

Installation troubleshooting tips on page 10
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

Install Genero Report Designer

These topics relate to the installation of the Genero Report Designer.
Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.
These instructions are for the installation of the standalone Genero Report Designer.
Genero Report Designer is also included as part of Genero Studio. If you have installed Genero Studio, you do not need to install the standalone Genero Report Designer.

- GRD system requirements on page 45
- Install Genero Report Designer on Linux on page 45
- Install Genero Report Designer on Windows on page 45
GRD system requirements

Before installing Genero Report Designer, ensure that your system meets the minimum system requirements.

Operating systems

The Genero Report Designer is supported on Linux® and Microsoft® Windows®.

For a detailed list of supported operating systems, refer to the Supported platforms and databases document (available on the Products download page of the Four Js Web site) or contact your support center. This document also informs you which operating systems will no longer be supported as of the next release.

Disk space

As the amount of disk space required may vary slightly, depending on the operating system, and the released version, you will need to estimate disk space. The disk space needed for installation may be calculated by multiplying the size of the download file by 5. Once the product is installed, the required disk space is approximately the size of the download file multiplied by 2.

Install Genero Report Designer on Linux®

Follow these steps to install Genero Report Designer on Linux®.

1. Type the following command to start the installation:

   $ sh fjs-grd-version-build-osident.run

   Example:
   $ sh fjs-grd-3.00.22-build149130-164x1212.run

2. Follow the instructions provided on the screen.

When installation is complete, see the Genero Report Designer User Guide for configuration information and instructions.

Related concepts
Installation troubleshooting tips on page 10
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

Install Genero Report Designer on Windows®

Follow these steps to install Genero Report Designer on Windows®.

1. Execute the package name to start the Setup Wizard.

   fjs-grd-version-build-osident.exe

   Example:
   fjs-grd-3.00.22-build149130-w64v120.exe

2. Complete the instructions provided online.

   The installation completes and the install wizard closes.

When installation is complete, see the Genero Report Designer User Guide for configuration information and instructions.

Related concepts
Installation troubleshooting tips on page 10
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

Install Genero Browser Client

These topics relate to the installation of the Genero Browser Client (GBC).

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

The Genero Browser Client (GBC) is released on a different schedule than the other components of the Genero Enterprise suite. A runtime version is included with the Genero Business Development Language installation; however you will likely want to update the GBC to the latest version.

The GBC package does not install like other Genero products. You do not launch an installation script and click through a wizard to install the Genero Browser Client. Instead, you download the latest GBC runtime package and deploy it to a Genero Application Server.

For more information on the differences between the GBC Runtime package and GBC Project package, see the Genero Browser Client User Guide.

For more information on setting up and using the Deployment App or the gasadmin command to manage your GBC packages, see the Genero Application Server User Guide.

Genero Browser Client system requirements

Before installing the Genero Studio Server Suite, ensure that your system meets the minimum system requirements.

Genero compatibility

Genero Browser Client is compliant with Genero 3.10 and above.

Operating systems

Genero Browser Client is supported on a variety of browsers.

For a detailed list of supported browsers and their version numbers, refer to the Supported platforms and databases document (available on the Products download page of the Four Js Web site) or contact your support center.

Install Four Js License Manager

To centralize licensing, install the Four Js License Manager.

Installation can vary depending on the host operating system. Ensure you follow the installation instructions for your host operating system.

- FLM system requirements on page 47
- Installation on page 49
FLM system requirements

Before installing Four Js License Manager, ensure that your system meets the minimum system requirements.

Dynamic Virtual Machine (DVM) compatibility

Most Dynamic Virtual Machine (DVM) versions are fully compatible with the License Manager, but the older versions that need to be patched are discussed here.

Four Js License Manager is ported to all platforms supported by the DVM. The following DVM versions are fully compatible with the License Manager:

- BDS version 3.55 and higher
- Genero version 1.32 and higher

For information on checking your DVM version, see Identify DVM version on page 48.

Versions older than those specified above need to be patched (or entries in the fglprofile file need to be updated) to be compliant with the License Manager. See .

Recent versions of the DVM can show the minimum license version required. The License Controller or License Manager will return an appropriate message in case of incompatibility. The minimum license version required should be displayed too.

Operating systems

The Four Js License Manager is supported on the same operating systems as Genero Business Development Language (BDL).

For a detailed list of supported operating systems, refer to the Supported platforms and databases document (available on the Products download page of the Four Js Web site) or contact your support center. This document also informs you which operating systems will no longer be supported as of the next release.

Hardware

Four J's License Manager requires either a UNIX™, Windows®, or Mac® machine.

Aside from requiring a host machine, the Four J's License Manager does not require any specific hardware.

Disk space

Typically 1.2 Mb of disk space is required for installation. Once the License Manager is installed, the required disk space is approximately 900 Kb. The actual amount of disk space may vary slightly, depending on the operating system.

Software

The Four J's License Manager itself does not require any specific software. During the installation phase, however, the installer program calls some system commands (such as df, tar and gzip on UNIX™ systems). The installation program automatically checks for such prerequisites and raises an error message if a required system command is missing.

Internet access

In order to license a product online from the Four J's Web site (http://www.4js.com), you need an internet connection.

Upgrade the FLM without re-applying licenses

When you upgrade the Four Js license manager, you do not need to reinstall your existing licenses.

1. Make a backup copy of your FLM configuration file, FLMDIR/etc/lmprofile
2. Start the command line interface.
   a) Open a command prompt.
      • On Windows®, open the License Manager Workplace window from the Start menu.
      • On Linux®, open a command prompt. "sudo" may be required.
   b) Type `flmprg -s`
      The FLM service is stopped.
3. Install the new FLM package in the same directory as the existing installation.
   Take the option to overwrite the existing files.
4. Replace the configuration file at `FLMDIR/etc/lmprofile` with the backup copy created in Step 1.
   Overwrite the existing file.
5. Remove every file and directory in the `FLMDIR/lock/` path.
6. Start your new FLM
   
   `flmprg -r`

   It is also recommended to upgrade the license controllers for your Genero Business Development Language (fglWrt) or Genero Report Writer (greWrt) installations at this time. See Patching a license controller on page 48.

**Patching a license controller**

If you need to update the license controller in order to make an older version of Dynamic Virtual Machine (DVM) compliant with the License Manager, follow the procedure described.

To update the license controller to the latest version, you download the version for your product that is appropriate for your operating system from the Four Js web site.

**Table 10: Genero Products and License Controllers**

<table>
<thead>
<tr>
<th>Genero product</th>
<th>Licence controller</th>
</tr>
</thead>
<tbody>
<tr>
<td>Genero Enterprise</td>
<td>Four Js License Controller for BDL (fglwrt)</td>
</tr>
<tr>
<td>Genero Report Engine</td>
<td>Four Js License Controller for GRE (greWrt)</td>
</tr>
</tbody>
</table>

1. Open your browser and navigate to the Four Js web site http://www.4js.com.
2. Navigate to the Download > Products page.
3. Under the License manager packages heading, locate the version of the license controller that is appropriate for your operating system under the Platform heading, and click on the link under Version to start the download.
4. When the download completes, uncompress the archive in your FGL installation directory
   The license controller is now updated.
   
   If a license controller version is not available for your operating system and/or for assistance with a downloaded version, contact your Four Js support center for help.

**Identify DVM version**

If you need to check if your Dynamic Virtual Machine (DVM) versions is compatible with the Four J's License Manager, run one of the commands described here.

To display the version number of a DVM, execute one of the following commands:

- `fpi`
• For older DVM versions, execute the command:

```
fglrun -V
```

Or

```
fglnodb -V
```

### Installation

Four Js License Manager is a separate product, to be installed in a dedicated directory with its own configuration file.

- **Four Js License Manager packages** on page 49  
- **Launching the installation** on page 49  
- **Setting the environment** on page 51

### Four Js License Manager packages

The Four Js License Manager (FLM) software is a self-extractable installation program.

On UNIX™, the installation program is a shell script. On Windows®, the installation file is an executable (.exe) file.

A Four Js or Genero software package follows a specific naming convention:

```
fjs-product-version-build-osident.extension
```

where:

- **product** is the product identifier ("flm" for Four J's License Manager).
- **version** is the software release number.
- **build** is the software build number.
- **osident** is the operating system identifier.
- **extension** is the file extension: **sh** or **run** on UNIX™ platforms, **exe** on Windows® platforms, and **dmg** or **run** on macOS™ platforms.

### Launching the installation

**Warning**: Be sure you are installing the correct binary files for your operating system. To do so, examine the installation package name, which includes the operating system brand name. For more information on the installation package name, refer to Four J's License Manager packages.

- **Installing on UNIX platforms** on page 49  
- **Install on Windows platforms** on page 50  
- **Installing the service (Windows only)** on page 50  
- **Starting Four Js License Manager** on page 51  
- **Stopping license manager** on page 52

### Installing on UNIX™ platforms

To display the installation options, run the installation command with the help (-h) option:

```
sh fjs-flm-5.10.3a-build333-1nxlc23.run -h
```

1. Choose a directory where Four J's License Manager will be installed, such as /opt/fourjs/flm.  
2. Log in as a user with permission to write to the chosen directory.  
3. Copy the self-extractable file into a temporary directory.
4. Run the self-extractable shell script with the -i option:

```
sh fjs-flm-5.10.3a-build333-lnxlc23.run -i
```

5. Follow the instructions displayed on your screen.

When installation is complete, see License Manager configuration on page 106 for configuration information and instructions.

**Related concepts**

Installation troubleshooting tips on page 10
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

## Install on Windows® platforms

1. Choose a directory where Four J's License Manager will be installed, such as `c:\fjs\flm`.
2. Log in as a user with permission to write to the chosen directory.
3. Copy the self-extractable file into a temporary directory.
   
   ```
fjs-product-version-build-osident.exe
   ```

   Example:

   ```
fjs-flm-5.19.16-build201708251459-w64v140.exe
   ```

4. Double-click the file to launch it, or right-click on the file name and select **Run as administrator**.
5. Follow the instructions displayed by the installation wizard.
   
   As part of the wizard, you are asked whether to install as a service. If you elect to install as a service, it is installed and set to **Manual** start. To have the service restart automatically on reboot, you must edit the **Startup Type** and change to **Automatic** or **Automatic Delayed**.

When installation is complete, see License Manager configuration on page 106 for configuration information and instructions.

**Related concepts**

Installation troubleshooting tips on page 10
If you have an issue during installation, generating a log of the installation can provide valuable information for support.

## Installing the service (Windows® only)

The installation wizard gives you the option of installing the Four Js License Manager as a service.

If you elected NOT to install as a service during the initial installation, you can execute the following command (from the License Manager Workplace Window) to install it as a service:

```
flmprg --service-install
```

If you attempt to start the service from the command line and the service is not yet installed, it will first install the service, and then start the service.

```
flmprg --service-start
```

## Install FLM on macOS™

**Before you begin**

Review the FLM system requirements on page 47.

You need a macOS™ and an user account which has administrator access level.

Download the installation package for the macOS™.
About this task

Follow these instructions to install the Four Js License Manager (FLM) on macOS.

1. Determine the directory where you will install the product.
   - The wizard will eventually suggest `/opt/fourjs/flm`. If you plan to use this default, ensure you have write permission to this directory.

2. Log in as a user with permission to write to the directory in which you plan to install this product.

3. Copy the self-extractable file into a temporary directory.

4. From a command prompt, run the self-extractable shell script with the -i option:
   
   ```
   sh fjs-flm-5.20.xx-buildxxxxxx-m64x10xx.run -i
   ```

   **Note:** The "x" entries in the file name example above must use the actual numbers of the downloaded file!

5. Follow the instructions displayed.

**Tip:** After you have read the licensing agreement, press "q" to return to the instructions and prompts.

When installation is complete, see License Manager configuration on page 106 for configuration information and instructions.

**Related concepts**

Installation troubleshooting tips on page 10

If you have an issue during installation, generating a log of the installation can provide valuable information for support.

**Setting the environment**

Before starting the Four J's License Manager, the `FLMDIR` and `PATH` environment variables must be set.

A script for setting the environment is created during the installation phase. Located in the Four J's License Manager installation directory (`FLMDIR`), this file is named `envflm` on UNIX™ platforms and `envflm.bat` on Windows® platforms. By running this script file, the following actions are performed:

- **on UNIX™ (using sh as shell script):**
  
  ```
  FLMDIR=/opt/fourjs/flm
  export FLMDIR
  PATH=$PATH:$FLMDIR/bin
  export PATH
  ```

- **on Windows®:**
  
  ```
  set FLMDIR=c:\fjs\flm
  set PATH=%PATH%;%FLMDIR%\bin
  ```

**Starting Four Js License Manager**

To start the License Manager service, execute the following command:

```
flmprg -r
```

On Linux™/UNIX™, the License Manager runs as a daemon. On Windows®, it runs as a service.

You can also use the following command on Windows™:

```
flmprg --service-start
```

**Important:** You must run the command as administrator, it is not enough to simply have administrator permissions.
Important: For security reasons, it is strongly recommended that the daemon be run as a non-privileged user (not root) on Linux®/UNIX™ systems. Also to avoid running into issues with directory permissions, it is recommended that the non-privileged user should also add the licenses.

Stopping license manager

To stop the License Manager service, execute the following command:

```bash
flmprg -s
```

Alternatively, on Windows®, you can also issue the following command:

```bash
flmprg --service-stop
```

Important: You must run the command as administrator, it is not enough to simply have administrator permissions.

License Genero Business Development Language

These topics give you the information you need to install and manage the license of your Genero Business Development Language product.

- Steps to BDL license installation on page 52
- Manage Genero BDL local license on page 59
- Register license on Four Js website on page 72
- Get maintenance key from Four Js website on page 75
- Steps to finalize temporary BDL license on page 75
- Steps to apply maintenance or subscription key (BDL) on page 80
- License using Four Js License Manager on page 83

Steps to BDL license installation

Preparing to license involves evaluating your options based on what licensing tool (GUI or command line) is available to you, and whether you can validate the installed license with Four Js over the internet. Choose the option that is right for you and match it with the procedure to follow.

Before you begin Genero product licensing:

1. Locate your email message that contains the following:
   - product license key
   - product license number
   - product maintenance key
   - your customer code

   If you do not have this email, contact your local Four Js sales office.

2. Decide which tool (GUI or command line) you are using to install the license:
   - Genero BDL Licenser (GUI application)
   - fglWrt (command line tool).

3. Determine if you have internet access from the machine you are licensing the product.

4. Use Table 11: Options for licensing on page 53 to choose your licensing option, and select the procedure to follow.
### Table 11: Options for licensing

<table>
<thead>
<tr>
<th>You are using ...</th>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Genero BDL Licenser</strong> with internet</td>
<td>See Install BDL license with user interface (internet) on page 53.</td>
</tr>
<tr>
<td><strong>Genero BDL Licenser</strong> without internet.</td>
<td>See Install BDL license with user interface (no internet) on page 55.</td>
</tr>
<tr>
<td><code>fglWrt</code> command line tool with internet.</td>
<td>See Install BDL license from the command line (via internet) on page 57.</td>
</tr>
<tr>
<td><code>fglWrt</code> command line tool without internet.</td>
<td>See Install BDL license from the command line (no internet) on page 58.</td>
</tr>
</tbody>
</table>

### Install BDL license with user interface (internet)

You can license a Genero Business Development Language (BDL) product using the Genero licensing user interface.

**Before you begin:** You must have internet access from the machine you are licensing the product to validate the license.

1. Launch the Genero licensing user interface.
   - From within the Genero Studio product interface, launch it from the **Tools > Genero Tools** menu
   - From the desktop select the **Genero BDL Licenser** tool from your Four Js program list

The licensing page opens in your Web browser.
Figure 1: Genero BDL Licensing Page

2. Enter your license number and license key, and click INSTALL.

Register the license
3. Select the REGISTER LICENSE USING FOUR JS ACTIVATION SERVER option.
Figure 2: Example registering the license

4. In the CUSTOMER CODE field, enter your customer code.

5. If your access to the internet is through a proxy, select the USE PROXY option, and perform the following steps:
   a) Provide the required information for HTTP PROXY and PORT options.
   b) If the proxy requires authentication, select the USE AUTHENTICATION option and provide the required information for LOGIN and PASSWORD.

6. Click INSTALL KEYS

   Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.

7. When finished, click QUIT to log out and close the licensing application.

Install BDL license with user interface (no internet)

Without internet access, you register the license with Four Js from another machine via the internet, or by phone. Then use the user interface to license your Genero Business Development Language (BDL) product.

1. Launch the Genero licensing user interface.
• From within the Genero Studio product interface, launch it from the Tools > Genero Tools menu
• From the desktop select the Genero BDL Licenser tool from your Four Js program list

The licensing page opens in your Web browser.

Figure 3: Genero BDL Licensing Page

2. Enter your license number and license key, and click INSTALL.

An installation number is generated.

Register the license
3. To register the license go to the License your products page on the Four Js web site. See the procedure described in Register license on Four Js website on page 72

Having registered your license, you have the installation key.

4. Enter your installation key, and click INSTALL KEY.
5. Enter your maintenance key, and click UPDATE KEY.

Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.

6. When finished, click QUIT to close the licensing application.

**Install BDL license from the command line (via internet)**

You can license a Genero Business Development Language (BDL) product using the command line tool, fglWrt.

**Before you begin:** You must have internet access from the machine you are licensing the product to validate the license.

1. At the command line enter the command:

   ```
   fglWrt -l
   ```

2. When prompted, enter the license number.
3. When prompted, enter the license key.

4. At the prompt:

   ![Image](image)

   Do you want to continue using HTTP ? (y/n)

   Enter: y

5. When prompted, enter your customer code:

   ![Image](image)

6. At the following prompt:

   ![Image](image)

   Do you need to configure an HTTP proxy ? (y/n)

   Enter y if your access to the internet is through a proxy. Provide the required information for HTTP proxy, Port, and authentication when prompted. Otherwise, enter n.

---

**Figure 5: Installing and registering a license via HTTP with fglWrt**

License installation is now completed.

**Install BDL license from the command line (no internet)**

Without internet access, you can register the license with Four Js from another machine via the internet, or by phone. Then license your Genero Business Development Language (BDL) product using the command line tool, fglWrt.

1. At the command line enter the command:

   ![Image](image)

2. When prompted, enter the license number.

3. When prompted, enter the license key.

   An **installation number** is generated and is displayed in the output.

4. At the prompt:

   ![Image](image)

   Do you want to continue using HTTP ? (y/n)

   Enter: n

5. At the prompt:

   ![Image](image)

   Enter your maintenance KEY (Empty to continue) >
Enter the maintenance key.

**Register the license**

6. To register the license go to the License your products page on the Four Js web site. See the procedure described in Register license on Four Js website on page 72

Having registered your license, you have the installation key.

7. At the prompt:

```
Enter the installation KEY (call your vendor to obtain it) >
```

Enter: *installation_key*

![Image of the command prompt output](figure6.png)

**Figure 6: Installing license with fglWrt**

License installation is now completed.

---

**Manage Genero BDL local license**

Refer to the topics in this section to quickly become familiar with how to perform license management tasks.

You can install and manage licenses locally using the license controller (*fglWrt*) installed with the product. Alternatively, you can use the License Manager, see the topic Using a license manager.

**Notes About Upgrading**

When upgrading a Genero product, the product is installed over the existing directory having a valid license. You do not have to re-enter the license keys.

When you purchase a new maintenance contract, the new maintenance key must be installed. To install your new maintenance key, you do not need to reinstall your license. Updating the maintenance key is handled separately. There is also no need to uninstall the old maintenance key. See Steps to apply maintenance or subscription key (BDL) on page 80.

- License Controller (*fglWrt*) on page 60
- Displaying environment and statistics on page 61
- Genero Browser Client (GBC) on page 64
- Get license information on page 64
- Uninstall license on page 67
- The FGLDIR/lock directory on page 69
• License an upgraded installation on page 69
• Managing the active users on page 70

License Controller (fglWrt)

The fglWrt command line tool is used to install, upgrade, or delete Genero BDL licenses. There are also options to provide various types of license information and statistics.

Syntax

```
fglWrt [options]
```

1. options are described in Table 12: fglWrt options on page 60.

fglWrt Options

Table 12: fglWrt options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-v or -V</td>
<td>Displays version information for the tool.</td>
</tr>
<tr>
<td>-h</td>
<td>Displays options for the tool. Short help.</td>
</tr>
<tr>
<td>-l license</td>
<td>Installs a license.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To escape when prompted to enter a license number and license key, type &quot;stop&quot; at the prompt.</td>
</tr>
<tr>
<td>-m option</td>
<td>Maintenance key installation, possible options are:</td>
</tr>
<tr>
<td></td>
<td>• key: Install a key directly.</td>
</tr>
<tr>
<td></td>
<td>• auto: The key is automatically installed (Internet connection is required).</td>
</tr>
<tr>
<td>-u</td>
<td>Check for active users.</td>
</tr>
<tr>
<td>-k option</td>
<td>Installation key for license validation, possible options are:</td>
</tr>
<tr>
<td></td>
<td>• key: Install a key directly.</td>
</tr>
<tr>
<td></td>
<td>• auto: The key is automatically installed (Internet connection is required).</td>
</tr>
<tr>
<td>-d</td>
<td>Remove current installed license.</td>
</tr>
<tr>
<td>-i</td>
<td>Clears the list of registered user sessions.</td>
</tr>
<tr>
<td>-a option</td>
<td>Check or view options, possible options are:</td>
</tr>
<tr>
<td></td>
<td>• ps: Shows processes on this machine.</td>
</tr>
<tr>
<td></td>
<td>• env: Shows current environment</td>
</tr>
<tr>
<td></td>
<td>• cpu: Shows number of CPU in the computer.</td>
</tr>
<tr>
<td></td>
<td>• hostname: Shows name of this machine.</td>
</tr>
<tr>
<td></td>
<td>• info license: Shows license information.</td>
</tr>
<tr>
<td></td>
<td>• info stat: Shows statistics of license server.</td>
</tr>
<tr>
<td></td>
<td>• info users: Shows all registered active users.</td>
</tr>
<tr>
<td></td>
<td>• info up: Shows if license server is up.</td>
</tr>
<tr>
<td>-x or -kill-session pid</td>
<td>Clears the session referenced by the specified pid.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>docker-assign</td>
<td>Assigns the license to a running docker instance.</td>
</tr>
<tr>
<td>docker-instance-name</td>
<td></td>
</tr>
<tr>
<td>docker-instance-id</td>
<td></td>
</tr>
<tr>
<td>docker-release</td>
<td>Release a docker-assigned license.</td>
</tr>
</tbody>
</table>

**Displaying environment and statistics**

When the Four Js License Manager is used for licensing, it works with the license controller locally to access information. The topics in this section describe license controller options that apply to the use of the FLM.

**Topics**

- Display environment information on page 61
- Display Statistics on page 62
- Display CPUs (cores) information on page 62
- Check Four Js License Manager (FLM) is started on page 61

**Display environment information**

Use this procedure to display information about the environment of your machine where the license is installed.

Settings are extracted from the FGL configuration file (for example, $FGLDIR/etc/fglprofile) and some from system environment settings.

To display information about the environment, execute the command:

```
fglWrt -a env
```

The output shows details under the Resource, Environment, and System headings.

**Note:**

- If you have a local license installed and therefore **not** using a Four Js License Manager (FLM) server, the server field will be displayed as (undefined).
- If you have a local license installed, your license number and key will not be displayed. License numbers that may be displayed are from the fglprofile, if any had been filled in there.

![Administration Command Prompt](image)

**Figure 7: Display the environment settings where license is installed.**

**Check Four Js License Manager (FLM) is started**

Follow this procedure to check if the FLM is started.

To check if the FLM is started, execute the command:

```
fglWrt -a info up
```
This example shows the display when the license manager is currently not running because configuration details are missing in `fglprofile`.

![Command Prompt](image)

**Figure 8: Check License Manager is Started**

**Related concepts**
- Install Four Js License Manager on page 46
  To centralize licensing, install the Four Js License Manager.

**Display Statistics**
Use this procedure to display statistical information on the use of a specific license on a machine when a License Manager is used for license control.

If you need detailed information about how licenses are used, or you need to troubleshoot your FLM, viewing information about a license in terms of the number of runtime, compilation, end-runtime, and process Id requests rejected or accepted can prove useful.

To display statistical information, execute the command

```
fglWrt -a info stat
```

**Related tasks**
- Display statistical information on page 114
  You can display statistics about license usage as shown in this procedure.

**Display CPUs (cores) information**
Use this procedure on the application server where the Genero runtime is installed, to determine the exact number of CPUs (cores/threads) for CPU licensing.

To display the number of logical CPUs in your machine type the command:

```
fglWrt -a cpu
```

The number of CPUs (cores/threads) you have are displayed. An example of a machine which has one physical CPU with four cores is shown.
Figure 9: Display the Number of CPUs using License Controller (fglWrt)

**GDC/GDCAX/GJC**

**Note:** Genero Desktop Client ActiveX (GDCAX) and Genero Java Client (GJC) are desupported.

The following Client Information (clientInfo) is sent:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cx-mode</td>
<td>Is the connection type. The value can be &quot;gas&quot; or &quot;direct&quot;</td>
</tr>
<tr>
<td>user-name</td>
<td>Is the local user name. The user that runs the Front End.</td>
</tr>
<tr>
<td>host-addr</td>
<td>Is the user computer IP address; this is the local IP address even if the connection goes through a router or a proxy.</td>
</tr>
<tr>
<td>hw-addr</td>
<td>Is the user computer mac address</td>
</tr>
<tr>
<td>host-name</td>
<td>Is the user computer name</td>
</tr>
</tbody>
</table>

Examples:

- **With direct connection to the DVM**
  
  ```
  cx-mode : direct
  user-name : Administrator
  host-addr : 10.0.0.65
  hw-addr : 00-0C-29-8D-EE-F0
  host-name : server-2
  ```

- **With connection to GAS or through a web server**
  
  ```
  cx-mode : gas
  user-name : Administrator
  host-addr : 10.0.0.65
  hw-addr : 00-0C-29-8D-EE-F0
  host-name : server-2
  ```
**Genero Browser Client (GBC)**

**Note:** Genero Web Client (GWC) applies to the Genero web client prior to version 3.00. From version 3.10, the GWC is discontinued and replaced by Genero Browser Client (GBC).

The following information (clientInfo) is sent by a Genero web client:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>app-name</td>
<td>appName</td>
</tr>
<tr>
<td>app-id</td>
<td>appId</td>
</tr>
<tr>
<td>user-agent</td>
<td>ua</td>
</tr>
<tr>
<td>host-addr</td>
<td>ip</td>
</tr>
<tr>
<td>host-name</td>
<td>hname</td>
</tr>
</tbody>
</table>

where:

- **appName** Is the application identifier that is in the URL `/wa/r/appName`.
- **appId** Is the application session number that is in the URL `/sua/appId/`.
- **ua** is the user agent name.
- **ip** Is the user computer IP address.
- **hname** Is the user computer name.

**Note:** Depending on the proxy configuration or the web server configuration, **host-name** and **host-addr** can be the proxy or the web server information instead of the user information.

Example:

```
host-addr   : 10.0.0.65
host-name   : 10.0.0.65
user-agent  : Mozilla/5.0 (Windows; U; Windows NT 5.1; en-US; rv:1.8.1.2)
             Gecko/20070219 Firefox/2.0.0.2
app-name    : gwc-demo
app-id      : 131551616
```

See [Display registered active users information](#) on page 70 for more information.

**Get license information**

Get details of the status of the license of your Genero product, for example, the maintenance contract expiry date, or the installation number for license registration.

- [Get license information](#) on page 65
- [Get license information using BDL licenser](#) on page 66

**License details reference**

A reference to license details.

The output from the license controller command, for example, `fglWrt -a info license`) and/or the Genero Licenser application screen displays details about the installed license. Use [Table 13: License details](#) on page 65 as a reference to look up details of your license.

**Note:** For specific license details, see your license agreement, or contact your nearest Four Js sales office.
**Table 13: License details**

<table>
<thead>
<tr>
<th>Details displayed</th>
<th>Description</th>
</tr>
</thead>
</table>
| Server name      | This is the name of the license manager server.  
  **Note:** Indicates that licensing is managed by a License Manager. |
| TCP Port         | This is the port the license manager is listening.  
  **Note:** Indicates that licensing is managed by a License Manager. |
| License          | This is the value of the license number. |
| License Key      | This is the value of the license key. |
| Product          | This refers to the name of the product under license, for example:  
  - Four J's Universal Compiler (for Genero Enterprise and Genero Mobile products)  
  - Four Js Genero Report Writer (for Genero Report Engine) |
| Type             | This refers to the type of license. This can be:  
  - runtime  
  - development |
| Users            | This number indicates the maximum number of users allowed to use the license. |
| Extension(s)     | This entry provides information on some specific conditions of the license. For example, ",- Open Database Interface" means that your license allows you to use any database.  
  The **installation number** is displayed if the license is a temporary license and the installation has not been finalized.  
  If the license is **date-limited**, then the date when the license expires is shown. |
| End of maintenance date | This entry indicates the date your maintenance contract expires. |

**Related tasks**

Get license information on page 65  
Get details of the status of the license of your Genero product.

**Get license information**

Get details of the status of the license of your Genero product.

**About this task:**

Use this procedure, for example, to find out the date the maintenance contract expires.

**Tip:** You can also use the procedure described in this topic to retrieve the **installation number** when you need to register the license and finalize the installation.
From a command prompt, enter the command:

```bash
fglWrt -a info license
```

**Example of Genero BDL license information:**

<table>
<thead>
<tr>
<th>License</th>
<th>TAB#XXXXXXXX</th>
</tr>
</thead>
<tbody>
<tr>
<td>License key</td>
<td>KKKKKKKKKKK</td>
</tr>
<tr>
<td>Product</td>
<td>Four Js Universal Compiler</td>
</tr>
<tr>
<td>Type</td>
<td>Development version</td>
</tr>
<tr>
<td>Users</td>
<td>5</td>
</tr>
<tr>
<td>Extension(s)</td>
<td></td>
</tr>
<tr>
<td>- Open Database Interface</td>
<td></td>
</tr>
<tr>
<td>- Enhanced license key format</td>
<td></td>
</tr>
</tbody>
</table>

This license is date limited and expires the 2016/03/31 (Year/Month/Day).

Warning! This is a temporary license, installation number is 'NNNNNNNNNNNN'.
This temporary installation will expire in 29 day(s).

WARNING! Your maintenance key has expired. Please contact your vendor.
End of maintenance date: 2016/03/03 (Year/Month/Day).

The output from the license controller command displays details about the installed license.

**Related concepts**

[License details reference](#) on page 64
A reference to license details.

**Get license information using BDL licenser**

Get details of the status of the license of your Genero product.

1. Launch the Genero Licenser application.
   - From within the Genero Studio product interface, launch it from the **Tools > Genero Tools** menu.
   - From the desktop select the **Genero BDL Licenser** application tool from your Four Js program list:

   The **Four Js Licensing Application** opens.
License information is displayed in the Licensing status field. In the field under Licensing status you see your maintenance key is valid until the date displayed after End of maintenance date.

2. When finished, select Quit to exit the application.

Related concepts
License details reference on page 64
A reference to license details.

Uninstall license
You may need to uninstall a license if you are making some hardware or software changes.

- Uninstall license with BDL Licenser on page 67
- Uninstall license from command line on page 69

Uninstall license with BDL Licenser
Use this procedure to uninstall the license of your Genero BDL product.

About this task:
Note: This procedure is valid for a local license only. If you are using the Four Js License Manager, see Manage licenses with FLM (flmprg) on page 111.

1. Launch the Genero licensing user interface.

   - From within the Genero Studio product interface, launch it from the Tools > Genero Tools menu
   - From the desktop select the Genero BDL Licenser tool from your Four Js program list

   The licensing page opens in your Web browser.

   ![Genero Business Development Language - Licensing version: 5.20.04-201809271621 (w64w140)](image)

   **Figure 11: Genero BDL Licenser**

2. Click Uninstall to uninstall the license.
   
   The DESCRIPTION field is updated to show a license is not installed.

3. When finished, click QUIT to close the licensing application.
**Uninstall license from command line**
Use this procedure to uninstall a license for your Genero BDL product.

1. At the command line enter the command:
   
   ```
   fglWrt -d
   ```

2. Enter “y” when prompted if you really want to uninstall the license.
   The license is uninstalled. A message confirms the license is uninstalled.

![Image of command line output]

**Figure 12: Uninstalling a License with the License Controller (fglWrt)**

**The FGLDIR/lock directory**
When using a local license, the license controller uses the FGLDIR/lock directory to store information (number of active users). A user running a BDL program must have access rights to this directory. Permissions can be restricted to specific users with FGLWRTUMASK.

This FGLDIR/lock directory must have access rights for any user running a BDL program. If it does not exist, it is automatically created.

**Note:** The FGLDIR/lock directory is **not** used when Genero is configured to use a license manager.

By default, the FGLDIR/lock directory is created with rwxrwxrwx rights, to let any user access the directory and create files. To restrict the access to a specific group or user, use the FGLWRTUMASK environment variable to force fglWrt to use a specific mask when creating the lock directory:

```$ FGLWRTUMASK="022"; export FGLWRTUMASK```

**Important:** The FGLWRTUMASK environment variable must be set for all users executing BDL programs, because the FGLDIR/lock directory can be re-created by any user at first BDL program execution.

**License an upgraded installation**
There are some considerations for licensing when upgrading an existing Genero installation to a newer version.

**Notes about Upgrading**
It is not necessary to re-enter the license of the product if the new version:

- Is installed into an existing installation directory
- Is not a major version number change

When you have purchased a new maintenance contract, the new maintenance key must be installed. To install your new maintenance key, you do not need to reinstall your license. Updating the maintenance key is handled separately. There is also no need to uninstall the old maintenance key.
Managing the active users

The license controller maintains a register of active users of licenses. The topics in this section describe ways you can manage license users.

Topics

- Display registered active users information on page 70
- Force a check of registered users list on page 71
- Clean registered users list on page 71
- Drop session on page 72

Display registered active users information

Use this procedure to display the registered active user list of the current license.

To display the registered active user list, execute the command:

```
fglWrt -a info users
```

The information displayed differs depending on the network architecture and the front-end client.

This example displays output when the connection is direct to the DVM via the Genero Desktop Client (GDC):

```
C:\Program Files\FourJs\Genero_Studio_3_00_22\fgl\bin>fglWrt.exe -a info users
License : THM#XXXXXXXX
License key : KKKKKKKKKKK
Product : Four Js Universal Compiler
Type : Development version
Users : 1/5
FrontEndId2: {f3619311-3f9b-4a93-bba5-5d9b4ec6d84b}
GUI Server 127.0.0.1:0 - Process Id 5144
    host-name: 4js1
    host-addr: ::ffff:127.0.0.1
    user-name: user1
    app-id: {f4afc501-f7c9-c9c6-e16f-2b881a8bf3f0}
    cx-mode: direct
```

This example displays output when the connection is through a Web server to the DVM:

```
C:\Program Files\FourJs\Genero_Studio_3_00_22\fgl\bin>fglWrt.exe -a info users
License : THM#XXXXXXXX
License key : KKKKKKKKKKK
Product : Four Js Universal Compiler
Type : Development version
Users : 1/5
    GUI Server 127.0.0.1:47274 - Process Id 5596
```

where:

- **License**
  - This is the value of the license number.

- **License Key**
  - This is the value of the license key.

- **Product**
  - The name of the product being licensed is displayed. In relation to Genero product, this can be, for example:
    - Four Js Universal Compiler (for Genero Enterprise and Genero Mobile products)
• Four Js Genero Report Writer (for Genero Report Engine)
• Genero Report Writer for Java C# PHP (for Genero Report Writer products)

**Type**
This is the type of license. This can be runtime version or development version.

**Users**
This is the number of active users over the maximum number of users allowed.

**FrontEndId2**
For desktop clients, the Global Unique Identifier (GUID) of the front-end client is displayed. For the web and desktop clients, the GUI server’s IP address and port, and the process identifier is displayed.

**host-name**
This is the name of the computer that runs the DVM.

**host-addr**
This is the server’s IP address and port it is listening on.

**user-name**
This is the user name.

**app-id**
For desktop clients, the Global Unique Identifier (GUID) of the application is displayed.

**Force a check of registered users list**
After a system crash or an abnormal termination of an application, use this procedure to force a check of the registered users list on the current machine.

This license controller feature forces the synchronization of the real users list and the registered users list for the current machine.

To check the registered users list, execute the command:

```bash
fglWrt -u
```

**Related tasks**

**Clean registered users list** on page 71
Generally, you never need to clean the registered users list on a host, but if, for example, a DVM crashes and the associated unreleased licenses would not be recovered otherwise, use this procedure to clear the list.

**Clean registered users list**
Generally, you never need to clean the registered users list on a host, but if, for example, a DVM crashes and the associated unreleased licenses would not be recovered otherwise, use this procedure to clear the list.

**Important:** The `fglWrt -i` should be used with caution because it invalidates implicitly all existing sessions and eventually all running applications will stop with a license error. In other cases, the `-u` option to force a check of the registered users should be preferred to the `-i` option.

To clean the registered users list, execute the license controller command:

```bash
fglWrt -i
```

All users registered are disconnected when you use this option.

---

**Figure 13: Clean the Registered Users with fglWrt -i**
Related tasks

Force a check of registered users list on page 71
After a system crash or an abnormal termination of an application, use this procedure to force a check of the registered users list on the current machine.

Display the process Id List
Use this procedure to display the current list of processes on your machine.

To display processes, execute the command:

```
fglWrt -a ps
```

A list of process Ids are displayed as shown.

```
Figure 14: Display the ids of Processes Currently Running
```

Related tasks

Drop session on page 72
Use this procedure to drop a session referenced by a specified process id on a host.

Drop session
Use this procedure to drop a session referenced by a specified process id on a host.

This feature is available starting from version 5.19.01.

Important: This feature only applies to User- type licenses, not to CPU licenses.

To drop a session, execute the command:

```
fglwrt -x <pid>
```

Where `<pid>` is the process id.

Related tasks

Display the process Id List on page 72
Use this procedure to display the current list of processes on your machine.

Register license on Four Js website

Register your license with Four Js in order to validate it.

About this task:

Important:

If you can use the license controller `-m auto` option to install the license via the internet, (for example `fglWrt -m auto`), then you do not need to perform this task.

Before you begin:
• Get your **installation number** from the output of the following command:

```
<license_controller> -a info license
```

Where `<license_controller>` is `fglWrt` (for Genero Enterprise), or `greWrt` (for Genero Report Engine), depending on which product you are licensing.

Or if you are using Four Js License Manager, use the following command:

```
flmprg -a info license <license_number>
```

• You must also have the following:
  - Customer code
  - License number
  - License key

Typically, these are delivered by email with your product. If you do not have them, contact your local sales office.

1. Open your browser and navigate to the Four Js web site:

2. Navigate to the Support > License your products page.
   The Online registration form is displayed.

![Four Js Online Registration Page](image)

**Figure 15: Four Js Online Registration Page**
3. Complete the Online registration form making sure that everything is entered correctly and select Submit. A new page is displayed showing information that your license has been registered and providing you with:
   - Installation key
   - Maintenance key
At this point, you need to install the installation and maintenance keys.

Related tasks
Troubleshooting license registration on page 74
When registering your license on the Four Js website you get an error message. More than likely you need to request a new activation key.

Troubleshooting license registration

When registering your license on the Four Js website you get an error message. More than likely you need to request a new activation key.

When registering a license, an error message on the registration page states that you may need to request a new activation key. You may encounter this issue, for example, when you are upgrading your server and registering a license that has already been registered for another server.

There has been a problem during the submit process. Please check following comment:
The number of licensing request is over. Please send a New Activation Key Request Form to your license provider.

Figure 16: Four Js license registration failure

1. Navigate to the Support > License forms page.
2. Click on the New Activation Key Request link.
3. Download the form.
4. Fill out the form to complete the request for a new activation key and send it to Four Js.
For more information and support contact your local Four Js support center.

Get maintenance key from Four Js website

You get the maintenance key from the Four Js website to ensure you have a valid maintenance key to install or update your product's license.

About this task:

If you can use the license controller \texttt{-m auto} option to install the maintenance key via the internet, (for example \texttt{fglWrt \ -m auto}), then you do not need to perform this task.

Before you begin:

You must also have the following:

- Customer code
- License number

1. Open your browser and navigate to the Four Js web site.
2. Navigate to the Support > License your products page and scroll to the Online maintenance section.

\textbf{Figure 17: Four Js Online Maintenance form}

3. Complete the form making sure that everything is entered correctly and select Submit.

A new page is displayed providing you with the maintenance key.

At this point, you need to install the maintenance key.

Steps to finalize temporary BDL license

You finalize your product's license installation after registering the license with Four Js. To complete licensing, select the option (with or without internet) that is right for you and match it with the procedure to follow.

Before you begin finalizing licensing:

1. Decide which tool (GUI or command line) you are using to install the license:
   - \textbf{Genero BDL Licenser} (GUI application)
   - \texttt{fglWrt} (command line tool).
2. Determine if you have internet access from the machine you are licensing the product.
3. Use Table 14: Options for licensing on page 76 to choose your licensing option, and select the procedure to follow.
Table 14: Options for licensing

<table>
<thead>
<tr>
<th>You are using ...</th>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Genero BDL Licenser with internet</td>
<td>See Finalize BDL license with user interface (via internet) on page 76.</td>
</tr>
<tr>
<td>Genero BDL Licenser without internet.</td>
<td>See Finalize BDL license with user interface (no internet) on page 77.</td>
</tr>
<tr>
<td>fglWrt command line tool with internet.</td>
<td>See Finalize BDL license from the command line (via internet) on page 79.</td>
</tr>
<tr>
<td>fglWrt command line tool without internet.</td>
<td>See Finalize BDL license from the command line (no internet) on page 79.</td>
</tr>
</tbody>
</table>

Finalize BDL license with user interface (via internet)
You can complete licensing using the user interface. The license is registered with Four Js via the internet and the maintenance key is installed.

Before you begin: You must have internet access from the machine you are licensing the product to validate the license.

1. Launch the Genero licensing user interface.
   - From within the Genero Studio product interface, launch it from the Tools > Genero Tools menu
   - From the desktop select the Genero BDL Licenser tool from your Four Js program list

   The licensing page opens in your Web browser.

2. Select the REGISTER LICENSE USING FOUR JS ACTIVATION SERVER option.
3. In the CUSTOMER CODE field, enter your customer code.

4. If your access to the internet is through a proxy, select the USE PROXY option, and perform the following steps:
   a) Provide the required information for HTTP PROXY and PORT options.
   b) If the proxy requires authentication, select the USE AUTHENTICATION option and provide the required information for LOGIN and PASSWORD.

5. Click INSTALL KEYS

   Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.

6. When finished, click QUIT to log out and close the licensing application.

**Finalize BDL license with user interface (no internet)**

Without internet access, you complete licensing using the user interface as described.

Register the license
1. To register the license go to the License your products page on the Four Js website. See the procedure described in Register license on Four Js website on page 72.

    Having registered your license, you have the installation key.

2. Launch the Genero licensing user interface.

    • From within the Genero Studio product interface, launch it from the Tools > Genero Tools menu
    • From the desktop select the Genero BDL Licenser tool from your Four Js program list

    The licensing page opens in your Web browser.

3. Enter your installation key, and click INSTALL KEY.

![Figure 19: Manually install installation key and maintenance key](image)

4. Enter your maintenance key, and click UPDATE KEY.

    Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.

5. When finished, click QUIT to close the licensing application.
Finalize BDL license from the command line (via internet)

Your license is registered with Four Js via the internet and the installation and maintenance keys are installed automatically using the command fglWrt -k auto.

**Before you begin:** You must have internet access from the machine you are licensing the product to validate the license.

1. At the command line enter the command:
   
   ```
   fglWrt -k auto
   ```

2. When prompted, enter your customer code:
   
   ```
   Enter your customer code >
   ```

3. At the following prompt:
   
   ```
   Do you need to configure an HTTP proxy ? (y/n)
   ```

   Enter y if your access to the internet is through a proxy. Provide the required information for HTTP proxy, Port, and authentication when prompted. Otherwise, enter n.

   The installation key and the maintenance key are installed automatically and the message is displayed.

   ```
   Installing maintenance key 'MMMMMMMMMMMM'
   License installation successful.
   ```

   License installation is now completed.

**Note:** There is no need to run fglWrt -m auto to install the maintenance key.

Finalize BDL license from the command line (no internet)

Without internet access, you can register the license with Four Js from another machine via the internet, or by phone. Then complete licensing of your BDL product using the command line tool, fglWrt, as described.

**Register the license**

1. To register the license go to the License your products page on the Four Js web site. See the procedure described in Register license on Four Js website on page 72

   Having registered your license, you have the installation key.

2. At the command line enter the command to install the installation key:

   ```
   fglWrt -k <installation-key>
   ```

   A message is displayed in the output to say the installation key was installed successfully.

3. At the command line enter the command to install the maintenance key:

   ```
   fglWrt -m <maintenance-key>
   ```

   A message is displayed in the output to say the license installation was successful.

License installation is now completed.
Steps to apply maintenance or subscription key (BDL)

You apply a maintenance key (also known as a subscription key depending on your contract) when you are installing a license for a product and thereafter when you renew your maintenance contract.

An active maintenance or subscription contract is required to license a product. The maintenance key determines which version of the Genero product you are authorized to use with your license, and the date that the maintenance contract expires.

Before you begin applying a maintenance key:

1. Decide which tool (GUI or command line) you are using to install the key:
   - **Genero BDL Licenser** (GUI application)
   - **fglwrt** (command line tool).

2. Determine if you have internet access from the machine you are licensing the product.

3. Use Table 15: Options for licensing on page 80 to choose your licensing option, and select the procedure to follow.

### Table 15: Options for licensing

<table>
<thead>
<tr>
<th>You are using ...</th>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Genero BDL Licenser</strong> with internet</td>
<td>See Install or update the maintenance key (BDL) with UI (via internet) on page 80.</td>
</tr>
<tr>
<td><strong>Genero BDL Licenser</strong> without internet.</td>
<td>See Install or update the maintenance key (BDL) with UI (no internet) on page 82.</td>
</tr>
<tr>
<td><strong>fglwrt</strong> command line tool with internet.</td>
<td>See Install or update the maintenance key (BDL) with fglwrt (via internet) on page 83.</td>
</tr>
<tr>
<td><strong>fglwrt</strong> command line tool without internet.</td>
<td>See Install or update the maintenance key (BDL) with fglwrt (no internet) on page 83.</td>
</tr>
</tbody>
</table>

**Install or update the maintenance key (BDL) with UI (via internet)**

Use the Genero user interface to install or update your maintenance key.

**Before you begin:** You must have internet access from the machine you are licensing the product to validate the license.

1. Launch the Genero licensing user interface.
   - From within the Genero Studio product interface, launch it from the **Tools > Genero Tools** menu
   - From the desktop select the **Genero BDL Licenser** tool from your Four Js program list

   The licensing page opens in your Web browser.

2. Select the **REGISTER LICENSE USING FOUR JS ACTIVATION SERVER** option.
Figure 20: Example installing maintenance key

3. In the CUSTOMER CODE field, enter your customer code.

4. If your access to the internet is through a proxy, select the USE PROXY option, and perform the following steps:
   a) Provide the required information for HTTP PROXY and PORT options.
   b) If the proxy requires authentication, select the USE AUTHENTICATION option and provide the required information for LOGIN and PASSWORD.

5. Click INSTALL MAINTENANCE KEY

   Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.

6. When finished, click QUIT to log out and close the licensing application.
Install or update the maintenance key (BDL) with UI (no internet)

Without internet access, you can get the maintenance key from Four Js from another machine via the internet. Then use the Genero user interface to install or update your maintenance key.

1. From a machine with internet access, open a browser and navigate to the Four Js web site to get the maintenance key. See the procedure described in Get maintenance key from Four Js website on page 75.
2. Launch the Genero licensing user interface.
   - From within the Genero Studio product interface, launch it from the Tools > Genero Tools menu
   - From the desktop select the Genero BDL Licenser tool from your Four Js program list

The licensing page opens in your Web browser.

3. Enter your maintenance key in the field provided, and click UPDATE KEY.

Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.
4. When finished, click **QUIT** to close the licensing application.

### Install or update the maintenance key (BDL) with fglwrt (via internet)

You can install or update the maintenance key of your BDL product using the command line tool, fglWrt.

**Before you begin:** You must have internet access to automatically install the maintenance key.

1. At the command line enter the command:
   ```
   fglWrt -m auto
   ```
2. When prompted, enter your customer code:
   ```
   Enter your customer code >
   ```
3. At the following prompt:
   ```
   Do you need to configure an HTTP proxy ? (y/n)
   ```
   Enter **y** if your access to the internet is through a proxy. Provide the required information for **HTTP proxy**, **Port**, and authentication when prompted. Otherwise, enter **n**.

   The **maintenance key** is then retrieved from the Four Js Activation server and a message is displayed:
   ```
   Maintenance key installation successful.
   ```

### Install or update the maintenance key (BDL) with fglwrt (no internet)

Without internet access, you can get the maintenance key from Four Js from another machine via the internet. Then to install or update the maintenance key of your BDL product use the command line tool, fglWrt.

1. From a machine with internet access, open a browser and navigate to the Four Js web site to get the maintenance key. See the procedure described in **Get maintenance key from Four Js website** on page 75.
2. At the command line enter the command to install the maintenance key:
   ```
   fglWrt -m <maintenance-key>
   ```
   A message is displayed in the output to say the license installation was successful.

   License installation is now completed.

### License using Four Js License Manager

License your Genero Business Development Language (BDL) product installation using a license manager on the network.

For details see **License using license manager** on page 106.

### License Genero Report Engine (GRE)

These topics give you the information you need to install and manage the license of your Genero Report Engine.

If your Genero Business Development Language (BDL) installation has a valid maintenance key, the Genero Report Engine is licensed under its installation. If the BDL maintenance is not up to date, a GRE license is required.

**Note:** If you have a Genero Report Writer installed, the GRE will not be limited under the Genero BDL maintenance but instead will function under the Genero Report Writer installation maintenance. For licensing in this case see the **Install and License Genero Report Writer** manual.
Steps to GRE license installation

Steps to GRE license installation involves evaluating your options based on what licensing tool (GUI or command line) is available to you, and whether you can validate the installed license with Four Js over the internet. Choose the option that is right for you and match it with the procedure to follow.

Before you begin Genero product licensing:

1. Locate your email message that contains the following:
   - product license key
   - product license number
   - product maintenance key
   - your customer code

   If you do not have this email, contact your local Four Js sales office.

2. Decide which tool (GUI or command line) you are using to install the license:
   - Genero Report Engine Licenser (GUI application)
   - greWrt (command line tool).

3. Determine if you have internet access from the machine you are licensing the product.

4. Use Table 16: Options for licensing on page 84 to choose your licensing option, and select the procedure to follow.

Table 16: Options for licensing

<table>
<thead>
<tr>
<th>You are using ...</th>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td>grxWrt command line tool with internet.</td>
<td>See Install GRE license from the command line on page 86.</td>
</tr>
<tr>
<td>grxWrt command line tool without internet.</td>
<td>See Install GRE license from the command line on page 87.</td>
</tr>
</tbody>
</table>

Install Genero Report Engine license with GUI (internet)

You can license a Genero Report Engine (GRE) product installation using the Genero Report Engine Licenser GUI application.

Before you begin: You must have internet access from the machine you are licensing the product to validate the license.

1. Launch the Genero licensing user interface.
   - From within the Genero Studio product interface, launch it from the Tools > Genero Tools menu
   - From the desktop select the Genero Report Engine Licenser application tool from your Four Js program list:
The licensing page opens in your Web browser.

![Genero Report Engine Licenser](image)

**Figure 22: Genero Report Engine Licenser**

2. Enter your license number and license key, and click **INSTALL**.

**Register the license**

3. Select the **REGISTER LICENSE USING FOUR JS ACTIVATION SERVER** option.
4. In the **CUSTOMER CODE** field, enter your customer code.
5. If your access to the internet is through a proxy, select the **USE PROXY** option, and perform the following steps:
   a) Provide the required information for **HTTP PROXY** and **PORT** options.
   b) If the proxy requires authentication, select the **USE AUTHENTICATION** option and provide the required information for **LOGIN** and **PASSWORD**.
6. Click **INSTALL KEYS**

Your product is now fully licensed. In the **DESCRIPTION** field you see your maintenance key is valid until the date displayed after **End of maintenance date**.
7. When finished, click **QUIT** to log out and close the licensing application.

**Install GRE license with GUI (no internet)**

Without internet access, you register the license with Four Js from another machine via the internet, or by phone. Then use the user interface to license your Genero Report Engine.

1. Launch the Genero licensing user interface.
   - From within the Genero Report Writer product interface, launch it from the **Tools > Genero Tools** menu
   - From the desktop select the **Genero Report Engine Licenser** application tool from your Four Js program list:

   The licensing page opens in your Web browser.

2. Enter your license number and license key, and click **INSTALL**.
   - An **installation number** is generated.

**Register the license**

3. To register the license go to the License your products page on the [Four Js web site](https://www.fourjs.com). See the procedure described in [Register license on Four Js website](https://www.fourjs.com/documentation/registration) on page 72
Having registered your license, you have the installation key.

4. On the licensing page enter your installation key in the **INSTALLATION KEY** field, and click **INSTALL KEY**.

![Figure 23: Manually install installation key and maintenance key](image)

5. Enter your maintenance key, and click **UPDATE KEY**.

Your product is now fully licensed. In the **DESCRIPTION** field you see your maintenance key is valid until the date displayed after **End of maintenance date**.

6. When finished, click **QUIT** to close the licensing application.

**Install GRE license from the command line**

You can license a Genero Report Engine (GRE) product using the command line tool, greWrt. During installation the license is registered with Four Js via the internet.

**Before you begin:** You must have internet access from the machine you are licensing the product to validate the license.

1. At the command line enter the command:

   ```
   greWrt -l
   ```

2. When prompted, enter the license number.
3. When prompted, enter the license key.
4. At the prompt:

   ```
   Do you want to continue using HTTP ? (y/n)
   ```

   Enter: y
5. When prompted, enter your customer code:

   Enter your customer code >

6. At the following prompt:

   Do you need to configure an HTTP proxy ? (y/n)

Enter y if your access to the internet is through a proxy. Provide the required information for HTTP proxy, Port, and authentication when prompted. Otherwise, enter n.

![Administration Command Prompt](image)

**Figure 24: Installing and registering a license via HTTP with greWrt**

License installation is now completed.

**Install GRE license from the command line**

Without internet access, you can register the license with Four Js from another machine via the internet, or by phone. Then license your Genero Report Engine (GRE) product using the command line tool, greWrt.

1. At the command line enter the command:

   greWrt -l

2. When prompted, enter the license number.
3. When prompted, enter the license key.
   An **installation number** is generated and is displayed in the output.
4. At the prompt:

   Do you want to continue using HTTP ? (y/n)

Enter: n

5. At the prompt:

   Enter your maintenance KEY (Empty to continue) >

Enter the maintenance key.

**Register the license**

6. To register the license go to the License your products page on the Four Js web site. See the procedure described in **Register license on Four Js website** on page 72

Having registered your license, you have the installation key.
7. At the prompt:

```
Enter the installation KEY (call your vendor to obtain it) >
```

Enter the installation key.

![Figure 25: Installing license with greWrt](image)

License installation is now completed.

## Manage Genero Report Engine local license

Refer to the topics in this section to quickly become familiar with how to perform license management tasks.

You can install and manage licenses locally using the license controller (`greWrt`) installed with the product.

- [License Controller (greWrt) options](#) on page 88
- [Get license information](#) on page 89
- [Uninstall license](#) on page 92
- [License an upgraded installation](#) on page 69

### License Controller (greWrt) options

The `greWrt` command line tool is used to install, upgrade, or delete Genero Report Engine licenses. There are also options to provide various types of license information and statistics.

**Syntax**

```
greWrt [options]
```

1. `options` are described in [Table 17: greWrt options](#) on page 88.

### greWrt Options

#### Table 17: greWrt options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-v</code> or <code>-V</code></td>
<td>Display version information for the tool.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>-h</td>
<td>Displays options for the tool. Short help.</td>
</tr>
<tr>
<td></td>
<td>Installs a license.</td>
</tr>
<tr>
<td>-l license</td>
<td>Note: To escape when prompted to enter a license number and license key, type &quot;stop&quot; at the prompt. Maintenance key installation, possible options are:</td>
</tr>
<tr>
<td></td>
<td>key : Install a key directly.</td>
</tr>
<tr>
<td></td>
<td>auto : The key is automatically installed (Internet connection is required).</td>
</tr>
<tr>
<td>-m option</td>
<td>Check for active users.</td>
</tr>
<tr>
<td></td>
<td>Installation key for license validation, possible options are:</td>
</tr>
<tr>
<td></td>
<td>key : Install a key directly.</td>
</tr>
<tr>
<td></td>
<td>auto : The key is automatically installed (Internet connection is required).</td>
</tr>
<tr>
<td>-d</td>
<td>Remove current installed license.</td>
</tr>
<tr>
<td>-i</td>
<td>Clears the list of registered user sessions.</td>
</tr>
<tr>
<td>-k option</td>
<td>Check or view options, possible options are:</td>
</tr>
<tr>
<td></td>
<td>ps : Shows processes on this machine.</td>
</tr>
<tr>
<td></td>
<td>env : Shows current environment</td>
</tr>
<tr>
<td></td>
<td>cpu : Shows number of CPU in the computer.</td>
</tr>
<tr>
<td>-a option</td>
<td>hostname : Shows name of this machine.</td>
</tr>
<tr>
<td></td>
<td>info license : Shows license information.</td>
</tr>
<tr>
<td></td>
<td>info stat : Shows statistics of license server.</td>
</tr>
<tr>
<td></td>
<td>info users : Shows all registered active users.</td>
</tr>
<tr>
<td></td>
<td>info up : Shows if license server is up.</td>
</tr>
<tr>
<td>-x or -kill-session pid</td>
<td>Clears the session referenced by the specified pid.</td>
</tr>
<tr>
<td>docker-assign</td>
<td>Assigns the license to a running docker instance.</td>
</tr>
<tr>
<td>docker-release</td>
<td>Release a docker-assigned license.</td>
</tr>
</tbody>
</table>

**Get license information**

Get details of the status of the license of your Genero product, for example, the maintenance contract expiry date, or the installation number for license registration.

- License details reference on page 64
- Get license information on page 90
- Get license information using GRE licenser on page 91

**License details reference**

A reference to license details.

The output from the license controller command, for example, `fglWrt -a info license`) and/or the Genero Licenser application screen displays details about the installed license. Use Table 18: License details on page 90 as a reference to look up details of your license.

**Note:** For specific license details, see your license agreement, or contact your nearest Four Js sales office.
### Table 18: License details

<table>
<thead>
<tr>
<th>Details displayed</th>
<th>Description</th>
</tr>
</thead>
</table>
| Server name      | This is the name of the license manager server.  
                    **Note:** Indicates that licensing is managed by a License Manager. |
| TCP Port         | This is the port the license manager is listening.  
                    **Note:** Indicates that licensing is managed by a License Manager. |
| License          | This is the value of the license number. |
| License Key      | This is the value of the license key. |
| Product          | This refers to the name of the product under license, for example:  
                    • Four J's Universal Compiler (for Genero Enterprise and Genero Mobile products)  
                    • Four Js Genero Report Writer (for Genero Report Engine) |
| Type             | This refers to the type of license. This can be:  
                    • runtime  
                    • development |
| Users            | This number indicates the maximum number of users allowed to use the license. |
| Extension(s)     | This entry provides information on some specific conditions of the license. For example, "- Open Database Interface" means that your license allows you to use any database.  
                    The **installation number** is displayed if the license is a temporary license and the installation has not been finalized.  
                    If the license is **date-limited**, then the date when the license expires is shown. |
| End of maintenance date | This entry indicates the date your maintenance contract expires. |

**Related tasks**

*Get license information* on page 65  
Get details of the status of the license of your Genero product.

**Get license information**  
Get details of the status of the license of your Genero product.

**About this task:**  
Use this procedure, for example, to find out the date the maintenance contract expires.

**Tip:** You can also use the procedure described in this topic to retrieve the **installation number** when you need to register the license and finalize the installation.
From a command prompt, enter the command:

```
greWrt -a info license
```

**Example of Genero Report Engine license information:**

<table>
<thead>
<tr>
<th>License</th>
<th>(GRE Built-in license)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>Four Js Genero Report Writer</td>
</tr>
<tr>
<td>Type</td>
<td>Runtime version</td>
</tr>
<tr>
<td>CPU(s)</td>
<td>CPU unlimited</td>
</tr>
<tr>
<td>Extension(s)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- DVM License under maintenance</td>
</tr>
</tbody>
</table>

In the example, the Genero Report Engine license is shown as built-in. This means that it is covered under the Genero Business Development Language installation. As the DVM license is under maintenance, the GRE license is valid.

**Related concepts**

- [License details reference on page 64](#)  

A reference to license details.

**Get license information using GRE licenser**

Get details of the status of the license of your Genero Report Engine product.

1. Launch the Genero Licenser application.
   - From within the Genero Studio product interface, launch it from the Tools > Genero Tools menu.
   - From the desktop select the Genero Report Engine Licenser application tool from your Four Js program list.

   The Four Js Licensing Application opens.
Figure 26: Genero Report Engine Licenser

In the example, the Genero Report Engine license is shown as built-in. This means that it is covered under the Genero Business Development Language installation. As the DVM license is under maintenance, the GRE license is valid.

2. When finished, select Quit to exit the application.

Related concepts
License details reference on page 64
A reference to license details.

Uninstall license
You may need to uninstall a license if you are making some hardware or software changes.

- Uninstall license with GRE licenser on page 92
- Uninstall license from command line on page 93

Uninstall license with GRE licenser
Use this procedure to uninstall a license for your Genero Report Engine product using the Genero Report Engine Licenser.

About this task:

Note: This procedure is valid for a local license only. If you are using the Four Js License Manager, see Manage licenses with FLM (flmprg) on page 111.

1. Launch the Genero licensing user interface.
   - From within the Genero Report Writer product interface, launch it from the Tools > Genero Tools menu
• From the desktop select the **Genero Report Engine Licenser** application tool from your Four Js program list:
  
The licensing page opens in your Web browser.

2. Click **Uninstall** to uninstall the license.
   
The **DESCRIPTION** field is updated to show a license is not installed.

3. When finished, click **QUIT** to close the licensing application.

**Uninstall license from command line**

Use this procedure to uninstall a license for your Genero Report Engine product using greWrt.

**Before you begin:** You must be the root user or the user who installed the software, to run the license controller command.

From a command prompt, enter the license controller command.

```
  greWrt -d
```

At the prompt:

```
  Do you really want to uninstall the license (y/n)?
```

Enter: y

The license is uninstalled. A message confirms the license is uninstalled.

![Figure 27: Uninstalling a License with the License Controller (greWrt)](image)

**License an upgraded installation**

There are some considerations for licensing when upgrading an existing Genero installation to a newer version.

**Notes about Upgrading**

It is not necessary to re-enter the license of the product if the new version:

- Is installed into an existing installation directory
- Is not a major version number change

When you have purchased a new maintenance contract, the new maintenance key must be installed. To install your new maintenance key, you do not need to reinstall your license. Updating the maintenance key is handled separately. There is also no need to uninstall the old maintenance key.

**Register license on Four Js website**

Register your license with Four Js in order to validate it.

**About this task:**

**Important:**
If you can use the license controller \texttt{-m auto} option to install the license via the internet, (for example \texttt{fglWrt -m auto}), then you do not need to perform this task.

**Before you begin:**

- Get your **installation number** from the output of the following command:

  \begin{verbatim}
  \texttt{<license_controller> -a info license}
  \end{verbatim}

  Where \texttt{<license_controller>} is \texttt{fglWrt} (for Genero Enterprise), or \texttt{greWrt} (for Genero Report Engine), depending on which product you are licensing.

  Or if you are using Four Js License Manager, use the following command:

  \begin{verbatim}
  \texttt{flmprg -a info license <license_number>}
  \end{verbatim}

- You must also have the following:
  - Customer code
  - License number
  - License key

  Typically, these are delivered by email with your product. If you do not have them, contact your local sales office.

1. Open your browser and navigate to the Four Js web site:

2. Navigate to the **Support > License your products** page.
   The **Online registration** form is displayed.
3. Complete the **Online registration** form making sure that everything is entered correctly and select **Submit**. A new page is displayed showing information that your license has been registered and providing you with:

- Installation key
- Maintenance key

At this point, you need to install the installation and maintenance keys.

**Related tasks**

[Troubleshooting license registration](#) on page 74

When registering your license on the Four Js website you get an error message. More than likely you need to request a new activation key.

---

**Get maintenance key from Four Js website**

You get the maintenance key from the Four Js website to ensure you have a valid maintenance key to install or update your product's license.

**About this task:**
If you can use the license controller `m auto` option to install the maintenance key via the internet, (for example `fglWrt -m auto`), then you do not need to perform this task.

**Before you begin:**

You must also have the following:

- Customer code
- License number

1. Open your browser and navigate to the Four Js web site.
2. Navigate to the Support > License your products page and scroll to the Online maintenance section.

![Four Js Online Maintenance form](image)

**Figure 29: Four Js Online Maintenance form**

3. Complete the form making sure that everything is entered correctly and select Submit.

A new page is displayed providing you with the maintenance key.

At this point, you need to install the maintenance key.

**Steps to finalize temporary GRE license**

You register the license with Four Js to finalize your product's license installation. To complete licensing, select the option (with or without internet) that is right for you and match it with the procedure to follow.

**Before you begin finalizing licensing:**

1. Decide which tool (GUI or command line) you are using to install the license:
   - Genero Report Engine Licenser (GUI application)
   - greWrt (command line tool).
2. Determine if you have internet access from the machine you are licensing the product.
3. Use Table 20: Options for licensing on page 100 to choose your licensing option, and select the procedure to follow.

**Table 19: Options for licensing**

<table>
<thead>
<tr>
<th>You are using ...</th>
<th>Procedure to follow</th>
</tr>
</thead>
</table>
You are using ...


Procedure to follow

See Finalize Genero Report Engine license with GUI (no internet) on page 98

See Finalize Genero Report Engine license from the command line (via internet) on page 99

See Finalize Genero Report Engine license from the command line (no internet) on page 100

Finalize Genero Report Engine license with GUI (via internet)

You can complete licensing using the user interface. The license is registered with Four Js via the internet and the maintenance key is installed.

Before you begin: You must have internet access from the machine you are licensing the product to validate the license.

1. Launch the Genero licensing user interface.
   - From within the Genero Report Writer product interface, launch it from the Tools > Genero Tools menu
   - From the desktop select the Genero Report Engine Licenser application tool from your Four Js program list:
     The licensing page opens in your Web browser.

Register the license

2. Select the REGISTER LICENSE USING FOUR JS ACTIVATION SERVER option.

Figure 30: Example registering the license
3. In the **CUSTOMER CODE** field, enter your customer code.

4. If your access to the internet is through a proxy, select the **USE PROXY** option, and perform the following steps:
   a) Provide the required information for **HTTP PROXY** and **PORT** options.
   b) If the proxy requires authentication, select the **USE AUTHENTICATION** option and provide the required information for **LOGIN** and **PASSWORD**.

5. Click **INSTALL KEYS**

   Your product is now fully licensed. In the **DESCRIPTION** field you see your maintenance key is valid until the date displayed after **End of maintenance date**.

6. When finished, click **QUIT** to log out and close the licensing application.

**Finalize Genero Report Engine license with GUI (no internet)**

Without internet access, you register the license with Four Js from another machine via the internet, or by phone. Then to complete licensing use the user interface as described.

**Register the license**

1. To register the license go to the License your products page on the Four Js web site. See the procedure described in Register license on Four Js website on page 72

   Having registered your license, you have the installation key.

2. Launch the Genero licensing user interface.

   • From within the Genero Report Writer product interface, launch it from the **Tools > Genero Tools** menu
   • From the desktop select the **Genero Report Engine Licenser** application tool from your Four Js program list:

   The licensing page opens in your Web browser.

3. Enter your installation key, and click **INSTALL KEY**.
Figure 31: Manually install installation key and maintenance key

4. Enter your maintenance key, and click UPDATE KEY.

Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.

5. When finished, click QUIT to log out and close the licensing application.

Finalize Genero Report Engine license from the command line (via internet)

Licensing of your Genero Report Engine product can be completed using the command `greWrt -k auto`. Your license is registered with Four Js via the internet and the installation and maintenance keys are installed automatically.

**Before you begin:** You must have internet access from the machine you are licensing the product to validate the license.

1. At the command line enter the command:

   ```bash
   greWrt -k auto
   ```

2. When prompted, enter your customer code:

   ```bash
   Enter your customer code >
   ```

3. At the following prompt:

   ```bash
   Do you need to configure an HTTP proxy? (y/n)
   ```

   Enter `y` if your access to the internet is through a proxy. Provide the required information for HTTP proxy, Port, and authentication when prompted. Otherwise, enter `n`. 
The installation key and the maintenance key are installed automatically and the message is displayed.

```
Installing maintenance key 'MMMMMMMMMMMM'
License installation successful.
```

License installation is now completed.

**Note:** There is no need to run `greWrt -m auto` to install the maintenance key.

---

**Finalize Genero Report Engine license from the command line (no internet)**

Without internet access, you can register the license with Four Js from another machine via the internet, or by phone. Then complete licensing of your Genero Report Engine product using the command line tool, `greWrt`.

**Register the license**

1. To register the license contact the vendor by phone, or register on the Genero Report Writer website. See the procedure described in Register license on Four Js website on page 72

Having registered your license, you have the installation key.

2. At the command line enter the command to install the installation key:

   ```
   greWrt -k <installation-key>
   ```

   A message is displayed in the output to say the installation key was installed successfully.

3. At the command line enter the command to install the maintenance key:

   ```
   greWrt -m <maintenance-key>
   ```

   A message is displayed in the output to say the license installation was successful.

License installation is now completed.

---

**Steps to apply maintenance or subscription key (GRE)**

You apply a maintenance key (also known as a subscription key depending on your contract) when you are installing a license for a product and thereafter when you renew your maintenance contract.

An active maintenance or subscription contract is required to license a product. The maintenance key determines which version of the Genero product you are authorized to use with your license, and the date that the maintenance contract expires.

Before you begin applying a maintenance key:

1. Decide which tool (GUI or command line) you are using to install the key:
   - **Genero Report Engine Licenser** (GUI application)
   - `greWrt` (command line tool).

2. Determine if you have internet access from the machine you are licensing the product.

3. Use Table 20: Options for licensing on page 100 to choose your licensing option, and select the procedure to follow.

**Table 20: Options for licensing**

<table>
<thead>
<tr>
<th>You are using ...</th>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Genero Report Engine Licenser with internet</td>
<td>See Install or update the maintenance key (GRW) with GUI (via internet) on page 101</td>
</tr>
</tbody>
</table>
You are using ...

<table>
<thead>
<tr>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td>gwxWrt command line tool with internet.</td>
</tr>
<tr>
<td>gwxWrt command line tool without internet.</td>
</tr>
</tbody>
</table>

Install or update the maintenance key (GRW) with GUI (via internet)

Use the Genero user interface to install or update your maintenance key.

**Before you begin:** You must have internet access from the machine you are licensing the product to validate the license.

1. Launch the Genero licensing user interface.
   - From within the Genero Report Writer product interface, launch it from the Tools > Genero Tools menu
   - From the desktop select the Genero Report Engine Licenser application tool from your Four Js program list:
     The licensing page opens in your Web browser.

2. Select the REGISTER LICENSE USING FOUR JS ACTIVATION SERVER option.

![Genero Report Writer - Licensing version: 5.20.05-201610011716 (w64r140)](image)

**Figure 32:** Example installing maintenance key

3. In the CUSTOMER CODE field, enter your customer code.

4. If your access to the internet is through a proxy, select the USE PROXY option, and perform the following steps:
a) Provide the required information for HTTP PROXY and PORT options.
b) If the proxy requires authentication, select the USE AUTHENTICATION option and provide the required information for LOGIN and PASSWORD.

5. Click INSTALL MAINTENANCE KEY

Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.

6. When finished, click QUIT to log out and close the licensing application.

Install or update the maintenance key (GRE) with GUI (no internet)
Without internet access, you can get the maintenance key from Four Js from another machine via the internet. Then use the Genero user interface to install or update your maintenance key.

1. To get the maintenance key, open a browser and navigate to the Four Js web site. See the procedure described in Get maintenance key from Four Js website on page 75.

2. Launch the Genero licensing user interface.
   • From within the Genero Report Writer product interface, launch it from the Tools > Genero Tools menu
   • From the desktop select the Genero Report Engine Licenser application tool from your Four Js program list:
     The licensing page opens in your Web browser.

3. Enter your maintenance key, and click UPDATE KEY.

Figure 33: Manually install maintenance key

Your product is now fully licensed. In the DESCRIPTION field you see your maintenance key is valid until the date displayed after End of maintenance date.

4. When finished, click QUIT to close the licensing application.
Install or update the maintenance key (GRE) with greWrt (via internet)

You can install or update the maintenance key of your Genero Report Engine (GRE) product using the command, greWrt -m auto. During installation the maintenance key is retrieved from Four Js via the internet.

Before you begin: You must have internet access to automatically install the maintenance key.

1. At the command line enter the command:

```
greWrt -m auto
```

2. When prompted, enter your customer code:

```
Enter your customer code >
```

3. At the following prompt:

```
Do you need to configure an HTTP proxy ? (y/n)
```

Enter y if your access to the internet is through a proxy. Provide the required information for HTTP proxy, Port, and authentication when prompted. Otherwise, enter n.

The maintenance key is then retrieved from the Four Js Activation server and a message is displayed:

```
Maintenance key installation successful.
```

Install or update the maintenance key (GRE) with greWrt (no internet)

Without internet access, you can get the maintenance key from Four Js from another machine via the internet. Then to install or update the maintenance key of your Genero Report Engine (GRE) product use the command line tool, greWrt.

Register the license

1. To get the maintenance key, open a browser and navigate to the Four Js web site. See the procedure described in Get maintenance key from Four Js website on page 75.

2. At the command line enter the command to install the maintenance key:

```
greWrt -m <maintenance-key>
```

A message is displayed in the output to say the license installation was successful.

License installation is now completed.

License Genero Report Engine using the Four Js License Manager

License your Genero Report Engine (GRE) product installation using a license manager on the network.

For details see License using license manager on page 106.

License Genero Mobile

To license Genero Mobile, you license the Genero Business Development Language. Please see the topics covering the licensing of Genero Business Development Language.

When licensing Genero Mobile, your Genero Business Development Language (BDL) license must be for a Genero Mobile installation. If you receive an error message:

```
ERROR(-6024) : Modules compiled with Genero Mobile require a Genero Mobile license at runtime.
```
This means that the Genero BDL license you have is not valid for Genero Mobile. Please contact your local sales office for further information.

**Tip:** While you can use a license manager for Genero Mobile, the Genero Mobile license is an individual license and there is no need to use a license manager. You would only consider using the Four Js License Manager for Genero Mobile if you already use it with an existing Genero installation.

- Find your mobile app p-code size on page 104

**Related concepts**

- Steps to BDL license installation on page 52
  Preparing to license involves evaluating your options based on what licensing tool (GUI or command line) is available to you, and whether you can validate the installed license with Four Js over the internet. Choose the option that is right for you and match it with the procedure to follow.

### Find your mobile app p-code size

If you have a Genero Mobile free developer license, use this procedure to determine your app’s p-code size.

The free developer license is suitable for apps whose p-code is under 64K (65,535 bytes to be precise).

**Note:** For general information about the `fglrun` sizing options `--program-size` and `--module-size`, see the *Genero Business Development Language User Guide*.

1. From Genero Studio, open the **Tools > Genero Tools** menu and select **Genero Workplace Window**.
   The **Genero Workplace Window** opens and displays a command prompt.

2. Verify that you are using a free Genero Mobile license.
   Type the command `fglWrt -a info`.

   ![Figure 34: Checking your Genero Mobile license](image)

   The output states when you are using a free license. You only need to continue this procedure if you are using a free license. A paid license has no limit.

3. Navigate to the directory where your compiled program files reside.

4. Type the command `fglrun --program-size appname`, where `appname` is your app name.
Figure 35: Determining the bytes towards your app p-code limit

The last line of the output shows the number of kilobytes of p-code for the app, as well as the number of kilobytes that apply towards the free license limit. The limit number cannot exceed 64K.

**Note:** The limit only includes the modules compiled with the free license. These modules are identified with the *(limited)* tag in the command output. Modules precompiled in Genero packages are not compiled with a free license, and therefore do not count towards the limit.
License using license manager

License your Genero Business Development Language (BDL) or Genero Report Engine (GRE) product installation using a license manager on the network.

Topics

• License Manager configuration on page 106
• Steps to licensing with FLM on page 108
• Manage licenses with FLM (flmprg) on page 111
• Steps to finalize temporary license with FLM on page 118
• Steps to apply maintenance (FLM) on page 120

License Manager configuration

Configure by linking the DVM configuration file with the License Manager.

Tip:

The DVM configuration file, for example $FGLDIR/etc/fglprofile, can be automatically updated with FLM server details when installing Genero on a UNIX® platform, as long as the FLM is installed, and the option to use the FLM is selected at time of installation.

Topics

• Configuring the License Manager on page 106
• Configuring the license controller on page 107

Configuring the License Manager

To configure the Four Js License Manager (FLM), edit the $FLMDIR/etc/lmprofile file.

Configuration entries are in the format name-of-resource="value"

Note: The flm.storage configuration entry was deprecated in version 5.12.08. If a configuration entry is set for flm.storage, it is silently ignored.

1. To set the value for the FLM server resource, add the line in the following format with the name of server:

   For example:
   
   flm.server="localhost"

2. Add or update values for the resources shown in Table 21: License Manager Configuration Resources on page 106 as required:

Table 21: License Manager Configuration Resources

<table>
<thead>
<tr>
<th>Resource Name</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>flm.server</td>
<td>none</td>
<td>Name of the machine that hosts FLM. Set this value to the current machine name or IP address. If your DNS or your hosts file is correctly configured, you can safely use localhost.</td>
</tr>
</tbody>
</table>

Warning: Although no default is provided, this parameter is mandatory.
### Resource Name | Default Value | Description
--- | --- | ---
flm.service | 6399 | Service or port number for the communication between the license controller and FLM.
flm.check | 100 | Number of connections between checks of the registered users list for a host machine. The control of active users is important, as it will synchronize real users on the network with the registered users list managed by FLM.

The check is used to recover licenses from users that are no longer active (in case of vm crash, the associated license may not be recovered).

To disable this control, set the parameter to \(-1\).

**Warning:** If you disable this control, some registered users will never be unregistered by the FLM unless you run the command `flmprg -u <license_number>`. See **Force a Check of the Registered Users List (flmprg)** on page 116.

flm.license.shared | 1 | Indicates whether the users are shared between licenses. If you have licenses for the same product, type, and extension, the total number of users will be cumulative. If this resource is set to 0, this will not be done.

flm.cnxlog.enabled | 0 | Set this entry to 1 to activate the FLM connection log. Support may request that you enable this option and send the generated log files to aide in analyzing licensing issues.

The log files are created in FLMDIR. The files are named using the pattern `flm-YYYYMMDD-id.log`, where:

- **YYYY** = current year
- **MM** = current month
- **DD** = day of month
- **id** = counter value. The counter value is incremented each time the FLM is started.

### Configuring the license controller

Before the Four Js License Manager (FLM) can manage a Genero product license, you need to configure the product's DVM configuration file locally with FLM server details and the product's license key and number.

- Genero Enterprise and Genero Mobile products are configured by setting values in the `FGLPROFILE` file.
- Genero Report Engine (GRE) is configured by setting values in the `GREPROFILE` file.

**Important:** Licensing for Genero Report Writer for Java, C# and PHP must be managed locally as it can not be managed by the License Manager.

1. To set the value for the FLM server, add the line in the following format with the name of server:
   
   ```
   flm.server="<FLM_server>"
   ```

2. To set the value for the license number, add the line in the following format:
   
   ```
   flm.license.number="<license_number>"
   ```

3. To set the value for the license key, add the line in the following format:
4. Add or update values for the resources shown in Table 22: DVM - configuration resources for License Server on page 108 as required:

**Table 22: DVM - configuration resources for License Server**

<table>
<thead>
<tr>
<th>Resource</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>flm.server</td>
<td>none</td>
<td>Name of the machine that holds the license service program. You must set this value to use Four Js License Manager from this machine.</td>
</tr>
<tr>
<td>flm.license.number</td>
<td>none</td>
<td>Value of your current license number. You must set this value to use Four Js License Manager. (For example: XXX#XXXXXXXX)</td>
</tr>
<tr>
<td>flm.license.key</td>
<td>none</td>
<td>Value of your current license key. You must set this value to use Four Js License Manager. (For example: YYYYYYYYYYYY)</td>
</tr>
<tr>
<td>flm.service</td>
<td>6399</td>
<td>Service or port number for the communication between the local license controller and Four Js License Manager. This value should be the same as in the Four Js License Manager configuration file, $FLMDIR/etc/lmprofile. See Configuring the License Manager on page 106.</td>
</tr>
<tr>
<td>flm.check</td>
<td>10</td>
<td>Number of iterations between two controls of the user list. Default is 10.</td>
</tr>
<tr>
<td>flm.ps</td>
<td>ps -ae</td>
<td>Specifies the command that gives a process list for a machine. This value is used to synchronize the real user list on the current machine with the registered users list on Four Js License Manager.</td>
</tr>
</tbody>
</table>

**Warning:** This entry is not used on most platforms as the default value `ps -ae` is replaced by a call to an API. Do not set this resource unless the internal implementation relying on the OS-specific API call fails.

---

**Steps to licensing with FLM**

Preparing to license involves deciding how you are going to validate the installed license with Four Js over the internet. Choose the option that is right for you and match it with the procedure to follow.

Before you begin Genero product licensing:

1. Locate your email message that contains the following:
   - product license key
   - product license number
   - product maintenance key
   - your customer code

   If you do not have this email, contact your local Four Js sales office.

2. Determine if you have internet access from the FLM server.

3. Use Table 23: Options for licensing on page 109 to choose your licensing option, and select the procedure to follow.
Table 23: Options for licensing

<table>
<thead>
<tr>
<th>FLM Licensing options</th>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using flmprg with internet.</td>
<td>See Install license with Four Js License Manager (via internet) on page 109.</td>
</tr>
<tr>
<td>Using flmprg without internet.</td>
<td>See Install license with Four Js License Manager (without internet) on page 110.</td>
</tr>
</tbody>
</table>

Install license with Four Js License Manager (via internet)

Follow this procedure to license a Genero product using the FLM command line tool, flmprg -l. During installation the license is registered with Four Js via the internet.

Before you begin: You must have internet access from the FLM server to validate the license.

1. Start the command line interface.
   a) Open a command prompt.
      • On Windows®, open the License Manager Workplace window from the Start menu.
      • On Linux®, open a command prompt. "sudo" may be required.
   b) Type `flmprg -l`
2. When prompted, enter the license number.
3. When prompted, enter the license key.
4. At the prompt:
   ```
   Do you want to continue using HTTP ? (y/n)
   ```
   Enter: y
5. When prompted, enter your customer code:
   ```
   Enter your customer code >
   ```
6. At the following prompt:
   ```
   Do you need to configure an HTTP proxy ? (y/n)
   ```
   Enter y if your access to the internet is through a proxy, and provide the required information for HTTP proxy and Port when prompted. Otherwise, enter n.

License installation is now completed.
Install license with Four Js License Manager (without internet)

Use this procedure to license a Genero product using the FLM command line tool, flmprg -l. Without internet access, you can register the license with Four Js from another machine via the internet, or by phone.

1. Start the command line interface.
   a) Open a command prompt.
      • On Windows®, open the License Manager Workplace window from the Start menu.
      • On Linux®, open a command prompt. "sudo" may be required.
   b) Type flmprg -l

2. When prompted, enter the license number.
3. When prompted, enter the license key.
   An installation number is generated and is displayed in the output.

4. At the prompt:

   Do you want to continue using HTTP ? (y/n)

   Enter: n

5. At the prompt:

   Enter your maintenance KEY (Empty to continue) >

   Enter: <maintenance-key>

Register the license

6. To register the license contact the vendor by phone, or register on the Four Js website. See the procedure described in Register license on Four Js website on page 72.

   Having registered your license, you have the Installation key

7. At the prompt:

   Enter the installation KEY (call your vendor to obtain it) >

   Enter: installation_key

![Figure 37: Installing License with License Manager (flmprg) without internet](image)

License installation is now completed.
Manage licenses with FLM (flmprg)

The License Manager program is installed and its service started to manage license controller connections. There are various command line options that you use for managing licensing with FLM.

The License Manager program is called `flmprg` on Linux®/UNIX™ and `flmprg.exe` on Windows®. The recommendation is to run this program only on the machine where the License Manager is installed and configured and where its daemon or service is started to listen for license controller connections. This chapter includes topics to manage licences.

Note: On Linux®/UNIX™ systems to avoid issues with directory permissions, it is recommended that the non-privileged user (not root user) who installs the License Manager, should also start the daemon and add licenses.

Topics

- Remove a license (Four Js License Manager) on page 113
- Display license information and statistics on page 113
- Manage the active user list (flmprg) on page 116
- Restricting access to a Four Js License Manager on page 117
- Reload the configuration file (Windows only) on page 118

FLM (flmprg) options

The flmprg command line tool is used to install, upgrade, or delete Genero licenses. There are also options that apply specifically to Windows®, and options to provide various types of license information and statistics.

Syntax

```
flmprg [options]
```

1. General command options are described in Table 24: General command options on page 111.
2. Options for use on Windows® only are described in Table 25: Windows only command options on page 112

flmprg Options

Table 24: General command options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-l [license]</code></td>
<td>Installs a license (requires license number and license key).</td>
</tr>
<tr>
<td><code>-m license</code></td>
<td>Install the maintenance key for the specified license.</td>
</tr>
<tr>
<td><code>-v</code> or <code>-V</code></td>
<td>Shows license manager version information.</td>
</tr>
<tr>
<td><code>-u host</code> or <code>-u all</code></td>
<td>Checks active users working on a given host. <code>-u all</code> checks users on all machines.</td>
</tr>
<tr>
<td><code>-r</code></td>
<td>Runs the license server daemon.</td>
</tr>
<tr>
<td><code>-s</code></td>
<td>Stops the license server daemon.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>−d license</td>
<td>Deletes the specified license.</td>
</tr>
<tr>
<td></td>
<td><strong>Important:</strong> For security reasons, you cannot remotely add or remove licenses registered on Four Js License Manager (FLM) with a local license controller command, for example, fglWrt.</td>
</tr>
<tr>
<td>−h</td>
<td>Display help for the license manager command.</td>
</tr>
<tr>
<td>−i license or −i all</td>
<td>Clears the list of registered user sessions for a given license.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning:</strong> All active users will be disconnected. Use −i all to clear lists for all licenses.</td>
</tr>
<tr>
<td>−a option</td>
<td>Check or view various license information, possible options are shown in the table.</td>
</tr>
<tr>
<td></td>
<td><strong>Option</strong></td>
</tr>
<tr>
<td>env</td>
<td>Shows current environment.</td>
</tr>
<tr>
<td>hostname</td>
<td>Shows name of the host machine.</td>
</tr>
<tr>
<td>info license</td>
<td>Shows license information.</td>
</tr>
<tr>
<td>info stat</td>
<td>Shows statistics for license manager server.</td>
</tr>
<tr>
<td>info users</td>
<td>Shows all registered active users.</td>
</tr>
<tr>
<td>info up</td>
<td>Checks if the FLM is started.</td>
</tr>
<tr>
<td>--kill-session host [pid]</td>
<td>Kills all sessions owned by the specified host, if pid is provided, only the specified session is cleared.</td>
</tr>
</tbody>
</table>

**Table 25: Windows only command options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--service-install</td>
<td>Installs the service and exits.</td>
</tr>
<tr>
<td>--service-start or −r</td>
<td>Starts the service.</td>
</tr>
<tr>
<td>--service-stop</td>
<td>Stops the service.</td>
</tr>
<tr>
<td>--service-uninstall</td>
<td>Uninstalls the service and exits.</td>
</tr>
<tr>
<td>--configuration-reload</td>
<td>Reloads the configuration file.</td>
</tr>
</tbody>
</table>
Remove a license (Four Js License Manager)

**Note:** Active users can continue to work after the license is deleted. No check on the registered users list is done for the deleted license. Once they stop their sessions, however, they will not be able to start them again.

Start the command line interface.

a) Open a command prompt.
   - On Windows®, open the License Manager Workplace window from the Start menu.
   - On Linux®, open a command prompt. "sudo" may be required.

b) Type `flmprg -d <license_number>`

Figure 38: Uninstalling a License with the License Manager (flmprg -d)

Display license information and statistics

Four Js License Manager provides various types of license information and statistics.

**Topics**

- Display license information (flmprg) on page 113
- Display statistical information on page 114
- Display registered active users information on page 115

**Display license information (flmprg)**

Use this procedure to display details of all the enabled licenses, and their maintenance expiration dates.

**Tip:** If you need to check a specific license, you may also find it useful to run the license controller command from the target host that consumes the license. For example:

```
flwr -a info license
```

Start the command line interface.

a) Open a command prompt.
   - On Windows®, open the License Manager Workplace window from the Start menu.
   - On Linux®, open a command prompt. "sudo" may be required.

b) Type `flmprg -a info license`

Example of display:

```
License : TXX#XXXXXXXX
License key : KKKKKKKKKKKK
Product : Four J's Universal Compiler
Type : Development version
Users : 1
Extension(s) :
  - Enhanced license key format
  - Strict licensing option
This license is date limited and expires the 2009/03/15 (Year/Month/Day).
End of maintenance date: 2009/01/01 (Year/Month/Day).
```
Display statistical information
You can display statistics about license usage as shown in this procedure.

Tip: If you need to display statistical information on the use of a specific license on a machine, you may also find it useful to run the license controller command from the target host that consumes the license, for example:

```bash
fglWrt -a info stat
```

Start the command line interface.

a) Open a command prompt.
   - On Windows®, open the License Manager Workplace window from the Start menu.
   - On Linux®, open a command prompt. "sudo" may be required.

b) Type `flmpreg -a info stat`

Example of display:

```
License Manager Statistics:
Runtime : 0
Accepted : 0
Rejected : 0
System Problem : 0
Compilation : 0
Accepted : 0
Rejected : 0
System Problem : 0
Extension : 0
Accepted : 0
Rejected : 0
System Problem : 0
End Runtime : 0
PID request : 0
Information : 1
Bad License : 58
Stop Manager : 0
Deleted licenses : 0
Unknown : 0
Total : 59
```

The following list describes the output fields and explains the values displayed:

- **Runtime**: This is the number of runtime requests, split into accepted, rejected and system problem categories.
- **Compilation**: This is the number of compilation requests, split into accepted, rejected and system problem categories.
- **Extension**: This is the number of extension requests, split into accepted, rejected and system problem categories.
- **EndRuntime**: This is the number of requests which specified that a runtime is finished.
- **PID request**: This is the number of requests for PID checking. This is an internal mechanism to synchronize the real users list and registered users list of the license manager.
- **Information**: This is the number of requests for statistics.
- **Bad License**: This is the number of requests for bad licenses (license not enabled or that does not exist).
- **Stop Manager**: This is the number of request to stop the license manager.
### Deleted licenses
This is the number of requests to delete licenses.

### Unknown
This is the number of requests of unknown type.

### Total
This is the number of total requests.

---

**Display registered active users information**
Follow this procedure to display a list of registered active users.

**Tip:** If you need to check registered users on a specific license, you may also find it useful to run the license controller command from the target host that consumes the license, for example:

```bash
glwrt -a info users
```

Start the command line interface.

a) Open a command prompt.

- On Windows®, open the **License Manager Workplace** window from the **Start** menu.
- On Linux®, open a command prompt. "sudo" may be required.

b) Type `lmpfrg -a info user`

This is an example of the output:

<table>
<thead>
<tr>
<th>License</th>
<th>FAA#YYYYYYYY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>Four J's Universal Compiler</td>
</tr>
<tr>
<td>Type</td>
<td>Development version</td>
</tr>
<tr>
<td>Users</td>
<td>2/200</td>
</tr>
<tr>
<td>Host</td>
<td>Athena</td>
</tr>
<tr>
<td>GUI Server</td>
<td>10.0.0.33:0</td>
</tr>
<tr>
<td>Process Id</td>
<td>2768</td>
</tr>
<tr>
<td>Process Id</td>
<td>2854</td>
</tr>
<tr>
<td>Terminal</td>
<td>772</td>
</tr>
<tr>
<td>License</td>
<td>FAB#ZZZZZZZZ</td>
</tr>
<tr>
<td>Product</td>
<td>Four J's Universal Dynamic Virtual Machine</td>
</tr>
<tr>
<td>Type</td>
<td>Runtime version</td>
</tr>
<tr>
<td>Users</td>
<td>0/700</td>
</tr>
</tbody>
</table>

The following list describes the output fields and explains the values displayed:

- **License**
  This is the value of the license number.

- **Product**
  This is the name of the product. In relation to Genero product, this can be, for example: Four J's Universal Compiler for Genero Enterprise and Genero Mobile products.

- **Type**
  This is the type of license. This can be runtime version or development version.

- **Users**
  Users are the current number of active users over the maximum number of users allowed.

- **Host**
  This is the name of the host machine.

- **GUI server**
  This is the IP address value of a graphical client.

- **Process Id**
  This is the current process identifier.

- **Terminal**
  This is the value of an ASCII client.
Manage the active user list (flmprg)

Four Js License Manager (FLM) provides you with methods to manage licenses being consumed by users by synchronizing the actual users list with the registered users list.

Topics

- Force a Check of the Registered Users List (flmprg) on page 116
- Clean registered users list on page 116
- Drop sessions attached to a host (flmprg) on page 116

Force a Check of the Registered Users List (flmprg)

Request a synchronization of the real users list with the registered users list for a specific machine or for all machines.

The synchronization will be done at the next dialogue between the license controller of the machine and the Four Js License Manager.

**Tip:** A faster way to synchronize users may be to run the license controller command from the target host that consumes the license, for example:

```plaintext
fglWrt -u
```

1. Start the command line interface.
   a) Open a command prompt.
      - On Windows®, open the **License Manager Workplace** window from the **Start** menu.
      - On Linux®, open a command prompt. "sudo" may be required.
   b) Type `flmprg -u <host>`
      Where `<host>` is the name of the machine.

2. To request a check of all machines using the license manager, execute the command:

   ```plaintext
   flmprg -u all
   ```

Clean registered users list

Clean the registered users listed as using a license. The command option to clear users for all licenses is also shown.

**Warning:** Use `flmprg -i` with caution, as it implicitly invalidates all existing sessions of a specific license; eventually all running applications will stop with a license error.

It may be used in the case of, for example, a DVM crash when the associated license would not be recovered otherwise. In other cases, the `-u` option to force a check of the registered users should be preferred to the `-i` option.

1. Start the command line interface.
   a) Open a command prompt.
      - On Windows®, open the **License Manager Workplace** window from the **Start** menu.
      - On Linux®, open a command prompt. "sudo" may be required.
   b) Type `flmprg -i <license_number>`
      All users registered for this license are disconnected when you use this option.

2. To clean all licenses, execute the command:

   ```plaintext
   flmprg -i all
   ```

Drop sessions attached to a host (flmprg)

Drop or stop a session running on a host.

Starting from version 5.19.01, there is an option to drop a single session, or drop all sessions started from a host.
**Important**: This feature only applies to User licenses, not to CPU licenses.

**Tip**: An equivalent feature is provided for local licensing. For example, to stop a session, you can run the license controller command from the target host:

```
fglWrt -x <pid>
```

Only the process id is needed in this case.

**Drop a single session**

1. Start the command line interface.
   a) Open a command prompt.
      • On Windows®, open the License Manager Workplace window from the Start menu.
      • On Linux®, open a command prompt. "sudo" may be required.
   b) Type `flmprg --kill-session <host>:<pid>`
      Where `<host>` is the name of the machine and `<pid>` is the process id.
      **Note**: The host name and process id are displayed in the `flmprg -a info license` output.

**Drop all sessions**

2. To drop all sessions running on a host, execute the command:

```
flmprg --kill-session <host>
```

**Related tasks**

- Display license information (flmprg) on page 113
- Use this procedure to display details of all the enabled licenses, and their maintenance expiration dates.

**Restricting access to a Four Js License Manager**

The license manager can be configured to filter the hosts connecting to it.

The following resources are available:

**Table 26: Filter Access Resources**

<table>
<thead>
<tr>
<th>Resource Name</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>flm.filter.deny.ip</td>
<td>none</td>
<td>List of IP addresses to deny.</td>
</tr>
<tr>
<td>flm.filter.deny.host</td>
<td>none</td>
<td>List of hostnames to deny.</td>
</tr>
<tr>
<td>flm.filter.deny.domain</td>
<td>none</td>
<td>List of domains to deny.</td>
</tr>
<tr>
<td>flm.filter.allow.ip</td>
<td>none</td>
<td>List of IP addresses to allow.</td>
</tr>
<tr>
<td>flm.filter.allow.host</td>
<td>none</td>
<td>List of hostnames to allow.</td>
</tr>
<tr>
<td>flm.filter.allow.domain</td>
<td>none</td>
<td>List of domains to allow.</td>
</tr>
<tr>
<td>flm.filter.priority</td>
<td>deny</td>
<td>Defines which rules will be processed first. Valid values for this parameter are &quot;allow&quot; and &quot;deny&quot;.</td>
</tr>
</tbody>
</table>

The IP addresses, host names and domains must be separated by a space character and can contain wildcards (*) or ?).

**Example:**

```
flm.filter.deny.ip="127.0.0.* 192.168.200.1"
```

The processing order of the rule is important.
Example:

```plaintext
flm.filter.deny.ip="127.0.0.1"
flm.filter.allow.ip="127.0.0.1"
```

Using the priority `deny`, the IP address 127.0.0.1 is rejected, as the rule for `flm.filter.deny.ip` matches first. Using the priority `allow`, the IP address 127.0.0.1 is accepted, as the rule for `flm.filter.allow.ip` matches first.

The license manager checks for IP addresses first, then host names, then domains.

Reload the configuration file (Windows only)

Use this procedure if you need to reload the FLM configuration file in a Windows® platform.

Start the command line interface.

a) Open a command prompt.
   - On Windows®, open the License Manager Workplace window from the Start menu.
   - On Linux, open a command prompt. "sudo" may be required.

b) Type `flmprg --configuration-reload`.

Steps to finalize temporary license with FLM

You register the license with Four Js to finalize your product's license installation. To complete licensing, select the option (with or without internet) that is right for you and match it with the procedure to follow.

Before you begin finalizing licensing:

1. Determine if you have internet access from the FLM server.
2. Use Table 27: Options for licensing on page 118 to choose your licensing option, and select the procedure to follow.

Table 27: Options for licensing

<table>
<thead>
<tr>
<th>FLM Licensing options</th>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using <code>flmprg</code> with internet.</td>
<td>See Install license with FLM (via internet) on page 118.</td>
</tr>
<tr>
<td>Using <code>flmprg</code> without internet.</td>
<td>See Finalize license with FLM (without internet) on page 119.</td>
</tr>
</tbody>
</table>

Install license with FLM (via internet)

You can complete licensing using the `flmprg -l` command. The license is registered with Four Js via the internet and the maintenance key is installed.

**Before you begin:** You must have internet access from the machine you are licensing the product to validate the license.

1. Start the command line interface.
   a) Open a command prompt.
      - On Windows®, open the License Manager Workplace window from the Start menu.
      - On Linux, open a command prompt. "sudo" may be required.
   b) Type `flmprg -l <license-number>`

   **Note:** The FLM recognizes you are in temporary license mode, and it will prompt you for the missing installation key to complete the license installation and switch to permanent license mode.

2. When prompted
Do you want to continue using HTTP ? (y/n)  
Enter: y

3. When prompted, enter your customer code:

   Enter your customer code >

4. At the following prompt:

   Do you need to configure an HTTP proxy ? (y/n)

Enter y if your access to the internet is through a proxy. Provide the required information for HTTP proxy. Port, and authentication when prompted. Otherwise, enter n.

The installation key is retrieved automatically from the Four Js Activation server. License installation is now completed.

Finalize license with FLM (without internet)

Without internet access, you complete licensing using the flmprg -l command. You can register the license with Four Js from another machine via the internet, or by phone.

1. Start the command line interface.
   a) Open a command prompt.
      • On Windows®, open the License Manager Workplace window from the Start menu.
      • On Linux, open a command prompt. "sudo" may be required.
   b) Type flmprg -l <license-number>

   Note: The FLM recognizes you are in temporary license mode, and it will prompt you for the missing installation key to complete the license installation and switch to permanent license mode.

2. When prompted

   Do you want to continue using HTTP ? (y/n)  
Enter: n

Register the license

3. To register the license contact the vendor by phone, or register on the Four Js website. See the procedure described in Register license on Four Js website on page 72.

   Having registered your license, you have the Installation key

4. At the prompt:

   Enter the installation key:

Enter the installation key.

Figure 39: Installing Installation Key with License Manager (flmprg -l) without internet
You should receive a message to say the installation was successful.

5. At the prompt:

   Enter your maintenance KEY ('stop' or leave empty to quit) >

   Enter: <maintenance-key>

   A message is displayed in the output to say the license installation was successful. License installation is now completed.

### Steps to apply maintenance (FLM)

You apply a maintenance key (also known as a subscription key depending on your contract) when you are installing a license for a product and thereafter when you renew your maintenance contract.

An active maintenance or subscription contract is required to license a product. The maintenance key determines which version of the Genero product you are authorized to use with your license, and the date that the maintenance contract expires.

Before you begin applying a maintenance key:

1. Determine if you have internet access from the FLM server.
2. Use Table 28: Options for licensing on page 120 to choose your licensing option, and select the procedure to follow.

#### Table 28: Options for licensing

<table>
<thead>
<tr>
<th>FLM Licensing options</th>
<th>Procedure to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using flmprg with internet.</td>
<td>See Install the maintenance key with Four Js License Manager (via internet) on page 120.</td>
</tr>
<tr>
<td>Using flmprg without internet.</td>
<td>See Install the maintenance key with Four Js License Manager (without internet) on page 121.</td>
</tr>
</tbody>
</table>

**Install the maintenance key with Four Js License Manager (via internet)**

Install or update the maintenance key for a Genero product using the license manager program command, flmprg -m. During installation the maintenance key is retrieved from Four Js activation server via the internet.

**About this task:** If you have purchased a new maintenance contract, you only need to add the new maintenance key. You do not need to reinstall your license, or uninstall the old maintenance key.

1. Start the command line interface.
   a) Open a command prompt.
      • On Windows®, open the License Manager Workplace window from the Start menu.
      • On Linux, open a command prompt. "sudo" may be required.
   b) Type flmprg -m <license-number>

      **Note:** The FLM prompts you for the missing maintenance key.

2. At the prompt:

   Do you want to obtain the maintenance key using HTTP ? (y/n)

   Enter: y

3. When prompted, enter your customer code:

   Enter your customer code >
4. At the following prompt:

```
Do you need to configure an HTTP proxy? (y/n)
```

Enter y if your access to the internet is through a proxy. Provide the required information for HTTP proxy, Port, and authentication when prompted. Otherwise, enter n.

The maintenance key is retrieved automatically from the Four Js Activation server. Maintenance key installation is now completed.

### Install the maintenance key with Four Js License Manager (without internet)

Install or update the maintenance key for a Genero product using the license manager program command, flmprg -m. Without internet access, you can obtain the maintenance key from Four Js from another machine via the internet, or by phone.

**About this task:** If you have purchased a new maintenance contract, you only need to add the new maintenance key. You do not need to reinstall your license, or uninstall the old maintenance key.

1. Start the command line interface.
   a) Open a command prompt.
      • On Windows®, open the License Manager Workplace window from the Start menu.
      • On Linux, open a command prompt. "sudo" may be required.
   b) Type `flmprg -m <license-number>`
      
      **Note:** The FLM prompts you for the missing maintenance key.

2. At the prompt:
   ```
   Do you want to obtain the maintenance key using http? (y/n)
   ```
   Enter: n

3. To get the maintenance key contact the vendor by phone, or get it from the Four Js website. See the procedure described in Get maintenance key from Four Js website on page 75.

4. At the prompt:
   ```
   Enter the maintenance key:
   ```
   Enter the maintenance key.
   You should receive a message to say the maintenance key installation was successful.

---

**License sharing with docker**

If you are working with Genero products installed in Docker container, follow the tasks for building a docker image and assigning a Genero BDL license installed on the host machine to that running in a Docker container.

Licensing for Genero products installed in a docker container can be implemented in one of two ways:

- If you are using a Four Js License Manager (FLM) server to manage licensing, licensing can be implemented by it in the usual way provided that the server is hosted outside the container. The FLM server can not run inside a docker container.
- An alternative option is to assign the license installed on the host machine to that running in a Docker container. This option is provided by the local license controllers (`fglWrt`, `greWrt`, `grxWrt`).

If you are working with Docker, you must have an understanding of Docker container technology. Docker is based on open standards that allow Docker instances running on the same machine to share the machine's operating system kernel but isolate applications from one another and from the underlying infrastructure. For more information see the Docker site.

- Install FGLGWS on host on page 122
Install FGLGWS on host

Follow this process to install Genero Business Development Language (BDL) with Web Services on the host machine running docker.

**Before you begin:** A prerequisite requires that the BDL installing path is not the same on both the host and the Docker container. Therefore, for example, instead of taking the default installation path option, which is `/opt/fourjs/fgl`, you specify the installation path as `/opt/fourjs/fglgws-license` on the host. For more information on Genero BDL installing, see the *Install and License your Genero Products* manual.

1. At the point in the installation when you are prompted for the installation directory, type N and then press the Enter key.:
   For example:
   
   FGLDIR is set up to `/opt/fourjs/fgl`. You can choose it for installation directory

   Do you want to use FGLDIR? Press [Y]es/[N]o/[C]ancel then (ENTER) ([Y]es is the default)

2. Specify the installation location:
   At the following prompt:
   "Where do you want to install this product?
   Default value is /opt/fourjs/fgl :

   Enter the path, for example:

   `/opt/fourjs/fglgws-license`

**What to do next:**

License Genero BDL. At the point of the installation requesting license details, follow the instructions for the license key and number and enter the required information.

---

Build operating system image

Follow this process to build a Linux® operating system image for use in a docker container.

**About this task:** This topic describes a procedure for working with a Debian image.

**Before you begin:**

You must have Docker installed and running.

1. Make a directory with a name that relates to your image.
   For example, a directory called `debian` may contain a Dockerfile for your Debian® image.

   ```bash
   mkdir debian
   ```

2. With a text editor create the file as shown, and save it as `Dockerfile`.

   ```bash
   FROM debian:latest
   RUN apt-get update \
   ```
The docker file contains all the commands needed to get the latest updates and build the Debian image. The user ("genero") and group ("fourjs") are added. A home directory and environment is set up for the user.

**Note:** The Dockerfile file is written following specific Dockerfile instructions. For more information see the Docker documentation.

3. At the command line, type the following commands to build the image from your Dockerfile:

```bash
docker pull debian:latest

docker build --force-rm -t fglgws-os .
```

The `docker pull` command pulls a pre-built Debian® image from the Docker repository. The `docker build` command builds an image called `fglgws-os` based on the Dockerfile found in the current directory, represented by the dot (`.`).

4. Get a list of docker images.

```bash
docker images
```

Your docker image (`fglgws-os`) is shown in the list.

**What to do next:**

Based on this image, you can now build a docker image with an FGLGWS package. See Build docker image with FGLGWS package on page 123

---

**Build docker image with FGLGWS package**

Follow this process to build a docker image with an FGLGWS package for use in a docker container.

**About this task:** The procedure described here applies to a Genero Business Development Language (BDL) installation in a docker container. The procedure may be adapted to add other Genero products to the docker container.

**Before you begin:**
• You have created a docker image called fglgws-os as described in Build operating system image on page 122.

• You have the FGLGWS package required for your installation downloaded to your system from the Four Js web site, www.4js.com.

• You have Docker installed and running.

1. Make a directory with a name that relates to your image.
   For example, a directory called fglgws-base may contain a Dockerfile for your image.

   mkdir fglgws-base

2. Create a docker file to install the FGLGWS package.
   With a text editor create the file as shown, and save it as Dockerfile:

   ```
   FROM fglgws-os
   USER root
   ARG user=genero
   ARG group=fourjs
   ARG FGLGWS_PACKAGE
   WORKDIR ${HOME}
   COPY ${FGLGWS_PACKAGE} /tmp/fglgws-install.run
   RUN mkdir -p /opt/fourjs \
       && chown ${user}:${group} /opt/fourjs /tmp/fglgws-install.run
   USER ${user}
   # Install fglgws package
   ENV FGLDIR /opt/fourjs/fglgws
   ENV PATH ${FGLDIR}/bin:${PATH}
   RUN /tmp/fglgws-install.run --accept --install --quiet --target ${FGLDIR} \
       && fglrun -V \
       && rm -f /tmp/fglgws-install.run
   ```

   In this example, the base image already created is used to build the FGLGWS installation (FROM fglgws-os). Permissions are set up for the installation to be run in the /opt/fourjs/fglgws directory by the "genero" user when the docker container is run.

3. At the command line type the following command to build the image from your dockerfile:

   ```
   docker build --force-rm -t fglgws-base .
   ```

   The build parameter --build-arg specifies the FGLGWS package to be installed in the docker container when created.

4. Get a list of docker images.

   ```
   docker images
   ```

   Your docker image (fglgws-base) is shown in the list.

**What to do next:**

Run the docker container and check Genero BDL license status. See Run docker container on page 125.
Run docker container

Run a docker container with a Genero Business Development Language (BDL) installation and check the license status.

**About this task:** Genero licensing can not be implemented directly in a docker container. This procedure shows the status before licensing has been assigned.

**Before you begin:**

- You have created a docker image called `fglgws-base` as described in Build docker image with FGLGWS package on page 123.
- You have Docker installed and running.

1. At the command line, type the command to create and run the `fglgws-base` docker container.

   ```
docker run --rm -it -t --name fglgws fglgws-base
   ```

   The container's name or tag is `fglgws` (as defined by the `--name` option). It can be listed by the docker command `docker ps` run on the host:

2. At the command prompt of the docker container, try to get Genero BDL license information.

   Type the license controller command:

   ```
   fglWrt -a info
   ```

   `genero@775edcg689ce:$ fglWrt -a info license
   SYS ERROR (-6054,2) : No such file or directory
   `Cannot read a license file
   Check installation path and your environment.
   There is no license available. License installation is not allowed in a docker container.

   **What to do next:**

   You assign the Genero BDL license on the host where the docker container is running to the instance in the container. See Assign host license to docker container on page 125.

Assign host license to docker container

Follow this process if you wish to assign a license to a docker container from a licensed Genero product on the host machine.

The procedure described here applies to assigning a license from a host to a Genero Business Development Language (BDL) installation in a docker container.

License controllers for Genero Report Engine (`greWrt`) and Genero Report Writer (`grxWrt`) provide a `docker-assign` function for those Genero products.

**Before you begin:**

- Make sure that the BDL installing path (FGLDIR) is **not** the same on both the host and the Docker container.
- You must have created a docker image as described in Build docker image with FGLGWS package on page 123.
- You must have Docker installed and running.

1. Run the docker command with the option to mount the host installation directory (FGLDIR) in the container.

   Type the command:

   ```
docker run --rm -it \
```
Important:

The `--volume` option mounts the host FGLDIR directory on the container. The names of the mounted directories must be the same in the host and docker container.

2. Set up the path to the license controller in the docker container.
   At the command line type the command:
   ```
   export FGLWRTPATH=/opt/fourjs/fglgws-license
   ```

3. Back on the host machine. Set the Genero BDL environment by running the script `envcomp`
   Tip: To detach from the `fglgws` container and leave it running, use the keyboard sequence Ctrl + p Ctrl + q.
   At the command line type:
   ```
   . /opt/fourjs/fglgws-license/envcomp
   ```

4. Assign the Genero BDL license on the host to the docker container named "fglgws":
   Type the license controller command:
   ```
   fglWrt docker-assign fglgws
   ```

5. Attach to the container fglgws.
   Type the command:
   ```
   docker attach fglgws
   ```

6. Check the Genero BDL license in the container.
   At the command line, type the license controller command:
   ```
   fglWrt -a info
   ```
   The license information shows the expected details of the license and you see it is assigned to the docker container. It can not be used again on the host, until it is released from the docker container.

   
   License : XXX#XXXXXXXX  
   Product : Four Js Universal Compiler  
   Type : Development version  
   Users : 10  
   Extension(s) :  
   - Open Database Interface  
   End of maintenance date: 2018/12/31 (Year/Month/Day).  
   License assigned to docker instance  
   '4c5c3747e838916365d04f2a2300a20334b91afbb9629861a6ddceb7d3abfd15f

   What to do next:
   
   A Genero license assigned to a docker container can be released back to the host installation. See Release docker container license on page 126.

---

**Release docker container license**

A license assigned to a docker container can be released back to the host from the host installation. Follow this process if you wish to release a license.

About this task:
This topic describes a procedure for releasing a Genero Business Development Language (BDL) license from the Docker container to the host.

At the command line of the host, type the command:

```
fglWrt docker-release
```

The license can now be used in the host. It is no longer available to the Docker container.

---

**Troubleshoot license issues**

You may become aware of licensing issues when using Genero products via messages output from the Dynamic Virtual Machine (DVM).

**Licensing errors**

Error messages that you see in the DVM output views about licensing are generally self-explanatory, detailing the specific cause. For example,

```
SYS ERROR(-6054,2):No such file or directory
Cannot read a license file.
Check installation path and your environment.
Verify if a license is installed.
```

You will find additional information about licensing related errors in the *Genero Business Development Language User Guide*, chapter "Genero BDL errors". Errors with numbers in the range 6001 to 6200 describe known and common licensing errors. You will find additional information about the action you need to take to resolve a particular error.

**License logs**

To troubleshoot licensing issues, you may have to activate a logging feature by enabling entries in either the lmprofile (FLM) or fglprofile (fglWrt, greWrt, or grxWrt). For further information see License logs on page 127. You may be asked to send log files to Four Js support for further assistance with a licensing problem. For more information or assistance you can also contact your local Four Js support center for help.

**Licensing recommendations for Windows**

On Windows® platforms, it is not recommended to install Genero products in the c:\Program Files path. If your installation directory is in this path, you will need to run the license controller command (for example fglWrt) as administrator in order to avoid permission issues.

**Important:** You must run the command as administrator, it is not enough to simply have administrator permissions.

---

**License logs**

Logging can be enabled for the Four Js License Manager (FLM) and/or the license controller.

Requests and responses that are sent and received by the license controller or Four Js License Manager (FLM) may be recorded in log files. These logs are intended for the troubleshooting of licensing issues by decoding and reviewing events. You may be asked to activate logging in order to assist Four Js support with a licensing problem.

**Note:** The logs are encoded and are not intended to be readable by users.

Activating this logging feature is dependent on how your license management is implemented.
**Local license controller logs**

If you are using a license controller (fglWrt, greWrt, or grxWrt) for license management, the log feature is configured in the FGLPROFILE file or by setting environment variables.

**fglprofile configuration**

To affect all license controllers, enable logging in the FGLPROFILE file.

Logs can be enabled using these entries:

- `flm.log.enabled=1`
- `flm.log.directory="/tmp"`

**Environment variables**

You can control which license controller processes inherit environment variables. For example, you can use a production installation for a single test and avoid changing the context where production executes.

**Tip:** Sometimes this method is easier than updating a configuration file.

Logs can be enabled using these environment variables:

- `WRT_LOG_ENABLED=1`
- `WRT_LOG_DIRECTORY="/tmp"`

A `wrt-<timestamp>.log` file is created in the specified log directory. A new log file is created each day. If logs are enabled and no directory provided, the output goes to stderr.

**Tip:** License controller logs can also be enabled locally when using an FLM.

**Four Js License Manager (FLM) Log**

If you are using FLM, a log feature is available (FLM version 5.10.3u or later). The log can be enabled by setting the entry `flm.cnxlog.enabled=1` in `$FLMDIR/etc/lmprofile`.

After making a configuration change, you will need to restart the FLM. After the restart, you get an `flm.log` file in the `$FLMDIR` directory.

Contact your local Four Js support center for additional assistance.

---

**Upgrading**

These topics talk about what steps you need to take to upgrade to the next release of Genero licensing, and allows you to identify which features were added for a specific version.

---

**New Features of Genero License**

These topics provide a look back at the new features introduced with each release of Genero License.
### Licensing 3.10 new features

Review this topic for information about new features and changes in existing functionality that have been introduced in this release of the Genero Licensing manual.

#### Table 29: License Manager

<table>
<thead>
<tr>
<th>Version 5.20 Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is a new implementation of the Genero Licencer User Interface.</td>
<td>See Table 31: Genero Licenser UI application on page 130</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Version 5.19.19 Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>This version has bug fixes and provides some enhancements for license controllers.</td>
<td>No additional reference.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Version 5.19.10 Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting from version 5.19.10, when licensing with <code>flmprg -l</code>, the maintenance key can be installed after the installation key.</td>
<td>See Steps to licensing with FLM on page 108</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Version 5.19.01 Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting with version 5.19.01, a feature is available that allows you to drop a single session, or drop all sessions started from a host.</td>
<td>See Drop sessions attached to a host (flmprg) on page 116</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Version 5.19.00 Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Genero products installed on a Docker container require the use of an FLM server that is hosted outside the container. The FLM server can not run inside a docker instance. This is effective since version 5.19.00.</td>
<td>No additional reference.</td>
</tr>
</tbody>
</table>

#### Table 30: License Controllers (fglWrt, greWrt, grxWrt)

<table>
<thead>
<tr>
<th>Version 5.19.26 Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting from version 5.19.26, license logs can be enabled for the license controller.</td>
<td>See License logs on page 127</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Version 5.19.10 Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting from version 5.19.10, when licensing from the command line using the <code>fglWrt -l, greWrt -l, or grxWrt -l</code>, the maintenance key can be installed after the installation key.</td>
<td>See Install BDL license from the command line (via internet) on page 57</td>
</tr>
</tbody>
</table>

The Genero license installed on a machine hosting Docker can be assigned to applications on a running docker container. |

<table>
<thead>
<tr>
<th>Version 5.19.01 Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>For local licensing, starting with version 5.19.01, there is an option to drop the session referenced by a specified process id.</td>
<td>See Drop session on page 72</td>
</tr>
</tbody>
</table>
Table 31: Genero Licenser UI application

<table>
<thead>
<tr>
<th>Version 5.20 Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting from version 5.20, there is a new implementation of the Genero Licenser UI. The application now launches a web page in your browser. The new UI provides the same service to license your products.</td>
<td>See, for example, Steps to BDL license installation on page 52</td>
</tr>
</tbody>
</table>

Licensing 3.00 new features
Review this topic for information about new features and changes in existing functionality that have been introduced in this release of the Genero Licensing manual.

Table 32: License Controller

<table>
<thead>
<tr>
<th>Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beginning with Four Js License Manager (FLM) and License Controller (fglWrt) version 5.18.00, there is a new method for calculating CPU Licenses operating in degraded mode.</td>
<td>No additional reference.</td>
</tr>
<tr>
<td>Starting with version 5.19.00 there is a new method for managing licensing of Genero products in a Docker container. Licenses can not be installed inside a docker container. Docker instances must use an FLM server hosted outside the container for license support.</td>
<td>No additional reference.</td>
</tr>
</tbody>
</table>

Table 33: Four Js License Manager

<table>
<thead>
<tr>
<th>Overview</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>The FLM server can not run inside a docker instance. This is effective since version 5.19.00 of f1mprg.</td>
<td>No additional reference.</td>
</tr>
</tbody>
</table>

Upgrade Guides for Licensing
Review the list of migration recommendations each time you move to a new version.

- Upgrade the FLM without re-applying licenses on page 130

Upgrade the FLM without re-applying licenses
When you upgrade the Four Js license manager, you do not need to reinstall your existing licenses.

1. Make a backup copy of your FLM configuration file, FLMDIR/etc/lmprofile
2. Start the command line interface.
   a) Open a command prompt.
      • On Windows®, open the License Manager Workplace window from the Start menu.
      • On Linux®, open a command prompt. "sudo" may be required.
   b) Type f1mprg -s
      The FLM service is stopped.
3. Install the new FLM package in the same directory as the existing installation.
   Take the option to overwrite the existing files.
4. Replace the configuration file at FLMDIR/etc/lmprofile with the backup copy created in Step 1.
   Overwrite the existing file.
5. Remove every file and directory in the `FLMDIR/lock/` path.
6. Start your new FLM

```
flmprg -r
```

It is also recommended to upgrade the license controllers for your Genero Business Development Language (fglWrt) or Genero Report Writer (greWrt) installations at this time. See Patching a license controller on page 48.

---

## Copyrights and Trademarks

The Copyright and trademark page is shared amongst all Four Js documentation. Appearance in this page does not guarantee a mention within the current document.

**Copyright notice**

© Copyright Four Js Development Tools, Inc. Use, duplication or disclosure restricted.

**Trademarks**

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of Adobe Systems Incorporated.

IBM and WebSphere are trademarks or registered trademarks of International Business Machines Corp., in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at Copyright and trademark information.

Linux is a registered trademark of Linus Torvalds.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Other company, product, or service names may be trademarks or service marks of others.
Index

A

activation key
requesting a new key 74

B

BDL
finalize license installation 75
install 11
install maintenance key 80
license information 64
license installation 52
licensing with License Manager 83
local license management 59
lock directory
user access 69
packages 12
post-install tasks 16
pre-install tasks 13
uninstall license 67
update maintenance key 80
bundled software 7
Business Development Language. See BDL

C

check FLM is started 61
check registered users list 71
clean registered users list 71
command line tools
common options 8
command reference
fglnodb 48
fpi 48
GRE license information
greWrt -a info license 90
GRE maintenance key install
greWrt -m 103
greWrt -m auto 103
install BDL license
fglwrt -l 57
install GRE installation key
greWrt -k 100
install GRE license
greWrt -l 86
install installation key automatically
greWrt -k auto 99
install license with FLM
flmprg -l 109
uninstall GRE license
greWrt -d 93
compatibility
GAS 3.10 and Genero 23
GAS and Genero 23
GDC 2.50 and Genero 17
GDC 3.00 and Genero 17
GDC 3.10 and Genero 17

D

display cpu information 62
display process list 72
displaying license information
FLM 113
docker-assign 125
docker-release 126
drop session 72
DVM version
identifying 48

F

FGLWRTUMASK
restricting user access 69
file format
fglprofile 107
greprofile 107
flm
manage active users 116

FLM
configuration 106
displaying license information 113
install installation key 118
install maintenance key 120
license installation 108
license management 111
system requirements 47
update maintenance key 120
See also license manager

G

GAS
install 21
GDC
install 16
Genero Application Server, See GAS
Genero Browser Client
install 46
Genero Desktop Client, See GDC
Genero Mobile for Android
install 40
Genero Mobile for iOS
install 40
Genero Report Designer
install 44
Genero Report Engine, See GRE
Genero Studio
install 27
Genero Studio Server Suite
install 36
GMA
install 40
| Index | 133 |

GMI

install 40

GRD. See Genero Report Designer

GRE

finalize license installation 96
install 41
install maintenance key 100
license information 89
license installation 84
licensing with License Manager 103
uninstall license 92
update maintenance key 100

greprofile

configure FLM resources 103

I

install

flm 50
Four Js License Manager 50
install installation key

FLM 118
install maintenance key

BDL 80
FLM 120
GRE 100
installation

directory environment 8
environment scripts 8
for development 7
for production 7
troubleshooting 10

L

license

environment and statistics 61
managing active users 70
license controller

command options

fglwrt 60
greWrt 88
license information

BDL 64
GRE 89
license management

Genero Report Engine 88
license manager

command options

flmprg 111
configuration

DVM configuration file 107
displaying license information

displaying active user statistics 115
displaying FLM statistics 114, 115
drop session 116
installing FLM service 50
license using 106
starting FLM service 51
stopping FLM service 52
uninstalling a license 113
upgrading 47, 130
license registration

on Four Js website 72, 93
licensing

docker container

assign host license 125
release host license 126
logs 127
troubleshooting 127
licensing Genero Mobile
determining app size 104
free developer license 104
packaging mobile app 104
licensing new product version 69, 93
licensing with License Manager

BDL 83
Linux

install GRD 45
local license management

BDL 59

M

macOS

install GAS 27
install GDC 20
install Genero BDL 15
install Genero Studio Server 39
install GRE 43
install Studio 34, 35
maintenance key

from Four Js website 75, 95
manage active users

flm 116
managing active users

license 70
MSI installer 14, 19, 30, 42

N

new features

version 3.00 130
version 3.10 129

P

patching license controller 48
product

version life cycle 9

R

Report Designer. See Genero Report Designer

S

silent mode

install BDL 14
install GAS 25
install GDC 19
install GRE 42
install Studio on UNIX 33, 33, 38
install Studio on Windows 30
software bundle 7
software package names 7
Studio. See Genero Studio
system requirements
  FLM 47
  GAS 22
  GDC 17
  Genero BDL 11
  GRD 45
  GRE 41
  GST 28, 36, 46

T

troubleshooting
  installation 10
  license registration 74

U

uninstall license
  BDL 67
  GRE 92
UNIX
  install BDL 13
  install GAS 23
  install GDC 18
  install Genero Studio 33, 38
  install GRD 45
  install GRE 42

W

Windows
  install BDL
    using MSI 14
  install GAS 24
  install GDC
    Using MSI 19
  install Genero Studio Server 37
  install GRD 45
  install GRE
    Using MSI 42
  install Studio
    Using MSI 30
  Security Blocking 21, 35

X

x11
  install GDC 21